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Audience for This Guide
Welcome to the Oracle Workflow Guide.

This guide assumes you have a working knowledge of the following:

The principles and customary practices of your business area.
Oracle Workflow

If you have never used Oracle Workflow, Oracle suggests you
attend one or more of the Oracle Workflow training classes
available through Oracle University.

See Other Information Sources for more information about Oracle
Applications product information.

The Oracle Workflow Guide also assumes you have a basic
understanding of operating system concepts and familiarity with
Oracle database server, PL/SQL, and Oracle9i Application Server
technology. If you have not yet been introduced to any of these
systems, Oracle suggests you attend one or more of the training classes
available through Oracle University.

How To Use This Guide

XX

Oracle Workflow Guide

This guide contains the information you need to understand and use
Oracle Workflow.

Chapter 1 provides an overview of Oracle Workflow.

Chapter 2 describes how to implement Oracle Workflow for your
site.

Chapter 3 describes how to begin defining a workflow process.

Chapter 4 describes how to define the components necessary to
build a workflow process.

Chapter 5 describes how to draw and define a workflow process
diagram.

Chapter 6 describes the standard activities provided with Oracle
Workflow.

Chapter 7 describes the standard APIs for the PL/SQL and Java
functions that can be called by Oracle Workflow.

Chapter 8 provides detailed information about Oracle
Workflow’s APIs.



e Chapter 9 describes the Oracle Workflow home page, where
users and administrators can centrally access all the web-based
features of Oracle Workflow.

e Chapter 10 discusses how a user can view and act on a workflow
notification.

e Chapter 11 describes how to use the Workflow Monitor to
administer or view the status of a workflow process.

e Chapter 12 describes how to launch a workflow process for
testing purposes.

e Chapter 13 describes how to manage business events.

e Chapter 14 describes the standard events provided with Oracle
Workflow.

e Chapter 15 describes the demonstration workflow processes
included with Oracle Workflow.

e Chapter 16 describes the miscellaneous administrative SQL
scripts included with Oracle Workflow.

e Appendix A describes the Oracle Workflow Builder menus and
toolbar.

e Appendix B lists the predefined workflow processes that are
included with the Oracle Applications—embedded version of
Oracle Workflow, the Oracle Applications features that leverage
the Business Event System, and the Oracle9i platform features
that leverage Oracle Workflow. This appendix also includes the
Oracle Workflow support policy.

e Appendix C describes concepts and techniques that you can use
for performance gain when running Oracle Workflow.

At the end of this guide, we include a glossary of Oracle Workflow
terms.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting
documentation accessible, with good usability, to the disabled
community. To that end, our documentation includes features that
make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with
other market-leading technology vendors to address technical
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obstacles so that our documentation can be accessible to all of our
customers. For additional information, visit the Oracle Accessibility
Program Web site at http:/ /www.oracle.com/accessibility /.

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the
code examples in this document. The conventions for writing code
require that closing braces should appear on an otherwise empty line;
however, JAWS may not always read a line of text that consists solely
of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies
or organizations that Oracle Corporation does not own or control.
Oracle Corporation neither evaluates nor makes any representations
regarding the accessibility of these Web sites.

Other Information Sources

Online Documentation

xxii
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You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Oracle Workflow.

If this guide refers you to other Oracle Applications documentation,
use only the Release 11i versions of those guides.

If you are using the version of Oracle Workflow embedded in Oracle
Applications, note that all Oracle Applications documentation is
available online (HTML or PDF).

¢ Online Help — The new features section in the HTML help
describes new features in 11i. This information is updated for
each new release of Oracle Workflow. The new features section
also includes information about any features that were not yet
available when this guide was printed. For example, if your
administrator has installed software from a mini-pack or an
upgrade, this document describes the new features. Online help
patches are available on MetaLink.



Related User’s Guides

¢ 11i Features Matrix — This document lists new features available
by patch and identifies any associated new documentation. The
new features matrix document is available on MetaLink.

¢ Readme File — Refer to the readme file for patches that you have
installed to learn about new documentation or documentation
patches that you can download.

Portions of this guide are also available online in Windows Help
format. The Windows Help is available from the Oracle Workflow
Builder Help menu.

If you are using the standalone version of Oracle Workflow, note that
this guide is available online in HTML format, and portions of the
guide are available in Windows Help format as well. The Windows
Help is available from the Oracle Workflow Builder Help menu. The
HTML documentation is available from a URL provided by your
system administrator or from the help icon in the Oracle Workflow web

pages.

Oracle Workflow is used by other Oracle Applications products to
provide embedded workflows. Therefore, if you are using the version
of Oracle Workflow embedded in Oracle Applications, you may want
to refer to other user’s guides when you set up and use Oracle
Workflow to learn more about the embedded workflows.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle Applications Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.

If you require printed guides, you can purchase them from the Oracle
Store at http:/ /oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate
using the graphical user interface (GUI) available with this release of
Oracle Workflow (and any other Oracle Applications products). This
guide also includes information on setting user profiles, as well as
running and reviewing reports and concurrent processes.
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You can access this user’s guide online by choosing ”Getting Started
with Oracle Applications” from any Oracle Applications help file.

User Guides Related to This Product

Oracle General Ledger User Guide

This guide provides information about journal entry, budgeting, and
multi-company accounting and consolidation.

Oracle Purchasing User’s Guide

This guide provides information about entering and managing
purchase orders and requisitions.

Implementing Oracle Self-Service Human Resources (SSHR)

This guide provides information about setting up the self-service
human resources management functions for managers and employees.
Managers and employees can then use an intranet and Web browser to
have easy and intuitive access to personal and career management
functionality

Oracle Payables User Guide

This guide provides information about entering and managing
suppliers, invoices, and payments.

Oracle Projects User Guide

This guide provides information about entering and managing projects,
budgets, expenditures, costing, and billing.

Oracle Receivables User Guide

This guide provides information about entering and managing
customers, receipts, collections, and transactions.

Oracle Business Intelligence System Implementation Guide

This guide provides information about implementing Oracle Business
Intelligence (BIS) in your environment.
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BIS 11i User Guide Online Help

This guide is provided as online help only from the BIS application and
includes information about intelligence reports, Discoverer workbooks,
and the Performance Management Framework.

Oracle Financials Open Interface Reference

This guide is a compilation of all open interface descriptions in all
Oracle Financial Applications user’s guides.

Oracle XML Gateway User’s Guide

This guide explains how to implement the production and
consumption of valid, well-formed XML messages between Oracle
Applications and trading partners.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features,
technology stack, architecture, and terminology for Oracle Applications
Release 11i. It provides a useful first book to read before an installation
of Oracle Applications. This guide also introduces the concepts behind
Applications—wide features such as Business Intelligence (BIS),
languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 117, much of the installation process
is handled using Oracle Rapid Install, which minimizes the time to
install Oracle Applications, the Oracle8 technology stack, and the
Oracle8i Server technology stack by automating many of the required
steps. This guide contains instructions for using Oracle Rapid Install
and lists the tasks you need to perform to finish your installation. You
should use this guide in conjunction with individual product user’s
guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications
Release 10.7 or Release 11.0 products to Release 11i. This guide
describes the upgrade process and lists database and product-—specific
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upgrade tasks. You must be either at Release 10.7 (NCA, SmartClient,
or character mode) or Release 11.0, to upgrade to Release 11i. You
cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as
AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD
Relink, License Manager, and others. It contains how-to steps,
screenshots, and other information that you need to run the AD
utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator. It contains information on how to
define security, customize menus and online help, and manage
concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor
the status of your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff. It describes the Oracle Application
Object Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards for Forms—Based Products. It also provides information
to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Other Implementation Documentation

Xxvi
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Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle
Applications. It provides a history of the changes to individual Oracle
Applications products between Release 11.0 and Release 11:. It includes
new features, enhancements, and changes made to database objects,
profile options, and seed data for this interval.



Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record
transactions in more than one currency, use this manual before
implementing Oracle Workflow. This manual details additional steps
and setup considerations for implementing Oracle Workflow with this
feature.

Multiple Organizations in Oracle Applications

This guide describes how to set up and use Oracle Workflow with
Oracle Applications” Multiple Organization support feature, so you can
define and support different organization structures when running a
single installation of Oracle Workflow.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference
information for the Oracle Workflow implementation team, as well as
for users responsible for the ongoing maintenance of Oracle
Applications product data. This manual also provides information on
creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (€TRM) contains database diagrams
and a detailed description of database tables, forms, reports, and
programs for a specific Oracle Applications product. This information
helps you convert data from your existing applications, integrate
Oracle Applications data with non—-Oracle applications, and write
custom reports for Oracle Applications products. Oracle eTRM is
available on MetaLink.

Oracle Applications User Interface Standards
for Forms—Based Products

This guide contains the user interface (UI) standards followed by the
Oracle Applications development staff. It describes the UI for the
Oracle Applications products and how to apply this Ul to the design of
an application built by using Oracle Forms.

Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up—to—date information about integrating with
other Oracle Manufacturing applications and with your other systems.
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Training and Support
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This documentation includes APIs and open interfaces found in Oracle
Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up—to—date information about integrating with
other Oracle Manufacturing applications and with your other systems.
This documentation includes APIs and open interfaces found in Oracle
Order Management Suite.

Oracle Applications Message Reference Manual

This manual describes all Oracle Applications messages. This manual is
available in HTML format on the documentation CD-ROM for Release
11i.

Training

Oracle offers a complete set of training courses to help you and your
staff master Oracle Workflow and reach full productivity quickly. These
courses are organized into functional learning paths, so you take only
those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses
offered by Oracle University at any one of our many Education
Centers, you can arrange for our trainers to teach at your facility, or
you can use Oracle Learning Network (OLN), Oracle University’s
online education utility. In addition, Oracle training professionals can
tailor standard courses or develop custom courses to meet your needs.
For example, you may want to use your organization structure,
terminology, and data as examples in a customized training session
delivered at your own facility.

Support

From on-site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Workflow working for you. This team includes your Technical
Representative and Account Manager, and Oracle’s large staff of
consultants and support specialists with expertise in your business
area, managing an Oracle database server, and your hardware and
software environment.



Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus,
Oracle Data Browser, database triggers, or any other tool to modify
Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database. But if you use
Oracle tools such as SQL*Plus to modify Oracle Applications data, you
risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using Oracle Applications can update many tables at once. But
when you modify Oracle Applications data using anything other than
Oracle Applications, you may change a row in one table without
making corresponding changes in related tables. If your tables get out
of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle
Applications.

When you use Oracle Applications to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. If you enter
information into database tables using database tools, you may store
invalid information. You also lose the ability to track who has changed
your information because SQL*Plus and other database tools do not
keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support, and office automation, as well as
Oracle Applications, an integrated suite of more than 160 software
modules for financial management, supply chain management,
manufacturing, project systems, human resources, and customer
relationship management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers and personal digital assistants,
allowing organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.
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Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and applications products, along with related
consulting, education, and support services, in over 145 countries
around the world.

Your Feedback

XXX

Oracle Workflow Guide

Thank you for using Oracle Workflow and this guide.

Oracle values your comments and feedback. At the end of this guide is
a Reader’s Comment Form you can use to explain what you like or
dislike about Oracle Workflow or this guide. Mail your comments to
the following address or call us directly at (650) 506—7000.

Oracle Applications Documentation Manager
Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

US.A.

Or, send electronic mail to appsdoc_us@oracle.com.



Overview of Oracle
Workflow

CHAPTER

T his chapter introduces you to the concept of a workflow process
and to the major features of Oracle Workflow. These features include:

e Oracle Workflow Builder, a graphical tool that lets you create
business process definitions.

e The Workflow Engine, which implements process definitions at
runtime.

e The Notifications System, which sends notifications to and
processes responses from users in a workflow.

e Workflow Monitor, which allows you to track your workflow
process using a web browser.

e The Business Event System, which communicates business events
between systems.
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Business processes today involve getting many types of information to
multiple people according to rules that are constantly changing. Oracle
Workflow lets you automate and continuously improve business
processes, routing information of any type according to business rules
you can easily change to people both inside and outside your enterprise.
See: Major Features and Definitions: page 1 - 3.

Routing Information

With so much information available, and in so many different forms,
how do you get the right information to the right people? Oracle
Workflow lets you provide each person with all the information they
need to take action. Oracle Workflow can route supporting information
to each decision maker in a business process.

Defining and Modifying Business Rules

Oracle Workflow lets you define and continuously improve your
business processes using a drag—and—drop process designer.

Unlike workflow systems that simply route documents from one user to
another with some approval steps, Oracle Workflow lets you model
sophisticated business processes. You can define processes that loop,
branch into parallel flows and then rendezvous, decompose into
subflows, and more. Because Oracle Workflow can decide which path
to take based on the result of a stored procedure, you can use the full
power of PL/SQL, the language of the Oracle database server, to express
any business rule that affects a workflow process. See: Workflow
Processes: page 1-6.

Delivering Electronic Notifications

Oracle Workflow extends the reach of business process automation
throughout the enterprise and beyond to include any e-mail or Internet
user. Oracle Workflow lets people receive notifications of items
awaiting their attention via e-mail, and act based on their e-mail
responses. You can even view your list of things to do, including
necessary supporting information, and take action using a standard Web
browser.



Integrating Systems

Oracle Workflow lets you set up subscriptions to business events which
can launch workflows or enable messages to be propagated from one
system to another when business events occur. You can communicate
events among systems within your own enterprise and with external
systems as well. In this way, you can implement point—to—point
messaging integration or use Oracle Workflow as a messaging hub for
more complex system integration scenarios. You can model business
processes that include complex routing and processing rules to handle
events powerfully and flexibly.

Major Features and Definitions

Oracle Workflow Builder

Oracle Workflow Builder lets you create, view, or modify a business
process with simple drag and drop operations. Using the Workflow
Builder, you can create and modify all workflow objects, including
activities, item types, and messages. See: Workflow Processes: page
1-6.

At any time you can add, remove, or change workflow activities, or set
up new prerequisite relationships among activities. You can easily work
with a summary-level model of your workflow, expanding activities
within the workflow as needed to greater levels of detail. And, you can
operate Oracle Workflow Builder from a desktop PC or from a
disconnected laptop PC.

Workflow Engine

The Workflow Engine embedded in the Oracle database server monitors
workflow states and coordinates the routing of activities for a process.
Changes in workflow state, such as the completion of workflow
activities, are signaled to the engine via a PL/SQL API or a Java APL
Based on flexibly—defined workflow rules, the engine determines which
activities are eligible to run, and then runs them. The Workflow Engine
supports sophisticated workflow rules, including looping, branching,
parallel flows, and subflows.

Business Event System

The Business Event System is an application service that uses the Oracle
Advanced Queuing (AQ) infrastructure to communicate business events
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between systems. The Business Event System consists of the Event
Manager, which lets you register subscriptions to significant events, and
event activities, which let you model business events within workflow
processes.

When a local event occurs, the subscribing code is executed in the same
transaction as the code that raised the event. Subscription processing can
include executing custom code on the event information, sending event
information to a workflow process, and sending event information to
other queues or systems.

Workflow Definitions Loader

The Workflow Definitions Loader is a utility program that moves
workflow definitions between database and corresponding flat file
representations. You can use it to move workflow definitions from a
development to a production database, or to apply upgrades to existing
definitions. In addition to being a standalone server program, the
Workflow Definitions Loader is also integrated into Oracle Workflow
Builder, allowing you to open and save workflow definitions in both a
database and file.

Complete Programmatic Extensibility

Oracle Workflow lets you include your own PL/SQL procedures or
external functions as activities in your workflows. Without modifying
your application code, you can have your own program run whenever
the Workflow Engine detects that your program’s prerequisites are
satisfied.

Electronic Notifications

Oracle Workflow lets you include users in your workflows to handle
activities that cannot be automated, such as approvals for requisitions or
sales orders. Electronic notifications are routed to a role, which can be
an individual user or a group of users. Any user associated with that
role can act on the notification.

Each notification includes a message that contains all the information a
user needs to make a decision. The information may be embedded in
the message body or attached as a separate document. Oracle Workflow
interprets each notification activity response to decide how to move on
to the next workflow activity.



Electronic Mail Integration

Electronic mail (e-mail) users can receive notifications of outstanding
work items and can respond to those notifications using their e-mail
application of choice. An e-mail notification can include an attachment
that provides another means of responding to the notification.

Internet-Enabled Workflow

Any user with access to a standard Web browser can be included in a
workflow. Web users can access a Notification Web page to see their
outstanding work items, then navigate to additional pages to see more
details or provide a response.

Monitoring and Administration

Workflow administrators and users can view the progress of a work
item in a workflow process by connecting to the Workflow Monitor
using a standard Web browser that supports Java. The Workflow
Monitor displays an annotated view of the process diagram for a
particular instance of a workflow process, so that users can get a
graphical depiction of their work item status. The Workflow Monitor
also displays a separate status summary for the work item, the process,
and each activity in the process.

If you are using the version of Oracle Workflow embedded in Oracle
Applications and you have implemented Oracle Applications Manager,
you can also use the Oracle Workflow Manager component of Oracle
Applications Manager as an additional administration tool for Oracle
Workflow. Oracle Applications Manager is a tool that provides
administrative and diagnostic capabilities for concurrent processing,
Oracle Workflow, and other functionality in Oracle Applications. For
more information, please refer to the Oracle Applications Manager
online help.
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Oracle Workflow manages business processes according to rules that
you define. The rules, which we call a workflow process definition,
include the activities that occur in the process and the relationship
between those activities. An activity in a process definition can be an
automated function defined by a PL/SQL stored procedure or an
external function, a notification to a user or role that may optionally
request a response, a business event, or a subflow that itself is made up
of a more granular set of activities.

A workflow process is initiated when an application calls a set of Oracle
Workflow Engine APIs. The Workflow Engine takes over by driving
the relevant work item defined by the application, through a specific
workflow process definition. According to the workflow process
definition, the Workflow Engine performs automated steps and invokes
appropriate agents when external processing is required.

The following diagram depicts a simplified workflow process definition
that routes a requisition to a manager or set of managers for approval.
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We refer to the whole drawing as a process or process diagram. The
icons represent activities, and the arrows represent the transitions
between the activities. In the above example, new items are created for
the process when a user creates and submits a requisition in the
appropriate application.

This process contains several workflow activities implemented as
PL/SQL stored procedures, including:

¢ Select Approver—to select, according to your business rules, who
should approve the requisition.

e Verify Authority—to verify that a selected approver has the
spending authority to approve the requisition.
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CHAPTER

Setting Up Oracle
Workfg

T his chapter describes the requirements for Oracle Workflow and
provides the steps necessary to set up Oracle Workflow at your site.
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The components of Oracle Workflow require the following hardware
and software configurations:

¢ Oracle Workflow Builder is installed using Oracle Universal
Installer and requires the installation of Oracle Net Services
(version 8.1.6 or higher for Oracle8i, or version 9.0.1 or higher for
Oracle9i) and Required Support Files (version 8.1.6 or higher for
Oracle8i, or version 9.0.1 or higher for Oracle9i). You should
install Oracle Workflow Builder on an IBM, Compaq or 100%
compatible personal computer with the following:

A 486 processor or better

Clock speed of 66 Mhz or greater (90 Mhz or greater is
recommended)

Network card
SVGA color monitor

Modem configured with dial-in access for use by Oracle
Worldwide Customer Support. At least one PC at your site
should be configured with a modem.

Remote access and control software to be used by Customer
Support for dial-in access through a modem to your PC.
The preferred software is Symantec’s Norton
pcANYWHERE, or Microcom’s Carbon Copy. Without
some form of remote access and control software, Oracle
Worldwide Customer Support will not be able to dial in to
your site to diagnose problems, nor will they be able to
supply patches directly to your client PC.

é Warning: Please follow the necessary security precautions
against viruses and unauthorized access when installing any
software that allows remote access.

Dual speed, ISO 9660 format CD-ROM available as a logical
drive

Microsoft Windows 95, Windows 98, Windows 2000, or
Windows NT 4.0 or higher

At least 60 Mb of available disk space to install Oracle
Workflow Builder, Oracle Net Services, and Required
Support Files.

At least 32 Mb of memory, 64 Mb recommended



IS

Attention: Oracle Net Services require and only support the
use of Microsoft’s TCP/IP drivers.

e The Oracle Workflow Server requires the following:

Iy

Oracle8i Enterprise or Standard Edition database version
8.1.6 or higher, or Oracle9i Enterprise or Standard Edition
database version 9.0.1 or higher, along with the Oracle
Objects and JServer Options, installed on a supported
server machine

At least 40 Mb of available disk space for Oracle Workflow
Server once it is installed in your Oracle Home

At least 128 Mb of memory, 256 Mb recommended

Oracle Net Services version 8.1.6 or higher for Oracle8i, or
version 9.0.1 or higher for Oracle9i

SQL*Plus version 8.1 or higher for Oracle8i, or version 9.0.1
or higher for Oracle9i

If you are installing Oracle Workflow Server on Microsoft
Windows NT, the following additional hardware and software
configurations are required:

ISO 9660 format CD-ROM available as a logical drive
Microsoft Windows NT 4.0 or higher

Attention: While the version of Oracle Workflow offered to
Oracle8i Standard Edition customers is exactly the same as the
version offered to Oracle8i Enterprise Edition customers, it is
important to note that Oracle Workflow leverages Oracle8i

functionality. Consequently, using an Oracle8i Standard Edition

database limits some of the features available for use by the
Oracle Workflow Business Event System.

For example:

— You cannot create any additional queues in Oracle8:
Standard Edition beyond the default queues provided by
Oracle Workflow. If you require additional queues, you
should choose Oracle8i Enterprise Edition.

— Oracle Advanced Queuing propagation in Oracle8i
Standard Edition does not support propagating messages
outside the local database. If you require messages to be
propagated to other systems, you should choose Oracle8i
Enterprise Edition.
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In Oracle%i, however, these restrictions no longer apply. Exactly
the same functionality is available with Oracle Workflow in an
Oracle9i Standard Edition database as in an Oracle9i Enterprise
Edition database.

The e-mail notifications component contains a Notification
Mailer program that can send mail through UNIX Sendmail or a
Windows NT MAPI-compliant mail application. Oracle
Workflow can also send mail to other e-mail applications as long
as you install the appropriate UNIX gateway product to
communicate with your e-mail application of choice.

Attention: The Microsoft Outlook E-mail Security Update
that was released on June 7, 2000 desupports the MAPI
Commmon Messaging Calls (CMC) interface used by the
Oracle Workflow MAPI Mailer. (See: OL2000: Developer
Information About the Outlook E—mail Security Update,
http://support.microsoft.com/support/kb/articles/
Q262/7/01.ASP) As a result, the Oracle Workflow MAPI Mailer
is not certified on any Microsoft Windows platforms where this
Microsoft Outlook E-mail Security Update or above has been
applied. The Oracle Workflow MAPI Mailer is not certified on
Windows XP.

Workflow customers running on NT /2000 are certified to
install the UNIX version of the Oracle Workflow Notification
Mailer (on UNIX) and connect to a Workflow Server database
running on NT/2000.

To send and respond to e-mail notifications with HTML
attachments, your e-mail application should support HTML
attachments and you should have a Web browser application
that supports JavaScript and Frames to view the attachment.

The Web notifications, Workflow Monitor, and Event Manager
components require Oracle HTTP Server and mod_plsql to be
installed on a server machine. The Oracle HTTP Server and
mod_plsql components are included with Oracle8i Database
version 8.1.7 or higher and with Oracle9i Database version 9.0.1
or higher, as well as with Oracle9i Application Server version
1.0.1 or higher.

To view notifications you need a Web browser application that
supports JavaScript and Frames. To view the Workflow Monitor
you need a Web browser that supports Java Development Kit
(JDK), Version 1.1.8 or higher and Abstract Windowing Toolkit
(AWT), such as Netscape Communicator version 4.76 or a higher
version of 4.7x, or Microsoft Internet Explorer version 5.0x or
5.5x.



¢ To run external Java function activities and to use the Workflow
XML Loader, you must have Java Runtime Environment (JRE)
version 1.1.8, or a higher 1.1.x version, installed.

e To extract the HTML help for the standalone version of Oracle
Workflow, you need an unzip utility.

¢ To implement Oracle Internet Directory and Single Sign—-On
integration, you must have Oracle Internet Directory Release 2
(9.0.2), Oracle9iAS Single Sign—On Server Release 2 (9.0.2)
installed, and Oracle9iAS Portal Release 2 (9.0.2) installed.
Additionally, you must have mod_osso installed with Oracle
HTTP Server.
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Overview of Setting Up

After you install Oracle Workflow, you implement it for your site by
setting up the preferences and components appropriate for your
enterprise.

Overview of Required Setup Steps for the Standalone Version of Oracle
Workflow

2-6

Oracle Workflow Guide

Set up the default Oracle Workflow user preferences for your entire
enterprise using the Global Preferences web page. The Global
Preferences web page also lets you define your workflow
administrator role and your Workflow web agent. See: Setting
Global User Preferences: page 2 — 14.

Map Oracle Workflow’s directory service to the users and roles
currently defined in your organization’s directory repository by
constructing views based on those database tables. The
Notification System uses these views to send notifications to the
performers specified in your activities. Your roles can be either
individual users or a group of users. Oracle Workflow provides
example directory services views that you can modify and reload.
See: Setting Up an Oracle Workflow Directory Service: page 2 - 21.

Create a view called WF_LANGUAGES that identifies the
languages defined in your Oracle database server installation.
Oracle Workflow uses this view to create in its translation tables, a
row that maps to a row found in its non—translated base table for
each installed language. See: Creating the WF_LANGUAGES
View: page 2 - 38.

Define an environment variable called WF_RESOURCES if your
Workflow server is installed on a UNIX platform. See: Setting the
WF_RESOURCES Environment Variable: page 2 — 42.

Set up background Workflow Engines to control the load and
throughput of the primary Workflow Engine on your system. You
can specify the cost threshold level of your primary and
background engines to determine the activities an engine processes
and the activities an engine defers. See: Setting Up Background
Workflow Engines: page 2 — 46.



Overview of Required Setup Steps for the Version of Oracle Workflow
Embedded in Oracle Applications

Optional Setup Steps

1.

Set up the default Oracle Workflow user preferences for your entire
enterprise using the Global Preferences web page. The Global
Preferences web page also lets you define your workflow
administrator role and your Workflow web agent. See: Setting
Global User Preferences: page 2 — 14.

Set the system profile options called Socket Listener Activated and
Socket Listener Port. See: Setting the Socket Listener Profile
Options: page 2 - 40.

Set up background Workflow Engines to control the load and
throughput of the primary Workflow Engine on your system. You
can specify the cost threshold level of your primary and
background engines to determine the activities an engine processes
and the activities an engine defers. See: Setting Up Background
Workflow Engines: page 2 — 46.

= Attention: Although your Oracle Workflow installation

automatically sets up the following for you, you may want to
refer to their appropriate sections for additional background
information:

— Directory services: page 2 - 21
— WF_LANGUAGES view: page 2 - 38
— Path to the language-dependent resources file: page 2 — 42

If you are using the version of Oracle Workflow embedded in
Oracle Applications, you can partition the
WE_ITEM_ACTIVITY_STATUSES,
WE_ITEM_ACTIVITY_STATUSES_H,
WE_ITEM_ATTRIBUTE_VALUES, and WE_ITEMS tables for
performance gain. See: Partitioning Workflow Tables: page 2 — 12.

If you are using the standalone version of Oracle Workflow, and
you have installed Oracle9iAS Release 2 or higher, you can
synchronize the user information in your Workflow directory
service with Oracle Internet Directory. See: Synchronizing
Workflow Directory Services with Oracle Internet Directory: page
2-30.
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10.

If you wish to integrate a certified document management system
with Oracle Workflow, define a node for the document
management system in the Document Nodes web page. (This
functionality will be supported in a future release.) See: Defining
Document Management Repositories: page 2 —43.

Set up the Notification Mailer program if you want to allow your
users to receive notifications by e-mail. See: Implementing the
Notification Mailer: page 2 - 51.

You can modify the templates for your electronic mail notifications.
See: Modifying Your Message Templates: page 2 - 72.

Customize the company logo that appears in Oracle Workflow’s
web pages. See: Customizing the Logo on Oracle Workflow’s Web
Pages: page 2 - 87.

You can include additional icons to your Oracle Workflow Icons
subdirectory to customize the diagrammatic representation of your
workflow processes. Use custom symbols for each activity you
define. See: Adding Custom Icons to Oracle Workflow: page 2 — 88.

Set up the Java Function Activity Agent if you are using the
standalone version of Oracle Workflow and you want to run
external Java function activities. See: Setting Up the Java Function
Activity Agent: page 2 — 89.

Set up the Business Event System if you want to communicate
business events between systems using event subscription
processing and Workflow process event activities. See: Setting Up
the Business Event System: page 2 - 99.

Set up the WF_EVENT_OMB_QH queue handler if you are using
the Business Event System with Oracle8i and you want to use
Oracle Message Broker to propagate event messages between
systems. See: Setting Up the WF_EVENT_OMB_QH Queue
Handler: page 2 - 103.

Before deploying Oracle Workflow and custom process definitions to
other branches of your enterprise, you can protect your data from
further modification by determining the level of access your users have
to the data. See: Overview of Oracle Workflow Access Protection: page
2-104.



You can also use the Workflow Definitions Loader to load workflow
process definitions from flat files to the database without using Oracle
Workflow Builder. See: Using the Workflow Definitions Loader: page
2-110.

If you are using the Business Event System, you can use the Workflow
XML Loader to load XML definitions for Business Event System objects
between a database and a flat file. See: Using the Workflow XML
Loader: page 2 - 115.

Identifying the Version of Your Oracle Workflow Server

If you ever need to determine the version of the Oracle Workflow
server you are running, you can connect to your Workflow server
account using SQLPLUS and run a script called wfver.sql. See:
wiver.sql: page 16 - 16.

In addition, all Oracle Workflow modules, such as the Workflow
Definitions Loader, Oracle Workflow Builder, Notification Mailer, and
the Workflow Monitor, automatically verify that the module is
compatible with the version of the Oracle Workflow server that it is
operating against. This version compatibility check helps to prevent
problems such as running Oracle Workflow Builder 2.6 against an
Oracle Workflow 2.0.3 database.
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Setup Flowchart

The following flowchart shows the Oracle Workflow setup steps. Some
of the steps are required and some are optional. You need to perform
optional steps only if you plan to use the related feature or complete
certain business functions.
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Setup Checklist

The following table lists Oracle Workflow setup steps. A reference to
whether the step is pertinent to the standalone or embedded version of
Oracle Workflow or both and whether the step is optional or required

is provided.
Ste Standalone/
P Required Step Embedded/
No. B
oth
Step1 | Optional [Partitioning Workflow Tables: page 2 — 12 Embedded
Step2 | Required |Setting Global User Preferences: page 2 - 14 Both
Step3 | Required |Setting Up an Oracle Workflow Directory Service: page Standalone
2-21
Step4 | Optional |Synchronizing Workflow Directory Services with Oracle | Standalone
Internet Directory: page 2 — 30
Step5 | Required |Creatingthe WF_LANGUAGES View: page 2 - 38 Standalone
Step 6 | Required |Setting the Socket Listener Profile Options: page 2 — 40 Embedded
Step7 | Required |Setting the WF_RESOURCES Environment Variable: Standalone
page 2 —42
Step 8 | Optional | Defining Document Management Repositories: page Both
2-43
Step9 | Required |Setting Up Background Workflow Engines: page 2 — 46 Both
Step 10 | Optional |Implementing the Notification Mailer: page 2 - 51 Both
Step 11 | Optional |Modifying Your Message Templates: page 2 — 72 Both
Step 12 | Optional |Customizing the Logo on Oracle Workflow’s Web Pages: | Both
page 2 - 87
Step 13 | Optional | Adding Custom Icons to Oracle Workflow: page 2 — 88 Both
Step 14 | Optional |Setting Up the Java Function Activity Agent: page2 -89 | Standalone
Step 15 | Optional | Setting Up the Business Event System: page 2 — 99 Both
Step 16 | Optional |Setting Up the WF_EVENT_OMB_QH Queue Handler: Both
page 2 — 103
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Setup Steps

Step1  Partitioning Workflow Tables

Partitioning addresses key issues in supporting very large tables and
indexes by letting you decompose them into smaller and more
manageable pieces called partitions. SQL queries and DML statements
do not need to be modified in order to access partitioned tables.
However, once partitions are defined, DDL statements can access and
manipulate individual partitions rather than entire tables or indexes. In
this way, partitioning can simplify the manageability of large database
objects. Also, partitioning is entirely transparent to applications.

If you are using the version of Oracle Workflow embedded in Oracle
Applications, you can optionally run a script called wfupartb.sql to
partition certain Workflow tables that store runtime status data. This
step is highly recommended for performance gain.

The script partitions four Workflow tables and recreates the associated
indexes. The following table shows the Workflow tables and indexes on
which the script runs.

Table Index

WEF_ITEM_ACTIVITY_STATUSES WEF_ITEM_ACTIVITY_STATUSES_PK

WEF_ITEM_ACTIVITY_STATUSES_N1

WEF_ITEM_ACTIVITY_STATUSES_N2

WE_ITEM_ACTIVITY_STATUSES_H WEF_ITEM_ACTIVITY_STATUSES_H_N1

WEF_ITEM_ACTIVITY_STATUSES_H_N2

WE_ITEM_ATTRIBUTE_VALUES WE_ITEM_ATTRIBUTE_VALUES_PK
WE_ITEMS WEF_ITEMS_PK

WE_ITEMS_N1

WE_ITEMS_N2

WE_ITEMS_N3

Table2-1 (Page1of1)

Before running wfupartb.sql, you should back up these four tables so
that you can restore them in case the script fails.

To run the script, you must have sufficient free space on the table and
index tablespaces. During the creation of the partitioned tables, the
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See Also

script requires slightly more diskspace than the underlying tables, in
the same tablespace where the underlying tables are located. Similarly,
sufficient free space is required for the index tablespace.

Additionally, you should allow sufficient time for the script to run. The
amount of time needed depends on the amount of data in the tables.
When the tables already contain existing data, such as after an upgrade
from a previous release, the script requires more time than it does
when the tables are empty, such as after a fresh installation of Oracle
Workflow. To minimize the time required, run the script as early as
possible in your setup process.

= Attention: If you are running wfupartb.sql through Oracle
Net Services, then you must set the TWO_TASK variable before
you begin.

The script is located in the admin/sql subdirectory under $FND_TOP.
Use the script as follows:

saglplus <apps_user>/<apps_passwd> @wfupartb <fnd_user>
<fnd_passwd> <apps_user> <apps_passwd>

For example:

sqglplus apps/apps @wfupartb applsys apps apps apps

If the script fails, you must perform any necessary cleanup manually.
Since the script’s operations are DDL operations running in nologging
mode, rollback is not possible.

Context: You need to perform this step only once.

Partitioning for Performance: page C - 8
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Step2  Setting Global User Preferences

You can control how you interact with Oracle Workflow by specifying
user preferences that you can set from the User Preferences web page.
As a workflow administrator, you also have access to the Global
Preferences web page, which you can use to globally set default user
preference values for the entire enterprise. An individual user can
override a default user preference at any time by changing the value of
the user preference in the User Preferences web page. Both web pages
are accessible from the Oracle Workflow Home page, but only a
workflow administrator has access to the Global Preferences page.

= Attention: The Language, Territory, and Notification
preference settings in the Global Preferences and User
Preferences web pages are valid only if your directory service
views map the Language, Territory, and
Notification_Preference columns to the Oracle Workflow
preferences table. If you map to some other preference source
or set a hard—coded value to these columns, any changes you
make to the preferences via the preferences web pages are
ignored. See: Setting Up an Oracle Workflow Directory
Service: page 2 - 21.

Context: You need to perform this step only once.

See: Setting User Preferences: page 9 — 6.

p To Set Global User Preferences

1. Use a web browser to connect to the Oracle Workflow home page,
then choose the Global Preferences link:

<webagent>/wfa_html.home

Alternatively, you can connect directly to the Global Preferences
web page:

<webagent>/wf_pref.edit?edit_defaults=Y

<webagent> represents the base URL of the web agent you
configured for Oracle Workflow in your Web server.

= Attention: These are secured pages, so if you have not yet
logged on as a valid user in the current web session, you will
be prompted to do so before the page appears.
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% Global Workflow Preferences - WF26 - Netscape

2. The Global Preferences web page displays a summary of your
current global preferences. Choose Update to modify these
preferences.
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3 Global Workflow Preferences - WF26 - Nelscape

[ﬁl Glohal Workflow Preferences [ jl,[ ? J ORACLE

i

Workflow Administrator I* "ﬂ

Workflow Web Agent Ihttp A/ www.asa_url.comd wE/owa "

Jinitigtor Classid [££346h6e-£d21-11d4-a3£0-00c04£a32518 |

Jmitiater Diownload Location Ihttp A fwww.aas url.comdplugins/ jinit. exe"

Jinitiator Wersion |1 .1.8.6 "

Local System [WFSI uj

System Status
LDAP Host | |
LDAP Port
LA s e

LDAP ChangeLog Base Directory | |

LDAP User Base Directory | |

Language [AMERICAN [AMERICAN-AMERICA]

Termitory [AMERICA [AMERICA-AMERICAN]

Document Home Node
Send me electronic mail notifications [HTML mail

Ok Cancel

3. In the Workflow Administrator field, use the list of values to select
the role to which you want to assign workflow administrator
privileges. Any user associated with this role can run the Oracle
Workflow Find Processes web page, which provides full access to
Oracle Workflow’s administration features. In addition, any user
in the administration role can view any other user’s notifications
and access the Event Manager web pages.

If you want all users and roles to have workflow administrator
privileges, such as in a development environment, enter an asterisk
(*) in the Workflow Administrator field. See: Setting Up an Oracle
Workflow Directory Service: page 2 — 21.

Note: To find out which role currently has workflow
administrator privileges, without accessing the Global
Workflow Preferences page, you can use the following
command:
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select text
from wf_resources
where name = ’'WF_ADMIN_ROLE’;

After installing Oracle Workflow, you should change the Workflow
Administrator preference from the default setting to the role that
you want to have administrator privileges.

¢ For the standalone version of Oracle Workflow, the default
setting after installation is an asterisk (*). You can log in as any
user to access the Global Workflow Preferences page and specify
the preferences you want.

e For the version of Oracle Workflow embedded in Oracle
Applications, the default setting after installation is SYSADMIN.
You must log in as the SYSADMIN user to access the Global
Workflow Preferences page and specify the preferences you
want.

Note: The SYSADMIN role is different than the role associated
with the System Administrator responsibility in Oracle
Applications. If you want to assign workflow administrator
privileges to this or any other Oracle Applications
responsibility, you must set the Workflow Administrator
preference to the internal name of the Workflow role associated
with that responsibility.

You can query the WF_ROLES view to find the role name for a
responsibility. For example, to find the role names for various
administrator responsibilities in Oracle Applications, use the
following command:

select name, display_name
from wf_roles
where display_name like ’‘%$Admin%’;

If you set the Workflow Administrator preference to the role
name of a responsibility, then any Oracle Applications user
with that responsibility will have workflow administrator
privileges.

4. In the Workflow Web Agent field, enter the base URL of the Oracle

web agent you defined for Oracle Workflow in Oracle HTTP
Server.

Caution: The list of values fields that are implemented in
many of Oracle Workflow’s web pages will not function
properly unless you specify the base URL of your Oracle
Workflow web agent in this field.
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The base URL should look like this if you are using Oracle HTTP
Server as your Web server:

http://<server.com:portID>/pls/<DAD_name>

<server.com:portID>represents the server and TCP/IP port
number on which your web listener accepts requests and
<DAD_name> represents the name of the DAD you configured for the
Oracle Workflow database schema.

See your Oracle HTTP Server documentation for more information.

= Attention: If you are using the version of Oracle Workflow

embedded in Oracle Applications, you should also edit the
APPS_WEB_AGENT profile option.

If you are using the version of Oracle Workflow embedded in
Oracle Applications, enter the Jinitiator plugin class ID, download
location, and version number. This information is required for
Oracle Workflow to launch Oracle Applications forms linked to
notifications and to display the Workflow Monitor. See: Setting the
Socket Listener Profile Options: page 2 — 40.

The Local System field displays the system name for the database
where this installation of Oracle Workflow is located. Oracle
Workflow automatically creates the system definition for this
database in the Event Manager during installation. The Business
Event System treats this system as the local system and all others as
external systems. See: Systems: page 13 - 17.

Note: The Local System setting is specific to this installation of
Oracle Workflow and is not included when Business Event
System data is replicated to other systems.

In the System Status field, use the list of values to select the
Business Event System status that you want to assign to the local
system.

¢ Enabled—Subscriptions are executed on all events.

¢ Local Only—Subscriptions are executed only on events raised on
the local system.

¢ External Only—Subscriptions are executed only on events
received from external systems.

¢ Disabled—No subscriptions are executed on any events.

Note: Oracle Workflow sets the system status to Enabled by
default. After you finish setting up the Business Event System,
you can change the setting to the status you want for event
processing.



10.

11.

12.

Note: The System Status setting is specific to this installation
of Oracle Workflow and is not included when Business Event
System data is replicated to other systems.

If you are implementing Oracle Internet Directory (OID)
synchronization, specify the Lightweight Directory Access Protocol
(LDAP) server information for the LDAP directory to which you
want to connect.

e LDAP Host—The host on which the LDAP directory resides.
e LDAP Port—The port on the host.

If you are implementing OID synchronization, specify the LDAP
user account used to connect to the LDAP server. This LDAP user
account must have write privileges.

e LDAP User Name—The LDAP user. This user name is required
to bind to the LDAP directory. For example:

cn=orcladmin

e LDAP Password—The LDAP password. The password is stored
in encrypted form.

If you are implementing OID synchronization, specify the
directories for the change log and the user records.

¢ LDAP Changelog Base Directory—The LDAP node under which
change logs are located. For example:

cn=changelog

e LDAP User Base Directory—The LDAP node under which user
records can be found. For example:

cn=Base, cn=0OracleSchemaVersion

In the Language and Territory fields, use the list of values to select
the NLS_LANGUAGE and NLS_TERRITORY combination that
defines the default language—dependent behavior and
territory-dependent formatting of your users’ notification sessions.

In the Date Format field, specify an Oracle8i—compliant date format
that defines the default date format for the workflow database
sessions of all users. An example of an Oracle8i—compliant date
format is DD-Mon-RRRR. If you do not specify a date format,
then the date format defaults to DD-MON-YYYY.

Note: Oracle Workflow may include a time element when
relevant for certain displayed dates, even if you do not include
a time format with your date format. If you specify a time
format along with your date format, then in those situations

Setting Up Oracle Workflow ~ 2-19



2-20

Oracle Workflow Guide

when Oracle Workflow displays a time element, you will see
two time elements following your date.

13. In the Document Home Node field, use the list of values to select
the default Document Management repository that users access
when they attempt to attach or access an attached document
management document. (This functionality will be supported in a
future release.)

14. In the ‘Send me electronic mail notifications’ field, use the list of
values to select a notification preference:

HTML mail—Send notifications as HTML e—mail. Users must
read their mail using an HTML e-mail viewer.

Plain text mail with HTML attachments—Send notifications as
plain text e-mail but include the HTML—formatted version of the
notifications as attachments.

Plain text mail—Send notifications as plain text e-mail.

Plain text summary mail—Send a summary of all notifications as
plain text e-mail. Users must use the Notifications web page to
take action on individual notifications.

Do not send me mail—Do not send the notifications as e—mail.
Users must view the notifications and take action from the
Notifications web page.

15. Click OK once you are satisfied with your changes.

Note: These global language, territory, document home node,
and notification preferences are saved to the Oracle Workflow
Preferences table for a special user name called
-WF_DEFAULTS-. The workflow administrator role,
workflow web agent, local system, and LDAP information is
saved to the Workflow Resources table.



Step 3

Setting Up an Oracle Workflow Directory Service

Oracle Workflow offers you flexibility in defining who your workflow
users and roles are. You determine the directory repository you want
Oracle Workflow to reference for users and roles information by
creating three views based on the database tables that make up that
repository. The views are:

e WF_USERS
e WF_ROLES
e WF_USER_ROLES

In addition, Oracle Workflow provides three local tables called
WE_LOCAL_USERS, WF_LOCAL_ROLES, and
WEF_LOCAL_USER_ROLES that contain columns similar to those
defined in the WF_USERS, WF_ROLES, and WF_USER_ROLES views,
respectively. You can use these tables to store users and roles not
included in your existing directory repository by calling the
appropriate Directory Service PL/SQL API. See: Workflow Directory
Service APIs: page 8 — 121.

= Attention: You should avoid selecting from DUAL to
incorporate additional users and roles into the directory service
views as this allows you to violate the unique constraint on
certain columns of the views and reduces performance with
unnecessary joins between the “select from DUAL’ statements.

Note: If you are using the standalone version of Oracle
Workflow, and you have installed Oracle9iAS Release 2 or
higher, you can integrate your Workflow directory service with
Oracle Internet Directory (OID) as your directory repository. In
this case, you must map your directory service views only to
the WF_LOCAL tables to enable synchronization of Workflow
user information with OID. See: Integrating Oracle Workflow
Directory Services with Local Workflow Users: page 2 — 28 and
Synchronizing Workflow Directory Services with Oracle
Internet Directory: page 2 — 30.

Context: You need to perform this step only once.
See: Predefined Directory Services: page 2 — 26
See: Ad Hoc Users and Roles: page 5 — 24

WEF_USERS

The WF_USERS view should reference information about all the
individuals in your organization who may receive workflow
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notifications. Create this view, making sure it contains the following
columns:

¢ Name—The internal name of the user as referenced by the

Workflow Engine and Notification System. For example, an
internal name for a user can be mbeech or 009, where 009
represents the user’s employee ID.

Attention: The Name column must be sourced from a column
that is less than 30 characters long and is all uppercase. If your
source table does not have a column that meets these criteria,
DO NOT use string functions to force these restrictions.
Instead, define the Name column to be
<orig_system>:<orig_system_id> so that Oracle Workflow can
reference the original base table where users are stored and a
unique user in that table. For example, "PER_PEOPLE:009”
represents a user whose employee ID is 009 and is stored in the
personnel table called PER_PEOPLE.

¢ Display_Name—The display name of the user. An example of a

display name can be ‘Beech, Matthew’.
Description—An optional description of the user.

Notification_Preference—Indicate how this user prefers to
receive notifications. A value of MAILTEXT, MAILHTML, Oor
MAILATTH allows users to receive and respond to notifications
by plain text e-mail, HTML-formatted e-mail or by plain text
e-mail with HTML attachments, respectively. A value of QUERY
allows users to query notifications from the Notifications Web
page. Finally, a value of SUMMARY allows users to get periodic
e-mail summaries of their open notifications. However, to
respond to the individual notifications, they have to query the
notification from the Notification Web page. See: Overview of
Notification Handling: page 10 — 2 and Notification Preferences:
page 2 —52.

Note: A notification preference of MAILTEXT, MAILHTML,
or MAILATTH also allows users to query their notifications
from the Notifications Web page.

Note: You can map the Notification_Preference column over
the Oracle Workflow preferences table using the statement
below. The benefit of this is that you can then globally set the
default notification preference for all users in your enterprise
using the Global Preferences web page and let individual users
override that default value by changing their notification
preference in the User Preferences web page. See: Global



Preferences: page 2 — 14, User Preferences: page 9 — 6 and
get_pref: page 8 — 148.

NVL (wf_pref.get_pref (USR.USER_NAME, 'MAILTYPE') ,
"MAILHTML' )

e Language—The value of the database NLS_LANGUAGE
initialization parameter that specifies the default
language-dependent behavior of the user’s notification session.
Refer to your Oracle Database user’s guide or installation
manual for the list of supported language conventions.

Note: You can globally set the language for all the users in
your enterprise, by specifying a language in the Global
Preferences web page. Individual users may override that
default value by changing their language in the User
Preferences web page. See: Global Preferences: page 2 — 14,
User Preferences: page 9 — 6 and get_pref: page 8 — 148.

Note: You can map the Language column over the Oracle
Workflow preferences table using the statement below. The
benefit of this is that you can then globally set the default
Language for all users in your enterprise using the Global
Preferences web page and let individual users override that
default value by changing their Language in the User
Preferences web page. See: Global Preferences: page 2 — 14 and
User Preferences: page 9 — 6.

NVL (wf_pref.get_pref (USR.USER_NAME, ' LANGUAGE’)
FNDL .NLS_LANGUAGE)

= Attention: Make sure that the e-mail templates used by the

Notification Mailer to send notifications have been translated
by Oracle to the language you wish to set. The e-mail
templates are delivered in a file called wfmail wft under the
subdirectory SORACLE_HOME /wf/res/<lang>. You can
check the appropriate language subdirectory to verify if the
templates have been translated to the language you wish to set.
See: Modifying Your Message Templates: page 2 - 72.

e Territory—The value of the database NLS_TERRITORY
initialization parameter that specifies the default
territory—dependant formatting used in the user’s notification
session. Refer to your Oracle Database user’s guide or
installation manual for the list of supported territory
conventions.

Note: You can map the Territory column over the Oracle
Workflow preferences table using the statement below. The
benefit of this is that you can then globally set the default
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Territory for all users in your enterprise using the Global
Preferences web page and let individual users override that
default value by changing their Territory in the User
Preferences web page. See: Global Preferences: page 2 — 14,
User Preferences: page 9 — 6 and get_pref: page 8 — 148.

NVL (wf_pref.get_pref (USR.USER_NAME, 'TERRITORY') ,
FNDL.NLS_TERRITORY)

Email_Address—A valid electronic mail address for this user or
a mail distribution list defined by your electronic mail system.

Fax—A Fax number for the user.

Orig_System—A code that you assign to the directory repository
that this view is based on. For example, if this view is based on
the personnel data stored in a Human Resource Management
System, Orig_System can be defined as PER.

Orig_System_ID—The primary key that identifies the user in this
repository system. For example, Orig_System_ID can be defined
as the value stored in a column called PERSON_ID in a Human
Resources database table called PER_PEOPLE.

Status—The availability of the user to participate in a workflow
process. The possible statuses are: active (ACTIVE), unavailable
for an extended period (EXTLEAVE), permanently unavailable
(INACTIVE), and temporarily unavailable (TMPLEAVE). These
statuses are also stored in the lookup type called
WESTD_AVAILABILITY_STATUS.

Expiration_Date—The date at which the user is no longer valid
in the directory service.

WF_ROLES

The WF_ROLES view should reference information about all the roles in
your organization who may receive workflow notifications. Create this
view, making sure it contains the following columns pertaining to the
roles in your repository. Those columns that are preceded by an
asterisk (*) are similar to the matching column described for the
WF_USERS view:

ISy

Attention: We require that you also define each user
identified by WF_USERS as a role.

Note: If a user is a member of a role and the user information
is different from the role information, the role information will
override the user information when the Notification System

delivers a notification to the role. For example, suppose a user



has a notification preference of 'SUMMARY’, and the user is
also a member of a multi—user role, whose notification
preference is ' MAILHTML'. When a notification is assigned to
the multi-user role, the user will receive a single notification
message addressed to the role, as opposed to a summary
message that includes that notification in it.

Name—The internal name of the role. The Name column must
be sourced from a column that is less than or equal to 30
characters long and is all uppercase. If your source table does
not have a column that meets these criteria, DO NOT use string
functions to force these restrictions. Instead, define the Name
column to be <orig_system>:<orig_system_id> so that Oracle
Workflow can reference the original base table where roles are
stored and a unique role in that table. For example,
"PER_POSITION:009” represents a position whose ID is 009 and
is stored in the personnel table called PER_POSITION.

*Display_Name
*Description
*Notification_Preference
*Language

*Territory

Email Address—if the e-mail address is null for a given role, the
Notification Mailer sends an individual e-mail to each user
within the role.

*Fax
*Orig_System
*Orig_System_ID
*Status

*Expiration_Date

WF_USER_ROLES

The WF_USER_ROLES view is an intersection of the users and roles in
WF_USERS and WF_ROLES. Create this view, making sure it contains
the following columns:

e User_Name—The internal name of the user as listed in the view

WF_USERS.
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e User_Orig_System—A code that you assign to the user directory
repository as listed in the view WF_USERS.

e User_Orig_System_ID—The primary key that identifies the user
in the user directory repository as listed in the view WF_USERS.

e Role_Name—The internal name of the role as listed in the view
WF_ROLES.

¢ Role_Orig_System—A code that you assign to the role directory
repository as listed in the view WF_ROLES.

¢ Role_Orig_System_ID—The primary key that identifies the role
in the role directory repository as listed in the view WF_ROLES.

Attention: To take advantage of unique indexes when

ISy querying users, make sure you initially enter the usernames in
your database in uppercase only. Forcing the usernames to
uppercase in your view definition results in poor performance
when accessing these views.

A Warning: Avoid making a join to a view that contains a union
as this results in poor database performance. The Oracle

database server is unable to preserve the indexes in that view
when you make such a join. The workflow directory services
views you create will most likely contain unions, therefore you
should not join to them directly. If you need to retrieve data
from any of the three directory services views, use the
appropriate directory services API. See: Workflow Directory
Services APIs: page 8 —121.

Predefined Directory Services

Oracle Workflow provides scripts for you to implement any one of
three directory service environments. If you are using the version of
Oracle Workflow embedded in Oracle Applications you automatically:

¢ Integrate your Oracle Workflow directory service with a unified
Oracle Applications environment.

If you are using the standalone version Oracle Workflow, you can
choose to implement one of the following two directory services or
create your own:

¢ A directory services with native Oracle users.
e A directory services with local workflow users.

You can customize any of these directory services environments further
by editing and rerunning their scripts against your Workflow Server.



= Attention: If you create your own directory service or edit
any of the predefined directory services listed above, you
should run the script wfdirchk.sql to validate your directory
service data model. The script is located on your server in the
Oracle Workflow admin/sql subdirectory for the standalone
version of Oracle Workflow, or in the sql subdirectory under
$FND_TOP for the version of Oracle Workflow embedded in
Oracle Applications. See: Wfdirchk.sql: page 16 - 10.

Integrating Oracle Workflow Directory Services with a Unified
Oracle Applications Environment

If you are using the version of Oracle Workflow embedded in Oracle
Applications, your Oracle Workflow directory service views are
automatically based on a unified Oracle Applications environment.
The unified environment maps over Oracle Human Resources tables,
Oracle Application Object Library tables, various Oracle Applications
tables, and the WF_LOCAL tables.

Oracle Workflow provides a sql script that defines the WF_USERS,
WEF_ROLES, and WF_USER_ROLES views that map to this unified
environment. When you install Oracle Applications, you automatically
install this script to create the unified environment. However, if you
should need to edit and rerun this script for whatever reason, the script
is called wfdirhrv.sql and is located on your server in the admin/sql
subdirectory under $FND_TOP.

Aside from the users and roles stored in WF_LOCAL_USERS and
WE_LOCAL_ROLES, the default notification preference for all
workflow users and roles in the unified environment is set to
"MAILHTML'.

Integrating Oracle Workflow Directory Services with Native Oracle
Users

If you plan to use the standalone version of Oracle Workflow, you can
map your directory service to the native users and roles in the Oracle
RDBMS. You base your views on the tables DBA_USERS,
WF_LOCAL_USERS, DBA_ROLES, and WF_LOCAL_ROLES.

Oracle Workflow provides a script you can use to setup the views. Use
the wfdirouv.sql script in the Oracle Workflow sql subdirectory on your
server. This script is automatically run by the Oracle Universal
Installer when you install the standalone version of Oracle Workflow.
You can customize and rerun this script if necessary. The script creates
three views.
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The WF_USERS view creates a workflow user for each DBA user and
any users stored in WF_LOCAL_USERS. For each DBA user, the
originating system is called ORACLE, and the originating system ID is
the USERNAME column in DBA_USERS. The default notification
preference for each DBA user is MAILHTML.

The WF_ROLES view includes all users in the WF_USERS view, all roles
defined in the WF_LOCAI_ROLES table, and all roles in DBA_ROLES,
where role_name begins with WF. For each DBA role, the originating
system is ORACLE and the originating system ID is the ROLE column in
DBA_ROLES. The default notification preference for each DBA role is
MATILHTML.

The WF_USER_ROLES view consists of the names and originating
system information of both users and roles in WF_USERS and
WF_ROLES.

Note: The wfdirouv.sql script sets each native Oracle user’s
e—mail address to the user’s respective username. Asa
minimal setup step, you should edit the wfdirouv.sql script to
either link your native Oracle users to an existing mail
directory store through the WF_ROLES view definition, or, if
the usernames and e-mail account names match, then simply
add the domain for your organization, such as ‘@oracle.com’,
to the usernames in the WF_USERS view definition. Typically,
the columns that you change are EMAIL_ADDRESS in
WE_USERS and EMAIL_ADDRESS in WE_ROLES.

Integrating Oracle Workflow Directory Services with Local Workflow
Users

If you plan to use the standalone version of Oracle Workflow and the
users and roles of your directory repository are not stored in any
existing database tables, you can enter your users and roles information
in the WF_LOCAL tables and map your directory service to these
tables.

Oracle Workflow provides a script you can use to set up the views.

Use the wfdircsv.sql script in the Oracle Workflow sgl subdirectory on
your server. This script creates three views. You can customize the
views in this script to incorporate the users and roles from your custom
directory repository.

= Attention: If you want to implement Oracle Internet Directory
(OID) integration for the standalone version of Oracle
Workflow, you must run the wfdircsv.sql script to ensure that
your directory service views are mapped only to the
WF_LOCAL tables, because only the WF_LOCAL_USERS table



will be synchronized with OID. (Only users are maintained
through OID, not Workflow roles.) In this case, you must not
customize the script to incorporate any other tables. After
implementing OID integration, you maintain your user
information only through OID. See: Synchronizing Workflow
Directory Services with Oracle Internet Directory: page 2 — 30.

The originating system in the WF_USERS view is called
WF_LOCAL_USERS, and the originating system ID is 0.

The WF_ROLES view includes all users in WF_LOCAL_USERS and all
roles defined in WF_LOCAL_ROLES. The originating system is
WF_LOCAL_ROLES and the originating system ID is 0.

The WF_USER_ROLES view consists of the names and originating
system information of both users and roles in WF_USERS and
WEF_ROLES.
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Synchronizing Workflow Directory Services with Oracle Internet
Directory

If you are using the standalone version of Oracle Workflow, and you
have installed Oracle9iAS Release 2 or higher, you can synchronize the
user information in your Workflow directory service with Oracle
Internet Directory (OID) using Lightweight Directory Access Protocol
(LDAP). This integration is recommended because it enables you to
manage and publish user information in a central location which
various systems can reference.

Synchronization with OID enables Oracle Workflow to do the
following:

e Participate in single sign-on through LDAP external
authentication with Oracle Portal and Oracle9iAS Single
Sign—-On Server. With single sign-on, a user who is logged into
any participating Oracle9iAS component is automatically
authenticated when accessing any other participating component
and does not need to log in again.

¢ Assign ownership of work items and send notifications to users
defined in OID.

¢ Synchronize with other external user directories that are
synchronized with OID.

Context: You need to perform this step only once.

Oracle Internet Directory

Oracle Internet Directory is a general purpose directory service that
enables fast retrieval and centralized management of information about
dispersed users and network resources. It combines Lightweight
Directory Access Protocol (LDAP) Version 3 with the high
performance, scalability, robustness, and availability of Oracle9:.

LDAP is a standard, extensible directory access protocol. It is a
common language that LDAP clients and servers use to communicate.
LDAP was conceived as an internet-ready, lightweight implementation
of the International Standardization Organization (ISO) X.500 standard
for directory services. It requires a minimal amount of networking
software on the client side, which makes it particularly attractive for
internet-based, thin client applications.

The advantages of OID include:

e Scalability — Oracle Internet Directory exploits the strengths of
Oracle9i, enabling support for terabytes of directory information.



See Also

In addition, such technologies as multithreaded LDAP servers
and database connection pooling allow it to support thousands
of concurrent clients with subsecond search response times.

Oracle Internet Directory also provides data management tools,
such as Oracle Directory Manager and a variety of
command-line tools, for manipulating large volumes of LDAP
data.

¢ High availability — Oracle Internet Directory is designed to meet
the needs of a variety of important applications. For example, it
supports full, multimaster replication between directory servers:
If one server in a replication community becomes unavailable,
then a user can access the data from another server. Information
about changes made to directory data on a server is stored in
special tables on the Oracle9i database. These are replicated
throughout the directory environment by Oracle9i Replication, a
robust replication mechanism.

Oracle Internet Directory also takes advantage of all the
availability features of Oracle9i. Because directory information is
stored securely in the Oracle9i database, it is protected by
Oracle’s backup capabilities. Additionally, the Oracle9i database,
running with large datastores and heavy loads, can recover from
system failures quickly.

e Security — Oracle Internet Directory offers comprehensive and
flexible access control. An administrator can grant or restrict
access to a specific directory object or to an entire directory
subtree. Moreover, Oracle Internet Directory implements three
levels of user authentication: anonymous, password-based, and
certificate-based using Secure Socket Layer (SSL) Version 3 for
authenticated access and data privacy.

e Synchronization with other directories — Oracle Internet
Directory includes the Oracle Directory Integration platform that
enables you to synchronize with other enterprise repositories,
including third-party LDAP directories.

Oracle9iAS Single Sign—On uses Oracle Internet Directory to store user
entries. It maps users for any partner application to user entries in OID
entries, and authenticates them by using LDAP mechanisms.

Oracle Internet Directory Administrator’s Guide
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Oracle9iAS Single Sign—On

Oracle9iAS Single Sign—On is a component of Oracle9i Application
Server that provides a framework for secure single sign-on, allowing
users to log in to multiple Web-based applications by entering a user
name and password only once.

Oracle9iAS Single Sign—On provides the following benefits:

e FEase of administration and reduced administrative costs,
because user names and passwords can be stored and
maintained outside of any particular application and shared
across the enterprise

¢ Convenient login experience, because users do not need to
maintain a separate username and password for each application
they access

¢ Increased security, because when the password is only required
once, users are less likely to use simple, easy—to-remember
passwords or write them down

The core of the Oracle9iAS Single Sign—On technology is the Login
Server. The Login Server authenticates users and passes their identities
to the partner applications that are integrated with it.

Partner applications support a single sign—on mechanism that enables
them to accept a user’s username and password as validated by the
Login Server. A partner application delegates its authentication to the
Login Server. If a partner application is registered with the Login
Server, users can log into it using the single sign—on mechanism.

With mod_osso, an Oracle module that enables single sign—on, Oracle
HTTP Server becomes a partner application of the Login Server. Oracle
Workflow uses Oracle HTTP Server as its Web server. If you implement
Oracle Internet Directory /Single Sign-On integration, Oracle Workflow
participates in single sign—on by using mod_osso to authenticate access
to its secured web pages.

When a user first tries to access a secured Workflow web page, the
Workflow security package WFA_SEC checks the CGI environment
variable REMOTE_USER for user information. If the user is not already
logged in to Oracle Workflow or another Oracle9iAS Single Sign—On
participating application, the user will be prompted to log in before the

page appears.

Note: The WFA_SEC package must be loaded as a post-install
step if you choose to implement Oracle Internet
Directory/Single Sign—On integration. For more information,
see your installation documentation.



To set the variable REMOTE_USER, Oracle HTTP Server internally
calls to mod_osso. Acting as an Oracle9iAS Single Sign-On partner
application, mod_osso transparently redirects the user to the Login
Server to obtain authentication credentials, if no application cookie is
present.

The Login Server performs the following steps:

e Prompts the user for the user name and password, if no login
cookie is present.

e Authenticates the user by means of the user name and password,
using external repository authentication that relies on an
LDAP-compliant directory, specifically Oracle Internet Directory.
The Login Server binds to OID and then looks up the user
credentials stored in the directory.

e Stores an encrypted login cookie on the authenticated client.

e Transparently redirects the user to the partner application,
mod_osso, by using a URL with an encrypted parameter
containing the user’s identity.

Oracle HTTP Server with mod_osso then performs the following steps:
e Decrypts the parameter.
e Identifies the user.

¢ Establishes its own session management (for example,
determining what, if any, access privileges to grant to the user).

e Sets a partner application cookie so that subsequent user access
does not require a redirect to the Login Server.

¢ Presents the requested application page to the user.

If, during the same session, the user again seeks access to the same or
to a different partner application, the Login Server does not prompt the
user for a username and password. Instead, the Login Server obtains
the information from the login cookie that is already on the client
browser. The login cookie provides the Login Server with the user’s
identity and indicates that authentication has already been performed.
If there is no login cookie, the Login Server presents the user with a
login page.

To guard against eavesdropping, the Login Server can send the login
cookie to the client browser over an encrypted SSL channel.

The login cookie expires with the session, either at the end of a time
interval specified by the administrator, or when the user exits the
browser. The login cookie is never written to disk.
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Note: To log out of a partner application and log in as another
user, the user must also log out of the Login Server session.
Otherwise, the authentication request returns the partner
application to the logged in state of the previous user.

Oracle9iAS Single Sign—On Administration Guide
Oracle9iAS Single Sign—On Application Developer’s Guide

Oracle Internet Directory Synchronization

Oracle Workflow provides APIs to synchronize the user information in
your Workflow directory service with OID. These APIs are defined in a
PL/SQL package called WF_LDAP. See: Workflow LDAP APIs: page

8 -144.

Note: OID integration includes only individual users, not user
groups. Workflow roles are not maintained through OID.

To Synchronize Workflow Directory Services with OID

1. Ensure that the following PL/SQL packages required for LDAP
synchronization are loaded in your database:

o DBMS_LDAP—This package contains the functions and
procedures which can be used to access data from LDAP servers.

o WFA_SEC—This package contains Workflow security functions
and procedures.

For the standalone version of Oracle Workflow, installation of these
packages is completed as part of the post-installation steps after
you install the Oracle Workflow server.

2. Ensure that the Database Access Descriptor for Oracle Workflow is
protected in the mod_osso configuration file. For the standalone
version of Oracle Workflow, mod_osso configuration is completed
as part of the post-installation steps after you install the Oracle
Workflow server.

3. Ensure that the following global Workflow preferences are set to
the appropriate information for your OID installation. See: To Set
Global User Preferences: page 2 - 14.

e LDAP Host



LDAP Port

LDAP User Name

LDAP Password

LDAP Changelog Base Directory
e LDAP User Base Directory

Run the wfdircsv.sql script to map your directory service views only
to the WF_LOCAL tables. See: Integrating Oracle Workflow
Directory Services with Local Workflow Users: page 2 — 28.

Enable the predefined subscription to the
oracle.apps.wf.public.user.change event with the rule function
WE_SSO.user_change. See: User Entry Has Changed Event: page
14 — 15 and To Update or Delete an Event Subscription: page

13 -51.

To begin the synchronization, run the WF_LDAP.Synch_all( ) APL
This function retrieves all the existing user information from OID,
based on the LDAP directory information specified in the Global
Workflow Preferences, and raises the
oracle.apps.wf.public.user.change event. The predefined
subscription to this event that you enabled loads the user
information into the WF_LOCAL_USERS table.

Because Synch_all( ) retrieves information for all users stored in
OID, you should use this function only once during setup. If
necessary, however, you can also run Synch_all( ) as required for
recovery or cleanup.

Use the following commands to run Synch_all( ):

declare
res boolean := FALSE;
begin
wf_log_pkg.WF_DEBUG_FLAG := TRUE;

res := wf_ldap.synch_all();
if (res) then
dbms_output.put_line(’succeeded’) ;
else
dbms_output.put_line(’'failed ’);
end if;
end;
/
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Subsequently, you must maintain the synchronization between
your Workflow directory service and OID by retrieving and
loading only changed OID user information. It is recommended
that you update the user information every ten minutes.

You can use either WF_LDAP.Synch_changes( ) or
WE_LDAP.Schedule_changes( ) to retrieve changed user information
from OID. WF_LDAP.Synch_changes( ) identifies LDAP user
changes in OID, including creation, modification, and deletion, by
querying the LDAP change log records. The function connects to
OID based on the LDAP directory information specified in the
Global Workflow Preferences. If there is a change, the function
retrieves the user information from OID and raises the
oracle.apps.wf.public.user.change event. The predefined
subscription to this event that you enabled loads the changed user
information into the WF_LOCAL_USERS table. You can use
WEF_LDAP.Synch_changes( ) to perform a single update.

To continue updating user information periodically, use
WEF_LDAP.Schedule_changes( ). This procedure submits a database
job using the DBMS_JOB utility to run WF_LDAP.Synch_changes( )
repeatedly at an interval that you specify. The default interval,
which is also the recommended frequency to check for updates, is
ten minutes.

You can create a script to run WF_LDAP.Schedule_changes( ). For
example, to run the API at an interval of ten minutes, create a SQL
file with the following commands:

declare
begin
wf_log_pkg.WF_DEBUG_FLAG := TRUE;
wf_ldap.schedule_changes(0,0,10);
end;
/

Then run SQL*Plus and load your new script to the database.

Note: You must terminate the running of any WE_LDAP APIs
before changing your LDAP setup, such as by migrating to a
different LDAP server.

= Attention: If you implement OID integration, you must

maintain your users only through OID. You must not create ad
hoc users in the WF_LOCAL_USERS table, because you risk
discrepancies in your user information and unpredictable
results if you use any tool other than OID to maintain users
after integrating with OID. Consequently, if you implement
OID integration, you must not use the CreateAdHocUser( ),



SetAdHocUserStatus( ), SetAdHocUserExpiration( ), or
SetAdHocUserAttr( ) APIs in the WF_DIRECTORY package.

You can still use ad hoc roles, however, since Workflow roles
are not maintained through OID.

See Also

Setting Global User Preferences: page 2 — 14
Workflow LDAP APlIs: page 8 — 144

User Entry Has Changed Event: page 14 - 15
Managing Job Queues, Oracle Administrator’s Guide

Workflow Directory Service APlIs: page 8 — 121
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Creating the WF_LANGUAGES View

The field values in the property pages of Oracle Workflow Builder and
the workflow notifications delivered to your users can be translated to
the languages defined in your Oracle installation. However, in order
for this to be possible, you must create a view called
WF_LANGUAGES that identifies the languages defined in your Oracle
installation. Oracle Workflow uses this view to create in its translatable
tables, a row for each language that maps to a row found in its
non-translated base table.

The WF_LANGUAGES view must include the following columns:
¢ Code—The language code.
¢ Display_Name—The display name of the language.

e NLS_Language—The value of the Oracle NLS_LANGUAGE
initialization parameter that specifies the default
language-dependent behavior of a session.

o NLS_Territory—The value of the Oracle NLS_TERRITORY
initialization parameter that specifies the default
territory-dependant date and numeric formatting of a session.

e NLS_Codeset—The character set for the language.

e Installed_Flag—Flag to indicate if the language is installed and
available for use.

A sample WF_LANGUAGES view is included in the script of each of
the predefined directory services that Oracle Workflow provides.

Context: You need to perform this step only once.

See: Oracle Database National Language Support Guide

To display user defined objects in Oracle Workflow Builder in other
languages (for standalone version only)

1. Install Oracle Workflow.
2. Create the WF_LANGUAGES view in your workflow server.

3. Run the script winlena.sql to enable the language of interest. See:
winlena.sql: page 16 —12.

4. Run the script WENLADD.sql to create rows for the enabled
language in each workflow object translation table. See:
WENLADD.sql: page 16 - 5.

5. Set the NLS_LANG environment variable for the new language.



For example, in UNIX, use the command:

setenv NLS_LANG = 'language.territory characterset’

For Windows NT, run the regedi t32 command and locate the
NLS_LANG setting under the
HKEY_LOCAL_MACHINE/SOFTWARE/ORACLE hierarchy. Double
click on NLLS_LANG, then set the variable to the new value and
save your edit.

Create a translated version of your workflow process definition
and save it as a flat file (.wft).

Load the translated .wft file to your workflow database, making
sure that the current NLS_LANG setting is correct.

Note: To determine the language to load, the Workflow
Definitions Loader uses the language specified in the .wft file,
while the Workflow Resource Generator accepts a language
parameter. If you do not specify a language parameter, the
Workflow Resource Generator defaults to the current setting of
NLS_LANG.

» To display an Oracle Workflow web session in other languages (for
standalone version only)

If you have multiple languages installed for Oracle Workflow, as a
workflow administrator, you can specify the default language that
your users’ web sessions display by setting the Language
parameter in the Global User Preferences web page. Individual
users can override the default language by setting the Language
parameter in the User Preferences web page. See: Setting Global
User Preferences: page 2 — 14 and Setting User Preferences: page
9-6.

» To display e-mail notifications in other languages

1.

Determine if Oracle has translated the e-mail notification templates
to the language you wish to set by checking for a file called

wifmail. wft in the appropriate language subdirectory
$ORACLE_HOME/wf/res/<lang>. See: Modifying Your Message
Templates: page 2 — 72.

If the e-mail templates are available for the language you wish to
display, you can set your users and roles” default language setting
to that language in the Global Preferences web page. See: Setting
Global User Preferences: page 2 — 14.
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Step 6  Setting the Socket Listener Profile Options

The Notification Details web page can display an attached form icon to
support form attributes in a notification message. Oracle Applications
users can launch the Oracle Workflow Notification Worklist from their
Oracle Applications menus.

From the Worklist, users can select a notification link to display the
contents of a notification in the Notification Details page. If the
notification details display an attached form icon, users can choose that
icon to launch an Oracle Applications form.

Before Oracle Workflow can launch the form from the Notification
Details page, it must check for appropriate context information with
Oracle Applications. To accomplish this, the socket listener on the form
side must be active.

You can activate the Oracle Applications socket listener by setting the
Socket Listener Activated profile option to Yes using the System Profile
Values Window.

In addition, the Workflow Administrator needs to specify the following
token values in $FND_TOP /resource/ <language>/wfcfg.msg for the
Java plugin:

WF_CLASSID <Class ID for Jinitiator>

(Required if you are using Microsoft Internet Explorer.)
WF_PLUGIN_DOWNLOAD <Plugin location>

(Such as http://<server>/0A_JAVA/.)
WF_PLUGIN_VERSION <Plugin version>

(Such as 1.1.7.27.)

Run the Workflow Resource Generator to load the contents of
wicfg.msg into the WF_RESOURCES table.

You can also set these three values in the Global Preferences page. See:
To Set Global User Preferences: page 2 — 14.

You must also set the Socket Listener Port profile option to the port at
which Oracle Workflow should launch attached forms. This profile
option can be set to different ports for different users.

If the socket listener port is not set at user level, Oracle Workflow
launches attached forms at the default port set for the site. However, if
users have set different ports, Oracle Workflow launches the forms for
each user at the specified port. By using different socket listener ports,
two different users logged into Oracle Applications on the same
machine can both launch attached forms at the same time without
interference from each other.
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Context: You need to perform this step only once.

See: Overview of Setting User Profiles: Oracle Applications System
Administrator’s Guide

See: To run the Workflow Resource Generator: page 8 — 105.

Setting Up Oracle Workflow = 2-41



2-42

Step 7

Oracle Workflow Guide

Setting the WF_RESOURCES Environment Variable

If you are using the standalone version of Oracle Workflow and your
Workflow server is installed on a UNIX platform, you must set an
environment variable called WF_RESOURCES to point to the
language—dependent Oracle Workflow resource file (wf<language>.res).
The resource file generally resides under the res subdirectory of your
Oracle Workflow server directory structure.

@ Attention: Do not enclose environment variable values in
double quotes (” ”) as this is not supported.

You do not need to set this environment variable if your Workflow
server is installed on the Windows NT platform. The Workflow server
installation on Windows NT automatically sets a WF_RESOURCES
environment variable that identifies the path of the wf<language>.res
file.

You also do not need to set this environment variable if you are using
the version of Oracle Workflow embedded in Oracle Applications. For
Oracle Applications, the path of the language—-dependent Oracle
Workflow resource file is $FND_TOP /$APPLRSC / wf<language>.res.

Context: You need to perform this step only once.



Step 8

Defining Document Management Repositories

Attention: Document management functionality will be

ISy supported in a future release. This description of the Oracle
Workflow web pages for defining document management
repositories is provided for reference only.

Oracle Workflow will provide seamless open integration with Oracle’s
third party document management (DM) integration partners. Oracle
Workflow communicates with these DM systems through a web server
agent interface. You should be able to identify your DM system’s web
server using the syntax <protocol>:/ / <server:port>/.

To register the DM system with Oracle Workflow, use the Oracle
Workflow Document Nodes web page to identify the DM system as a
document node. Oracle Workflow uses the document node as the
gateway to a specific document management system and uses the
information defined in the node to construct the URLs that display the
document management system documents.

Context: You need to perform this step only once.

To Define a Document Node

1. Use a web browser to connect to the Oracle Workflow home page
and choose the Document Nodes link, if you have workflow
administrator privileges:

<webagent>/wfa_html.home

Alternatively, if you have workflow administrator privileges, you
can connect directly to the Document Management Nodes web

page:
<webagent>/fnd_document_management .dm_nodes_display
<webagent> represents the base URL of the web agent configured

for Oracle Workflow in your Web server. See: Setting Global User
Preferences: page 2 — 14.

= Attention: These are secured pages, so if you have not yet
logged on as a valid user in the current web session, you will
be prompted to do so before the page appears.
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2. The Document Management Nodes web page displays a summary
of any previously defined document management nodes. The
summary displays the DM system node name, DM system version
number, node ID, node description, and web server for the DM
system. Also shown is the name of the DM system product, the
DM product vendor and the DM system version number.

3. You can click on a node name link to edit the details of a node or
choose Create Node to define a new node in the Document Nodes
web page.
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4. In the Document Nodes web page, enter or edit the name and
description of the node.

5. Enter or edit the web server agent for the document management
system. The syntax should be <protocol>:/ / <server:port>.

6. Choose the document management product name for this node.
This is the name that represents the node for all users who wish to
link documents to their workflow processes.

7. Choose OK to update or define the node.

Once you define a node, the browser returns you to a reloaded
Document Management Nodes web page. Oracle Workflow
assigns a node ID for the new node.

8. You can also delete a node by clicking on the Delete icon in the
Delete column.

Caution: Before you delete a node, you should ensure that no
Document-type attributes currently reference the node.
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Setting Up Background Workflow Engines

When the Workflow Engine initiates and performs a process, it
completes all necessary activities before continuing to the next eligible
activity. In some cases, an activity can require a large amount of
processing resource or time to complete. Oracle Workflow lets you
manage the load on the Workflow Engine by setting up supplemental
engines to run these costly activities as background tasks. In these
cases, the costly activity is deferred by the Workflow Engine and run
later by a background engine. The main Workflow Engine can then
continue to the next available activity, which may occur on some other
parallel branch of the process.

A background engine must also be set up to handle timed out
notification activities. When the Workflow Engine comes across a
notification activity that requires a response, it calls the Notification
System to send the notification to the appropriate performer, and then
sets the notification activity to a status of 'NOTIFIED’ until the
performer completes the notification activity. Meanwhile, a
background engine set up to handle timed out activities periodically
checks for 'NOTIFIED’ activities and whether these activities have time
out values specified. If a ’NOTIFIED activity does have a time out
value, and the current date and time exceeds that time out value, the
background engine marks that activity as timed out and calls the
Workflow Engine. The Workflow Engine then resumes by trying to
execute a <Timeout> transition activity.

Additionally, a background engine must be set up to handle stuck
processes. A process is identified as stuck when it has a status of
ACTIVE, but cannot progress any further. For example, a process could
become stuck in the following situations:

o A thread within a process leads to an activity that is not defined
as an End activity but has no other activity modeled after it, and
no other activity is active.

¢ A process with only one thread loops back, but the pivot activity
of the loop has the On Revisit property set to Ignore.

e An activity returns a result for which no eligible transition exists.
For instance, if the function for a function activity returns an
unexpected result value, and no default transition is modeled
after that activity, the process cannot continue.

The background engine sets the status of a stuck process to
ERROR#STUCK and executes the error process defined for it.

You can define and start up as many background engines as you like to
check for deferred and timed out activities.



Background engines can be restricted to handle activities associated
with specific item types, and within specific cost ranges. A background
engine runs until it completes all eligible activities at the time it was
initiated.

Generally, you should set the background engine up to run periodically
by either using a script to restart the background engine periodically
(for the standalone version of Oracle Workflow), or scheduling the
Background Process concurrent program to resubmit periodically (for
the version of Oracle Workflow embedded in Oracle Applications).

Ensure that you have at least one background engine that can check for
timed out activities, one that can process deferred activities, and one
that can handle stuck processes. At a minimum, you need to set up one
background engine that can handle both timed out and deferred
activities as well as stuck processes.

Generally, you should run a separate background engine to check for
stuck processes at less frequent intervals than the background engine
that you run for deferred activities, normally not more often than once
a day. Run the background engine to check for stuck processes when
the load on the system is low.

Context: You need to perform this step only once.
See: Activity Cost: page 4 —47
See: Timeout Transitions: page 5 -3

See: Deferring Activities: page C -7

To Start a Background Engine

If you are using the standalone version of Oracle Workflow, then use
the WF_ENGINE.BACKGROUND () API to start up a background engine.
Sample scripts that repeatedly run the background engine are provided
with the standalone version of Oracle Workflow. You can use the
procedures in the DBMS_JOB package to schedule and manage the
background engine as a database job. See: Background: page 8 — 41 and
Managing Job Queues, Oracle Administrator’s Guide.

If you are using the version of Oracle Workflow embedded in Oracle
Applications, you can start a background engine by submitting the
Background Process concurrent program using the Submit Requests
form. See: To Schedule Background Engines: page 2 — 48

Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications and you have implemented
Oracle Applications Manager, you can use Oracle Workflow
Manager to submit and manage the Workflow Background
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Process concurrent program. For more information, please refer
to the Oracle Applications Manager online help.

Note: Make sure you have a least one background engine that
can check for timed out activities, one that can process deferred
activities, and one that can handle stuck processes. Ata
minimum, you need to set up one background engine that can
handle both timed out and deferred activities as well as stuck
processes.

To Schedule Background Engines

If you are using the version of Oracle Workflow embedded in Oracle
Applications, you can submit the background engine procedure as a
concurrent program to schedule different background engines to run at
different times. Use the Submit Requests window in Oracle
Applications to submit the Workflow Background Process.

Note: If you require a larger rollback segment for the
Workflow Background Process than the default, you can use
the Concurrent Programs window in the System Administrator
responsibility to specify the rollback segment that you want.
This rollback segment will be used instead of the default and
will be used up until the first commit.

Query the Workflow Background Process concurrent program
(FNDWEBG) in the Concurrent Programs window, and choose
the Session Control button. Then in the Session Control
window, enter the rollback segment you want in the Rollback
Segment field, and save your work. See: Concurrent Programs
Window, Oracle Applications System Administrator’s Guide.

To Run a Workflow Background Process as a Concurrent Program

1. Navigate to the Submit Requests form.

2. Submit the Workflow Background Process concurrent program as a
request. See: Submitting a Request, Oracle Applications User’s Guide.

3. In the Parameters window, enter values for the following
parameters:

Item Type Specify an item type to restrict this engine to

activities associated with that item type. If you do
not specify an item type, the engine processes any
deferred activity regardless of its item type.



Minimum Specify the minimum cost that an activity must
Threshold have for this background engine to execute it, in
hundredths of a second.

Maximum Specify the maximum cost that an activity can have
Threshold for this background engine to execute it, in
hundredths of a second.

By using Minimum Threshold and Maximum
Threshold you can create multiple background
engines to handle very specific types of activities.
The default values for these arguments are 0 and
100 so that the background engine runs activities
regardless of cost.

Process Deferred  Specify whether this background engine checks for
deferred activities. Setting this parameter to
"Yes'’ allows the engine to check for deferred
activities.

Process Timeout  Specify whether this background engine checks for
activities that have timed out. Setting this
parameter to ' Yes’ allows the engine to check for
timed out activities.

Process Stuck Specify whether this background engine checks for
stuck processes. Setting this parameter to ' Yes’
allows the engine to check for stuck processes.

Note: Make sure you have a least one background engine that
can check for timed out activities, one that can process deferred
activities, and one that can handle stuck processes. Ata
minimum, you need to set up one background engine that can
handle both timed out and deferred activities as well as stuck
processes.

4. Choose OK to close the Parameters window.

5. When you finish modifying the run options to define the schedule
for the background engine, choose Submit to submit the request.

See Also

See: Overview of Concurrent Programs and Requests, Oracle
Applications System Administrator’s Guide
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To Set Engine Thresholds

To set the thresholds of background engines, specify the minthreshold
and maxthreshold arguments when starting the engine. The
background engine then only processes activities with costs within
your specifications.

The Workflow Engine threshold is set to 50 as a default. Activities with
a cost higher than 50 are deferred for background engines to process.

In some cases, you may want to force the engine to defer an activity
although the activity’s cost is less than fifty. You can do this by altering
the Workflow Engine threshold in the PL/SQL stored procedure for a
function activity.

The engine threshold is set in an externalized constant called
THRESHOLD. Include the following line in your PL/SQL procedure to
set the WF Engine threshold to a different value:

WF_ENGINE.THRESHOLD := n;

You should reset the threshold value afterwards in SQLPLUS or in the
next function activity so that other activities are processed as expected.



Step 10

Implementing the Notification Mailer

The Notification Mailer is a program that performs e-mail send and
response processing for the Oracle Workflow Notification System. You
need to perform this step only if you wish to have your workflow users
receive their notifications via e-mail, as well as from the Notifications
Worklist web page. The Notification Mailer polls the database for
messages that have to be sent, dequeues these messages from the SMTP
advanced queue, and performs the following action for each message:

e Resolves the recipient role to a single e-mail address, which itself
can be a mail list.

e Switches its database session to the role’s preferred language and
territory as defined by the directory service.

¢ Generates the message and any optional attachments using the
appropriate message template.

¢ Sends the message via UNIX Sendmail or any MAPI-compliant
mail application on Windows NT.

Note: A standard agent named WF_SMTP_O_1_QUEUE is
defined for the Notification Mailer SMTP queue in the Event
Manager. This agent appears in the Check Setup page and the
Event System Local Queues page of the Event Manager,
enabling you to use these pages to check the number of
notification messages on the Notification Mailer queue. The
WF_SMTP_O_1_QUEUE agent is not used by the Business
Event System, however. See: Standard Agents: page 13 — 25,
Checking the Business Event System Setup: page 13 — 52, and
Reviewing Local Queues: page 13 - 71.

The Notification Mailer also processes responses by interpreting the
text of messages mailed to its response mail account and calling the
appropriate notification response function to complete the notification.

The e-mail notifications are based on standard templates defined in
Oracle Workflow Builder. The templates describe the syntax the reply
should follow and list the information needed to confirm the
notification. The generated e-mail message also includes any custom
site information, the due date, and any information necessary to
process the response. See: Modifying Your Message Templates: page
2-72.

Once you set up the Notification Mailer to run, it continually polls the
database for messages to send and checks its response mail account for
responses to process. You do not have to do anything else unless you
have a need to shut it down and restart it again with different
parameters.
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= Attention: The Notification Mailer will shut itself down if a
database failure is encountered or if the PL/SQL package state
for the session is invalid due to dropping or replacing of
package definitions. If you are using the standalone version of
Oracle Workflow, you can restart the Notification Mailer
manually or run a shell script that restarts the Notification
Mailer if it ever exits with a failure. See: To Run a Perpetual
Shell Script for the Notification Mailer: page 2 —70. If you are
using the version of Oracle Workflow embedded in Oracle
Applications, you can use the concurrent manager to restart the
Notification Mailer program manually or schedule it to restart
periodically.

Context: You need to perform this step only once.

See: Reviewing Notifications via Electronic Mail: page 10 — 2

Full MIME Support

Oracle Workflow fully supports MIME (Multi-purpose Internet Mail
Extensions) encoded messages. This means that the Notification Mailer
can exchange messages with workflow users containing languages with
different character sets and multi-media encoded content.

Notification Preferences

Oracle Workflow allows you to determine how you view notifications
by setting a notification preference in the User Preferences web page.
See: Setting User Preferences: page 9 — 6.

Often times, the functionality of a user’s mail reader determines what
the user’s notification preference should be. Some mail readers can
only display plain text, others can display HTML formatting, while still
others can only display HTML formatting in an attachment. Five
notification preferences are available:

¢ Plain text mail (MAILTEXT)—The notification message appears
as plain text, with no attachments. See: Plain Text E-mail: page
2-53.

¢ HTML mail (MAILHTML)—The notification message appears as
HTML-formatted text, with at least one other attachment that is
a link to the notification in the Notifications web page. If the
notification message has ‘Content-Attached” message attributes,

these attributes appear as additional attachments to the message.
See: HTML-Formatted E-mail: page 2 — 54.



= Attention: If you wish to view notifications with HTML
formatting, but your mail reader is not able to interpret HTML
formatting in the mail message body, change your notification
preference to 'Plain text mail with HTML attachments’
(MAILATTH). The MAILATTH preference delivers an
HTML—-formatted version of the notification as an attachment
to the plain text notification.

e Plain text mail with HTML attachments (MAILATTH)—The
notification message appears as plain text, with at least two other
attachments. One attachment is an HTML—formatted version of
the message, and the other is a link to the notification in the
Notifications web page. If the notification message has
‘Content-Attached’ message attributes, these attributes appear
as additional attachments to the message. See: Plain Text E-mail
with an HTML Attachment: page 2 — 56.

e Plain text summary mail (SUMMARY)—The message is a plain
text summary of all open notifications. To respond to the
individual notifications in the summary, you must access the
notifications from the Notifications web page.

¢ Do not send me mail (QUERY)—The Notification Mailer does
not send you e-mail notifications. Instead you must query and
respond to your notifications from the Notifications web page.

= Attention: You can always query and respond to your
notifications from the Notifications web page, even if you set
your notification preference to send you mail.

See: Reviewing Notifications via Electronic Mail: page 10 — 2
See: Viewing Notifications from a Web Browser: page 10 - 13

See: Reviewing a Summary of Your Notifications via Electronic Mail:
page 10-25

Plain Text E-mail

If the performer of a notification has a notification preference of plain
text mail (MAILTEXT), the notification is flagged as such in the
Workflow Notification table. When the Notification Mailer polls the
Notification table and identifies that flag, it generates a plain text
e-mail notification from the information in the table and sends it to the
performer role. The Notification Mailer uses the Text Body defined for
the message in the Oracle Workflow Builder message property page to
generate the plain text e-mail. It token replaces all attribute values
referenced in the message body with plain text values. For example:
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e PL/SQL and PL/SQL CLOB document attributes are token
replaced with a plain text version of a PL/SQL document.

¢ Document Management-type document attributes are token
replaced with the plain text display name of the document
attribute. (This functionality will be supported in a future
release.)

e URL attributes are token replaced with the display name of the
URL attribute, followed by a colon and the URL:

<URL_Attribute_Display. Name>:<URL>

= Attention: Message attributes that have Attach Content
checked in their Attributes property page, are attached as plain
text to their parent notification. Note that this may render
some attachments unreadable if the attachment includes special
formatting or your plain text e-mail reader does not recognize
attachments. To view these attachments, you should display
your notifications in the Notifications Worklist web page. See:
Viewing Notifications from a Web Browser: page 10 - 13.

A recipient of a plain text e-mail notification responds by manually
replying to the notification and entering response values following the
instructions provided in the notification. See: To Respond to a Plain
Text E-mail Notification Using Templated Response: page 10 — 4 and To
Respond to a Plain Text E-mail Notification Using Direct Response:
page 10 - 6.

HTML-Formatted E-mail

If the performer of a notification has a notification preference of HTML
mail (MAILHTML), the notification is flagged as such in the Workflow
Notification table. When the Notification Mailer polls the Notification
table and identifies that flag, it generates an HTML-formatted e-mail
notification from the information in the table and sends it to the
performer role. The performer role should use an e-mail reader that
can interpret and display HTML content within a message body.

Note: If your e-mail reader cannot interpret HTML formatting
in a message body, you should set your notification preference
to plain text mail with HTML Attachments (MAILATTH).

The Notification Mailer uses the HTML Body defined for the message
in the Message Body property page to generate the HTML e-mail. If
no HTML Body is defined, it uses the Text Body to generate the HTML
mail. The Notification Mailer token replaces all message attributes
referenced in the message body with HTML-formatted values. For
example:



e PL/SQL and PL/SQL CLOB document attributes are token
replaced with HTML text or plain text between <pre>...</pre>
HTML tags.

¢ Document Management document attributes are token replaced
with an HTML anchor. When you select such an anchor, your
e-mail reader takes you to the target document management
integration screen to display the referenced document. (This
functionality will be supported in a future release.)

e URL attributes are token replaced with HTML anchors. When
you select such an anchor, your e-mail reader takes you to the
target URL page.

Note: Message attributes that have Attach Content checked in
their Attributes property page, are appended as
HTML~formatted attachments to their parent message. For
example:

— If the message attribute is a URL attribute, an attachment
called Notification References is appended to the message.
This attachment includes a link to each URL attribute for
the message that has Attach Content checked. You can
navigate to a URL by choosing its link. The Notification
Mailer does not have any special handling of image, video,
or audio URL content.

— If the message attribute is a PL/SQL or PL/SQL CLOB
document attribute, the fully generated PL/SQL document
is fetched and attached to the message.

— If the message attribute is a Document Management
document attribute, a URL anchor to the document
management integration screen is attached. (This
functionality will be supported in a future release.)

An HTML—formatted notification always includes at least one
attachment. The attachment is called Notification Detail Link. When
you select this attachment, your e-mail reader opens a browser
window that displays your notification in the Notification Details web
page. You can respond directly to your notification from this web page,
bypassing the need to process your response through the Notification
Mailer.

Note: If the SEND_ACCESS_KEY parameter in the
Notification Mailer configuration file is set to N, and you are
not already logged in, you will be prompted to log in when you
select the Notification Detail Link before you can access the
Notification Details web page.
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Note: The file name of the Notification Detail Link attachment
is determined by the text value for the
WF_URL_NOTIFICATION resource token, or by the token
name if no text value is defined. Similarly, the file name of the
Notification References attachment is determined by the text
value for the WF_URLLIST ATTACHMENT resource token, or
by the token name if no text value is defined. The default file
names are “Notification Detail Link.html” and

“Notification References.html”, respectively. If you want to
specify different file names for these attachments, you must
first create a .msg source file specifying the new file names as
the text values for the WF_URL_NOTIFICATION and
WEF_URLLIST _ATTACHMENT resource tokens. Then use the
Workflow Resource Generator program to generate a new
Oracle Workflow resource file (wf<language>.res) from the
source file and to upload the new seed data from the source file
to the database table WF_RESOURCES. See: To Run the
Workflow Resource Generator: page 8 — 105 and Setting the
WF_RESOURCES Environment Variable: page 2 — 42.

Alternatively, you can respond to your HTML—formatted notification
by clicking on a link that represents the response in the HTML message
body. The response link generates a plain text e-mail response that
includes a response template modified with the predefined response
value that you select. See: To Respond to an HTML E-mail
Notification: page 10 - 9.

Plain Text E-mail with an HTML Attachment

If the performer of a notification has a notification preference of plain
text mail with HTML attachments (MAILATTH), the notification is
flagged as such in the Workflow Notification table. When the
Notification Mailer polls the Notification table and identifies that flag,
it generates a plain text e-mail notification with HTML attachments
from the information in the table and sends it to the performer role.
The performer role should use an e-mail reader that supports HTML
attachments.

The Notification Mailer uses the Text Body defined for the message in
the Message Body property page to generate the plain text body of the
e-mail. It also generates an HTML version of the notification message
and sends it as an attachment called HTML Message Body to the plain
text e-mail. The Notification Mailer generates the content of the HTML
attachment from the HTML Body defined for the message. If no
HTML Body is defined, it uses the Text Body to generate the HTML
mail. The Notification Mailer token replaces all message attributes



referenced in the plain text message body with plain text values and
token replaces all message attributes referenced in the attached HTML
message with HTML—formatted values. See: Sending Plain Text
E-mail: page 2 — 53 and Sending HTML-Formatted E-mail: page 2 — 54.

If your e-mail reader supports HTML—formatting in the message body,
then the HTML attachment will also appear in line in the message
body.

Note: Message attributes that have Attach Content checked in
their Attributes property page, are appended as
HTML-formatted attachments. For example:

— If the message attribute is a URL attribute, an attachment
called Notification References is appended to the message.
This attachment includes a link to each URL attribute for
the message that has Attach Content checked. You can
navigate to a URL by choosing its link.

— If the message attribute is a PL/SQL or PL/SQL CLOB
document attribute, the fully generated PL/SQL document
is fetched and attached to the message.

— If the message attribute is a Document Management
document attribute, a URL anchor to the document
management integration screen is attached. (This
functionality will be supported in a future release.)

The notifications received by a user whose notification preference is
"Plain text with HTML attachments’ always contain at least two
attachments. The first attachment is HTML Message Body and the
other is Notification Detail Link. When you select Notification Detail
Link, your e-mail reader opens a browser window that displays your
notification in the Notification Details web page. You can respond
directly to your notification from this web page, bypassing the need to
process your response through the Notification Mailer. See: To
Respond to a Plain Text E-mail Notification with an HTML
Attachment: page 10 — 11.

Note: If the SEND_ACCESS_KEY parameter in the
Notification Mailer configuration file is set to N, and you are
not already logged in, you will be prompted to log in when you
select the Notification Detail Link before you can access the
Notification Details web page.

Alternatively, a recipient of this type of notification can respond in one
of two other ways:

e Manually reply to the notification and enter response values
following the instructions provided in the notification. See: To
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Respond to a Plain Text E-mail Notification Using Templated
Response: page 10 — 4 and To Respond to a Plain Text E-mail
Notification Using Direct Response: page 10 — 6.

o Select the HTML Message Body attachment to display the
HTML-formatted version of the e-mail message, and click on
the HTML link that represents the response. The response link
generates a plain text e-mail response that includes a response
template updated with the predefined response value you select.

Note: The file name of the HTML Message Body attachment is
determined by the text value for the WF_HTML_MESSAGE
resource token, or by the token name if no text value is defined.
Similarly, the file name of the Notification Detail Link
attachment is determined by the text value for the
WF_URL_NOTIFICATION resource token, or by the token
name if no text value is defined; and the file name of the
Notification References attachment is determined by the text
value for the WF_URLLIST _ATTACHMENT resource token, or
by the token name if no text value is defined. The default file
names are "HTML Message Body.html”,

”Notification Detail Link.html”, and

”Notification References.html”, respectively. If you want to
specify different file names for these attachments, you must
first create a .msg source file specifying the new file names as
the text values for the WF_HTML_MESSAGE,
WEF_URL_NOTIFICATION, and

WEF_URLLIST _ATTACHMENT resource tokens. Then use the
Workflow Resource Generator program to generate a new
Oracle Workflow resource file (wf<language>.res) from the
source file and to upload the new seed data from the source file
to the database table WF_RESOURCES. See: To Run the
Workflow Resource Generator: page 8 — 105 and Setting the
WF_RESOURCES Environment Variable: page 2 — 42.

Starting the Notification Mailer

You can install and set up the Notification Mailer to run against UNIX
Sendmail or a MAPI-compliant mail application on Windows NT.
However, before doing so, you must set up a least one mail account
dedicated to the Notification Mailer in one of these mail applications.
You must also define three folders or files in your mail account to use
response processing.

Users can receive e-mail notifications using any e-mail reader that is
MAPI-compliant running on Windows NT or that UNIX Sendmail can
provide a gateway to.



» To Start the Notification Mailer for UNIX Sendmail

For the Standalone Version of Oracle Workflow:

1.

The Notification Mailer resides on your server in the
$ORACLE_HOME/bin subdirectory. To run the Notification
Mailer, use the following command syntax:

wfmail.<xxx> —-f <config file>

Replace <xxx> with snd to use the UNIX Sendmail version of the
Notification Mailer. Replace <config_ file> with the full path and
name of the configuration file that contains the parameters you
want to run with the Notification Mailer.

Alternatively, you can specify the parameters for the Notification
Mailer as arguments on the command line rather than in a
configuration file, by typing the following command:

wfmail.<xxx> <argl> <arg2> ...

Or, you can specify a configuration file, but override certain
parameter values in the configuration file by specifying command
line values:

wfmail.<xxx> -f <config file> <argl> <arg2> ...

Replace <argl> <arg2> ... with any number of optional
parameters and values, using the format parameter=value.

For the Version of Oracle Workflow Embedded in Oracle
Applications:

1.

The Notification Mailer program is registered as a concurrent
program. You can run the Notification Mailer concurrent program
from the Submit Requests form or from the command line.

Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications and you have implemented
Oracle Applications Manager, you can use Oracle Workflow
Manager to configure and run the Notification Mailer. For more
information, please refer to the Oracle Applications Manager
online help.

2. To run the concurrent program from the Submit Requests form,

navigate to the Submit Requests form.

Note: Your system administrator needs to add this concurrent
program to a request security group for the responsibility that
you want to run this program from. See: Overview of
Concurrent Programs and Requests, Oracle Applications System
Administrator’s Guide.
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Submit the Notification Mailer concurrent program as a request.
See: Submitting a Request, Oracle Applications User’s Guide.

In the Parameters window, enter the path and filename of a
configuration file. The configuration file contains the parameters
you want to run with the Notification Mailer.

Choose OK to close the Parameters window.

When you finish modifying the print and run options for this
request, choose Submit to submit the request.

Rather than use the Submit Requests form, you can also run the
Notification Mailer concurrent program from the command line.
Enter:

WFMAIL apps/pwd 0 Y FILE config file

Replace apps/pwd with username and password to the APPS
schema, replace config_file with the file specification of the
configuration file that contains the parameters you want to run
with the Notification Mailer.

A file specification for config_file can be:

@<application_short_name>:[<dir>/.../]lfile.ext

or

<native path>

To Start the Notification Mailer for MAPI-Compliant Mail
Applications

1.

Install the Notification Mailer for MAPI-compliant mail
applications on your Windows NT PC using Oracle Universal
Installer. The Notification Mailer program resides in
<drive>:\<ORACLE_HOME>\bin.

Start the Notification Mailer program by entering the following
command in an MS-DOS prompt window:

<drive>:\<ORACLE_HOME>\bin\wfmlr.exe -f <config file>

Replace <config_f£ile> with the full path and name of the
configuration file that contains the parameters you want to run
with the Notification Mailer.

Note: You can also double—click on the Oracle Workflow
Notification Mailer icon in the Oracle — <SID NAME> program
group to start the program, but you must first edit the
properties of the icon to include the above command as its
target.



Alternatively, if you want to specify the parameters for the
Notification Mailer as arguments on the command line rather than
in a configuration file, you can type the following command:

wfmlr.exe <argl> <arg2> ...

Or, you can specify a configuration file, but override certain
parameter values in the configuration file by specifying command
line values:

wfmlr.exe -f <config file> <argl> <arg2> ...

Replace <argi> <arg2> ... with the required and optional
parameters and values, using the format parameter=value.

» To Create a Configuration File for the Notification Mailer

1.

Oracle Workflow provides an example configuration file, called
wfmail.cfg. If you are using the standalone version of Oracle
Workflow, the file resides in your Oracle Workflow server directory
structure, under the subdirectory res. For the version of Oracle
Workflow embedded in Oracle Applications, the file resides in the
resource subdirectory under $FND_TOP on your server. The file
also resides on your PC in the <drive>: \<ORACLE_HOME>\wf\data
subdirectory.

Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications and you have implemented
Oracle Applications Manager, you can use Oracle Workflow
Manager to configure and run the Notification Mailer. For more
information, please refer to the Oracle Applications Manager
online help.

The content of the configuration file is formatted as follows:
#Description

PARAMETERI1=<valuel>

#Description

PARAMETER2=<value2>

Any text preceded by # is not interpreted and can be used for
including comments. List each parameter name on the left side of
the equal sign (=) and specify a value for each parameter on the
right.

The parameters are as follows:
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CONNECT—(Required) The information to connect to the
database account where the Oracle Workflow server is installed,
using the format, username/password@connect_string (or
alias).

Attention: The CONNECT parameter is not required if you
submit the Notification Mailer as a concurrent program from
the version of Oracle Workflow embedded in Oracle
Applications. In this case, the concurrent manager passes in the
database connection information for the Notification Mailer to
use.

ACCOUNT—(Required) The information to connect to the mail
account that the program uses to send notification messages. For
MAPI-compliant mail programs, the account information is the
mail account profile name and mail account password. For
Sendmail, the account information would be the full file path of
the mail spool file where incoming messages are stored, such as
/var/mail/applmgr3. Note that this should correspond to the
account from which you start the Notification Mailer, in this
example, applmgr3.

Attention: If you want to start the Sendmail version of the
Notification Mailer, you must also specify the full path of the
Sendmail executable directory in your PATH environment
variable.

Attention: If you are using the version of Oracle Workflow
embedded in Oracle Applications, and want to start the
Sendmail version of the Notification Mailer concurrent
program, then the Account parameter must be set to the
account from which you start the Concurrent Manager.

NODE—(Required) The node identifier name. The node name is
included with the outgoing notification ID. The default name is
wt.

If you have multiple workflow databases on one server, you
must define a unique node name for each Notification Mailer
configuration file to ensure that the Notification Mailer for each
instance uses a different TMP file for processing. For example, if
you already have a Notification Mailer on the server with the
node name wf, you could assign the node name wf2 to the
Notification Mailer for the next instance you set up.

Note: You can only run one Notification Mailer per instance,
and each Notification Mailer must use a separate e-mail
account to process responses.



Iy

FROM—The value that appears in the From: field of the message
header when a notification message is delivered to a user. The
default is Oracle Workflow.

Attention: The FROM parameter is only used to set the From:
field value by the UNIX Sendmail version of the Notification
Mailer. The MAPI-compliant version of the Notification Mailer
uses the display value that is set up for the mail account
specified in the ACCOUNT parameter.

SUMMARYONLY—(Required) Indicate whether this
Notification Mailer processes only notifications assigned to
users/roles with a notification preference of 'SUMMARY” or
whether it only processes notifications for users/roles with a
notification preference of 'MAILTEXT’, ' MAILATTH’, or
'MAILHTML'". Valid values are Y or N. The defaultis N. You
should set up at least two Notification Mailers, one where
SUMMARYONLY=Y and one where SUMMARYONLY=N if any
of your workflow users or roles have a notification preference of
'MAILTEXT’, ' MAILATTH’, MAILHTML', or 'SUMMARY".
See: Setting Up Users and Roles from a Directory Repository:
2-21.

If you set SUMMARYONLY=Y, then the Notification Mailer will
shut itself down after it polls the database and delivers any
appropriate notification summaries. You must therefore
schedule the Notification Mailer to run at the frequency you
want notification summaries to be delivered. We recommend
you run the summary Notification Mailer once a day, since the
summary includes all open notifications. For Oracle Workflow
running in the standalone environment, this would involve
creating an operating system script, such as a cron job in UNIX,
to schedule the Notification Mailer. For the version of Oracle
Workflow embedded in Oracle Applications, this simply
involves scheduling the Notification Mailer concurrent program
in the Submit Request form.

DIRECT_RESPONSE—Specify N or n to send plain text
notifications requiring a templated response to users with a
notification preference of 'MAILTEXT’ or ' MAILATTH'. Specify
Y or y to send plain text notifications requiring a direct response
to users with these preferences. The default is N.

For the templated response method, users must reply using a
template of response prompts and enter their response values
between the quotes following each prompt. For the direct
response method, users must enter their response values directly
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as the first lines of a reply. See: Reviewing Notifications via
Electronic Mail: page 10 - 2.

l]@ Attention: If you include the HTML_MAIL_TEMPLATE
parameter in your configuration file, the Notification Mailer
will ignore the DIRECT_RESPONSE parameter when sending
messages to users with a notification preference of
'MAILATTH’. Instead, all users with this notification
preference will receive the plain text message body defined for
the Workflow Open Mail for Outlook Express template, which
uses the templated response method. Consequently, if you do
not need to use the Workflow Open Mail for Outlook Express
template, you should comment out the
HTML_MAIL_TEMPLATE parameter to let the
DIRECT_RESPONSE parameter take effect.

¢ AUTOCLOSE_FYI—Indicate whether this Notification Mailer
automatically closes notifications that do not require a response,
such as FYI (For Your Information) notifications, after sending
the notifications by electronic mail. Valid values include Y or N.
The default is Y.

If the value is N, all FYI notifications will remain open in the
Notifications Worklist until users manually close these
notifications.

e ALLOW_FORWARDED_RESPONSE—Indicate whether to
allow a user to respond to an e-mail notification that has been
forwarded from another role. Valid values include Y or N. The
defaultis Y.

If the value is N, the Notification Mailer will check if the “From:”
e-mail address of the notification response exactly matches the
e-mail address of the recorded recipient role (or the e-mail
address of a user in that role). If the two e-mail addresses match
exactly, meaning the notification was not forwarded or was
forwarded according to a valid routing rule, the Notification
Mailer treats the response as a valid response. If the two e-mail
addresses do not match exactly, meaning the notification was
simply forwarded using the e-mail Forward command, the
Notification Mailer does not process the response and treats it as
unsolicited mail.

7

If the value is Y, the Notification Mailer never checks the ”From:’
e-mail address of the notification response and always allows
the response to be processed.

c Warning: Note that there are limitations when you set
ALLOW_FORWARDED_RESPONSE to N. For example,
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suppose a notification is sent to a distribution list mail alias
that does not have a USER/ROLE relationship in the Oracle
Workflow directory service. If any user from the distribution
list responds to the notification, the Notification Mailer will
always treat their notification response as unsolicited mail,
because the "From:” e-mail address, which is an individual
user’s e-mail address, will never match the distribution list
mail alias.

e IDLE—The number of seconds to wait before checking for
messages to send. The value must be an integer greater than or
equal to zero. The defaultis 30.

¢ LOG—The name of a log file to record activity. A valid value
would be a filename. This parameter is valid only for the
standalone version of the Notification Mailer. For the concurrent
program version of the Notification Mailer, the activity output
goes to the concurrent manager log file.

e SHUTDOWN-—The name of a file that cues the Notification
Mailer to shut down. This lets you safely shut down the
Notification Mailer without killing the process. The Notification
Mailer always looks for the shutdown file in its current working
directory before looking for notifications to process. If the file
exists, then the Notification Mailer shuts down. You must
remove the shutdown file to restart the Notification Mailer
again. The default filename is shutdown.

For the standalone version of Oracle Workflow, the Notification
Mailer’s current working directory is the directory from which
you start the Notification Mailer. For the version of Oracle
Workflow embedded in Oracle Applications, the current
working directory is the SAPPLCSF/$APPLLOG directory. If
you have not set the JAPPLCSF environment variable, then place
the shutdown file in the $FND_TOP/$APPLLOG directory.

e FAILCOMMAND—The command to run if the Notification
Mailer encounters a fatal error.

¢ DEBUG—Indicate whether to print debugging information in
the log. Valid values include Y or N. The default is N.

e TEST_ADDRESS—Indicate a test e-mail address to direct all
outgoing e-mail notifications. The test address overrides each
recipient’s e-mail address so that you can test a workflow
process without having to change each recipient’s e-mail address
to access the test notifications.
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REPLYTO—(Required) A default e-mail address to reply to, if
the e-mail account that processes responses is different from the
e-mail account that sends outgoing notifications.

Attention: The REPLYTO parameter is only used to set the
reply-to address by the UNIX Sendmail version of the
Notification Mailer. The MAPI-compliant version of the
Notification Mailer uses the display value that is set up for the
mail account specified in the ACCOUNT parameter.

HTMLAGENT—The base URL that identifies the HTML Web
Agent that handles HTML notification responses. This URL is
required to support e-mail notifications with HTML
attachments. The default URL is derived from the Workflow
Web Agent specified in the Global Preferences web page, but you
can override this default by entering a different value for this
parameter. See: Setting Global User Preferences: page 2 — 14.

DISCARD—The name of the mail folder or full path name of the
mail file to put discarded messages. A -’ preceding the name
causes the Notification Mailer to truncate the folder or file on
startup. The defaultis -discard.

Note: For the UNIX Sendmail version of the Notification
Mailer, the DISCARD value must always be the full path name
of a mail file.

PROCESS—The name of the mail folder or full path name of the
mail file to put processed notification messages. A '~ preceding

the name causes the Notification Mailer to truncate the folder or

file on startup. The default is processed.

Note: For the UNIX Sendmail version of the Notification
Mailer, the PROCESS value must always be the full path name
of a mail file.

UNPROCESS—The name of the mail folder or the full path
name of the mail file to put unprocessed notification messages.
A’ preceding the name causes the Notification Mailer to
truncate the folder or file on startup. The default is
unprocessed.

Note: For the UNIX Sendmail version of the Notification
Mailer, the UNPROCESS value must always be the full path
name of a mail file.

TAGFILE—The full path and name of a tag file. The tag file lists
strings of text found in unusual messages and the status you
want to assign to a message response if it contains any of those
strings. Unusual messages include bounced or returned



messages, auto—reply messages such as those sent by vacation
daemons, mass mailing lists, and so on. Since different mail
systems vary in how they identify bounced, undeliverable, or
otherwise invalid messages, you can use a tag file to specify how
your mail system identifies those stray messages and how you
want the Notification Mailer to handle those messages should it
come across them.

Attention: Only a message response that contains a
notification ID is checked by the tag file. If the Notification
Mailer receives a message response that does not contain a
notification ID, it moves the message response to the discard
folder and sends a "Warning’ message to the sender that it
received unsolicited mail. See: Workflow Warning Mail
Message: page 2 — 85.

The format used in the tag file is

Status ”Matching string”

where Status can be the value: ERROR, IGNORE, or
UNAVAIL and "Matching string” is the text to look for in the
From: line, Subject: line, or body of the message. The
Notification Mailer handles a message assigned one of these
status values as follows:

— IGNORE—moves the message to the discard folder and
continues waiting for a valid reply to the open notification.
The notification’s status is still OPEN and its mail status is
still SENT.

— ERROR—moves the message to the discard folder and
initiates an error process, if one is defined. The
notification’s status is still OPEN, but its mail status and
activity status are updated to ERROR. Ideally, the
workflow administrator corrects the problem and resends
the notification by updating its mail status to MAIL.

— UNAVAIL (or any other user defined tag)-—-moves
the message to the discard folder and continues waiting for
a reply to the notification since the notification’s status is
still OPEN, but its mail status is updated to UNAVAIL.
This status is purely informative, as no further processing
occurs with this notification.

The Notification Mailer can also assign an INVALID status to a
message response, if the returned response value is not a valid
value in the assigned lookup (result) type. In this case, it moves
the message to the discard folder, and sends an ‘Invalid” message
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but does not alter the notification’s status or mail status, so that
it continues to wait for a valid reply. See: Workflow Invalid Mail
Message: page 2 — 82.

Attention: It is important that you uniquely identify bounced
messages and auto-replies from normal responses in the tag
file. If you do not identify bounced and auto-reply messages,
the Notification Mailer can mistake these as invalid responses,
send an 'Invalid’ message and continue to wait for a reply. In
both cases a perpetual loop would occur where the Notification
Mailer keeps sending out an 'Invalid” message and the Invalid’
message bounces back or is auto-replied.

As an example, if you want to mark all message responses that
contain the string “— Unsent message follows —” in the subject
or body of the message as an error, you can include the following
line in your tag file:

ERROR ”"-- Unsent message follows —-"

Attention: If a message response matches more than one
string in the tag file, it gets tagged with the status of the first
string it matches in the file. That is, the Notification Mailer
performs a top to bottom comparison against the tag file. Due
to this behavior, you should prioritize your strings listing the
ERROR tags first, followed by the UNAVAIL and then
IGNORE tags.

Oracle Workflow provides an example tag file called wfmail.tag.
For the standalone version of Oracle Workflow, the file resides in
your Oracle Workflow server directory structure in the
subdirectory res. For the version of Oracle Workflow embedded
in Oracle Applications, the file resides on your server in the
resource subdirectory under $FND_TOP.

RESET_FAILED—Indicate whether this Notification Mailer
should reset all notifications with a mail status of FAILED to a
mail status of MAIL when the Notification Mailer is started.
Valid values include Y or N. The default is N.

If the value is Y, the Notification Mailer will reset all FAILED
notifications to a mail status of MAIL on startup and then
attempt to process these notifications as usual.

RESET_NLS—Indicate whether the Notification Mailer should
convert the NLS codeset for a notification message according to
the notification recipient’s preferences before composing the
message. Valid values include Y or N. The default is N.



If the value is v, the Notification Mailer will convert the message
to the codeset listed in the WF_LANGUAGES table for the
language and territory specified in the recipient’s Workflow user
preferences. If no preferred territory is specified, the Notification
Mailer will use the codeset associated with the first entry it
encounters for the user’s preferred language. If neither a
language nor a territory is specified in the user preferences, the
Notification Mailer will use the codeset seeded in
WE_LANGUAGES for the language AMERICAN and territory
AMERICA. See: Setting User Preferences: page 9 — 6.

e HTML_MAIL_TEMPLATE—Specify OPEN_MAIL_OUTLOOXK to
use the Workflow Open Mail for Outlook Express message as the
template for e-mail notifications that require a response, for
users with a notification preference of ' MAILHTML “or
"MAILATTH'. You can select this message template if you use
an e-mail application such as Microsoft Outlook Express as your
e—-mail client, in order to include a link to the Notification Details
web page which lets users respond to the notification there. This
template is provided to accommodate e-mail applications that
cannot process the response links included in the Workflow
Open Mail (Templated) and Workflow Open Mail (Direct)
templates.

If you want to use the normal Workflow Open Mail (Templated)
and Workflow Open Mail (Direct) templates, you can comment
out this parameter in your configuration file and let the
Notification Mailer use these templates by default.

n@ Attention: If you include the HTML_MAIL_TEMPLATE

parameter in your configuration file, the Notification Mailer
will ignore the DIRECT_RESPONSE parameter when sending
messages to users with a notification preference of
'MAILATTH’. Instead, all users with this notification
preference will receive the plain text message body defined for
the Workflow Open Mail for Outlook Express template, which
uses the templated response method. Consequently, if you do
not need to use the Workflow Open Mail for Outlook Express
template, you should comment out the
HTML_MAIL_TEMPLATE parameter to let the
DIRECT_RESPONSE parameter take effect.

Note: The HTML_MAIL_TEMPLATE parameter does not
apply to users with a notification preference of 'MAILTEXT".

e SEND_ACCESS_KEY—Specify Y to include an access key in the
Notification Detail Link attachment that is sent with HTML
e-mail notifications and with plain text e-mail notifications with
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HTML attachments. The access key allows users to access the
Notification Details web page directly by clicking the
Notification Detail Link. Specify N to exclude the access key from
the Notification Detail Link. When users click the link without
the access key, they are prompted to log in, if they have not
already done so, before they can access the Notification Details
web page. The default is Y.

See: Defining Rules for Automatic Notification Processing: page 10 — 26

» To Run a Perpetual Shell Script for the Notification Mailer

Oracle Workflow Guide

1.

If you are running the standalone version of Oracle Workflow, you
need to set up a perpetual shell script that restarts the Notification
Mailer if it shuts down due to failure. Oracle Workflow provides a
sample shell script to restart the UNIX Sendmail Notification
Mailer. The script is called wfmail.csh and it is located in the Oracle
Home bin subdirectory on your server.

Note: Use a similar technique to restart the Window NT
Notification Mailer.

Enter the following command at your operating script prompt to
run the shell script:

wfmail.csh —-f <config file>

Replace <config_rile> with the full path name of the
configuration file that contains the parameters you want to run
with the Notification Mailer. The shell script passes all command
line arguments directly to the Notification Mailer executable.

Response Processing

You must create three folders or files in your response mail account
before starting the Notification Mailer to process responses. The three
folders or files serve to hold discarded, unprocessed, and processed
messages.

The Notification Mailer does the following to check for response
messages:

¢ Logs into the response mail account.

o Checks for messages. If a message exists, it reads the message,
checking for the notification ID and node identifier.

¢ If the message is not a notification, it moves it to the discard
folder.



e If the message is a notification for the current node, it moves the
message to the unprocessed folder.

o If the message is a notification, but for the wrong node, it does
not move the message so that the Notification Mailer for the
correct node can read it later.

The Notification Mailer then opens the unprocessed folder to process
each response. For each message, it:

e Retrieves the notification ID.

e Checks to see if the message bounced by referring to a specified
tag file, if any. If the message bounced, it reroutes it or updates
the notification’s status and stops any further processing
depending on the specifications of the tag file.

e Checks the Oracle Workflow database for this notification.

— If the notification does not exist, it moves it to the discard
folder.

— If the notification exists, but is closed or canceled, it moves
it to the discard folder.

— If the notification exists and is open, it verifies the response
values with the definition of the message’s response
attributes in the database. If a response is invalid, it sends
an Workflow Invalid Mail message to the recipient role. If
the responses are valid, it calls a Respond function to
complete the notification response and saves the change to
the database.

e Moves the message for the completed notification to the
processed folder and closes the unprocessed folder.

The Notification Mailer then truncates the discard and processed
folders, if a '~ precedes the discard and process parameters specified
in the configuration file, and logs out of the mail and database
accounts.
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Modifying Your Message Templates

Use the System: Mailer item type in Oracle Workflow Builder to
configure the templates that Oracle Workflow uses to send e-mail
notifications. The System: Mailer item type has attributes that
represent every part of the notification message. You can reorganize
the layout of these attributes in each template to customize the e-mail
messages sent by the Notification system.

The messages of the System: Mailer item type are not true messages;
rather they act as templates for any e-mail messages the Notification
system sends. System: Mailer messages determine the basic format of
an e-mail notification, including what header information to include,
or whether and where to include details such as the message due date
and priority.

c Warning: Do not add new attributes or delete existing
attributes from the message templates in the System: Mailer
item type.

Context: You need to perform this step only once.

Workflow Open Mail (Templated) Message

If you select the templated response method, the Notification system
uses the Workflow Open Mail (Templated) message as a template for
e—mail notifications that require a response. The notification template
includes generic instructions on how to respond to a notification. It
also includes the following information about a message: message
priority, date that a response is due, and any comments from the
sender of the message or, if the notification is forwarded from another
user, any comments from the forwarder.

Note: To select the templated response method, set
DIRECT_RESPONSE=N in the configuration file for the
Notification Mailer. See: To Create a Configuration File for the
Notification Mailer: page 2 — 61.

The response instructions in the plain text message body describe how
to reply manually using the templated response method. This message
is used for notifications sent to performers with a notification
preference of MAILTEXT or MAILATTH. The response instructions in
the HTML—-formatted message body describe how to reply using the
automatically generated response template. This message is used for
notifications sent to performers with a notification preference of
MAILHTML, and is also attached to notifications sent to performers
with a notification preference of MAILATTH.



The Workflow Open Mail (Templated) message has the following
message attributes. The values are drawn from the message definition
associated with a notification activity.

START_DATE The date the message is sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line defined in the message.

BODY The text of the body defined in the message.
COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.

NOTIFICATION Required notification code used to identify the
information in the notification.

RESPONSE The user response section as defined by the
Respond message attributes in the actual
notification message definition.

MAILTO The content of the HTML tag that a recipient
would click on to respond to a notification. This
attribute is used only for HTML e-mail
notifications.

CLICK_HERE_  The content of the HTML tag that a recipient

RESPONSE would click on to access the Notification Details
page to respond to a notification. This attribute is
not currently used.

You can customize the boilerplate text that appears in the body of the
Workflow Open Mail (Templated) message, where attributes preceded
by an ampersand (&) are token substituted with runtime values when
the notification is sent.

The boilerplate text for a plain text message body is as follows:

Oracle Workflow Notification
&COMMENT

Start of Response Template
Response Template for &NOTIFICATION

To submit your response, reply to this message, including
this response template with your reply. Copy and paste from
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this message if necessary to obtain an editable copy of the
template. Insert your response value between the quotes
following each response prompt.

&RESPONSE
End of Response Template

Notification Details:
&BODY

Due Date: &DUE_DATE

The boilerplate text for a HTML—formatted message body is as follows:

<HTML> <HEAD> <TITLE> Oracle Workflow Notification </TITLE>
</HEAD>

<BODY BGCOLOR="#FFFFFF” >

<P><B><FONT SIZE=+1>&COMMENT</FONT> </B>

<P>&BODY

<P><B>Please click on one of the following choices to
automatically generate an E-mail response. Before sending
the E-mail response to close this notification, ensure all
response prompts include a desired response value within
quotes.</B>

<P>&MATILTO

</BODY>

</HTML>

Workflow Open Mail (Direct) Message

If you select the direct response method, the Notification system uses
the Workflow Open Mail (Direct) message as a template for e-mail
notifications that require a response. The notification template includes
generic instructions on how to respond to a notification. It also
includes the following information about a message: message priority,
date that a response is due, and any comments from the sender of the
message or, if the notification is forwarded from another user, any
comments from the forwarder.

Note: To select the direct response method, set
DIRECT_RESPONSE=Y in the configuration file for the
Notification Mailer. See: To Create a Configuration File for the
Notification Mailer: page 2 — 61.



The response instructions in the plain text message body describe how
to reply using the direct response method. This message is used for
notifications sent to performers with a notification preference of
MAILTEXT or MAILATTH. The response instructions in the
HTML-formatted message body describe how to reply using the
automatically generated response template. This message is used for
notifications sent to performers with a notification preference of
MAILHTML, and is also attached to notifications sent to performers
with a notification preference of MAILATTH.

Note: Responses that are generated automatically from an
HTML—-formatted notification or attachment always use a
response template, regardless of which response method you
select in the DIRECT_RESPONSE parameter.

The Workflow Open Mail (Direct) message has the following message
attributes. The values are drawn from the message definition
associated with a notification activity.

START_DATE The date the message is sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line defined in the message.

BODY The text of the body defined in the message.
COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.

NOTIFICATION Required notification code used to identify the
information in the notification.

RESPONSE The user response section as defined by the
Respond message attributes in the actual
notification message definition.

MAILTO The content of the HTML tag that a recipient
would click on to respond to a notification. This
attribute is used only for HTML e-mail
notifications.

CLICK_HERE_  The content of the HTML tag that a recipient

RESPONSE would click on to access the Notification Details
page to respond to a notification. This attribute is
not currently used.
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You can customize the boilerplate text that appears in the body of the
Workflow Open Mail (Direct) message, where attributes preceded by
an ampersand (&) are token substituted with runtime values when the
notification is sent.

The boilerplate text for a plain text message body is as follows:

Oracle Workflow Notification
&COMMENT

Response Instructions for &NOTIFICATION

To submit your response, reply to this message, including
this note with your reply. The first lines of your reply
must be your responses to the notification questions.
Instructions below detail exactly what should be placed on
each line of your reply.

&RESPONSE

Notification Details:
&BODY

Due Date: &DUE_DATE

The boilerplate text for a HTML—formatted message body is as follows:

<HTML> <HEAD> <TITLE> Oracle Workflow Notification </TITLE>
</HEAD>

<BODY BGCOLOR="#FFFFFF” >

<P><B><FONT SIZE=+1>&COMMENT</FONT> </B>

<P>&BODY

<P><B>Please click on one of the following choices to
automatically generate an E-mail response. Before sending
the E-mail response to close this notification, ensure all
response prompts include a desired response value within
quotes.</B>

<P>&MAILTO

</BODY>

</HTML>



Workflow Open Mail for Outlook Express Message

If you use an e-mail application such as Microsoft Outlook Express as
your e-mail client, you should select the Workflow Open Mail for
Outlook Express message as a template for e-mail notifications that
require a response, for users with a notification preference of
MAILHTML or MAILATTH. This message includes a link to the
Notification Details web page to let users respond to the notification
there. This template is provided to accommodate e-mail applications
that cannot process the response links included in the Workflow Open
Mail (Templated) and Workflow Open Mail (Direct) templates.

Note: To select the Workflow Open Mail for Outlook Express
message as the message template for users with a notification
preference of MAILHTML or MAILATTH, set
HTML_MAIL_TEMPLATE=OPEN_MAIL_OUTLOOK in the
configuration file for the Notification Mailer. See: To Create a
Configuration File for the Notification Mailer: page 2 — 61.

n@ Attention: If you include the HTML_MAIL_TEMPLATE
parameter in your configuration file, the Notification Mailer
will ignore the DIRECT_RESPONSE parameter when sending
messages to users with a notification preference of
'MAILATTH'. Instead, all users with this notification
preference will receive the plain text message body defined for
the Workflow Open Mail for Outlook Express template, which
uses the templated response method. Consequently, if you do
not need to use the Workflow Open Mail for Outlook Express
template, you should comment out the
HTML_MAIL_TEMPLATE parameter to let the
DIRECT_RESPONSE parameter take effect.

The response instructions in the plain text message body describe how
to reply manually using the templated response method. This message
is used for notifications sent to performers with a notification
preference of MAILATTH. The HTML-formatted message body
includes a link called “Click here to respond” which lets users access
the notification in the Notification Details web page to respond to the
notification. This message is used for notifications sent to performers
with a notification preference of MAILHTML, and is also attached to
notifications sent to performers with a notification preference of
MAILATTH.

Note: When users choose the ”Click here to respond” link, it
automatically attempts to establish a web session with the web
server. Users must be able to connect to the web server to use
this link to respond to a notification. See: Reviewing
Notifications via Electronic Mail: page 10 — 2.
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The Workflow Open Mail for Outlook Express message has the
following message attributes. The values are drawn from the message
definition associated with a notification activity.

START_DATE The date the message is sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line defined in the message.

BODY The text of the body defined in the message.
COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.

NOTIFICATION Required notification code used to identify the
information in the notification.

RESPONSE The user response section as defined by the
Respond message attributes in the actual
notification message definition.

MAILTO The content of the HTML tag that a recipient
would click on to respond to a notification. This
attribute is not currently used.

CLICK_HERE_  The content of the HTML tag that a recipient

RESPONSE would click on to access the Notification Details
page to respond to a notification. This attribute is
used only for HTML e-mail notifications.

You can customize the boilerplate text that appears in the body of the
Workflow Open Mail for Outlook Express message, where attributes
preceded by an ampersand (&) are token substituted with runtime
values when the notification is sent.

The boilerplate text for a plain text message body is as follows:
Oracle Workflow Notification
&COMMENT

Start of Response Template

Response Template for &NOTIFICATION

To submit your response, reply to this message including
this response template in your reply. Insert your response
value between the quotes following each response prompt.



&RESPONSE
End of Response Template

Notification Details:
&BODY

Due Date: &DUE_DATE

The boilerplate text for a HTML—formatted message body is as follows:

<HTML> <HEAD> <TITLE> Oracle Workflow Notification </TITLE>
</HEAD>

<BODY BGCOLOR="#FFFFFF” >

<P><B><FONT SIZE=+1>&COMMENT</FONT> </B>

<P>&BODY

<P>&CLICK_HERE_RESPONSE

</BODY>

</HTML>

Workflow Open FYI Mail Message

The Notification system uses the Workflow Open FYI Mail message as
a template for all e-mail notifications that do not require a response.
The template indicates that the notification is for your information
(FYI) and does not require a response. In addition to the message, the
template also includes any comments from the sender or forwarder of
the message.

The Workflow Open FYI Mail message has the following message
attributes. The values are drawn from the message definition
associated with a notification activity.

START_DATE The date the message is sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line defined in the message.

BODY The text of the body defined in the message.
COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.
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NOTIFICATION Required notification code used to identify the
information in the notification.

You can customize the text that appears in the body of the Workflow
Open FYI Mail template, where attributes preceded by an ampersand
(&) are token substituted with runtime values when the notification is
sent. The boilerplate text for the plain text message body is as follows:

Oracle Workflow Notification (FYI)
&COMMENT

The boilerplate text for the HTML—formatted message body is as
follows:

<HTML><HEAD></HEAD>

<BODY BGCOLOR="#FFFFFF”><b>0Oracle Workflow Notification
(FYI)</b>

<br>&COMMENT

<hr>

<P>&BODY

</BODY>

</HTML>

Workflow URL Attachment Message

The Notification system uses the Workflow URL Attachment message
as a template to create the Notification References attachment for
HTML-formatted notification messages that include URL attributes
with Attach Content checked. The template includes a list with links to
each URL.

The Workflow URL Attachment message has the following message
attribute. The value is drawn from the message definition associated
with a notification activity.

URLLIST The list of URLs to be included in the attachment.

You can customize the text that appears in the body of the Workflow
URL Attachment template, where an attribute preceded by an
ampersand (&) is token substituted with a runtime value when the
notification is sent. The boilerplate text for the HTML—formatted
message body is as follows:

<HTML> <HEAD> <TITLE> Oracle Workflow Notification
References </TITLE> </HEAD>
<BODY BGCOLOR="#FFFFFF” >



<P><B><FONT SIZE=+1>Notification References</FONT> </B>

<HR WIDTH="100%">
<BR>

&URLLIST

<BR>

<HR WIDTH="100%">
<BR>&nbsp;
</BODY>

</HTML>

Workflow Canceled Mail Message

The Workflow Canceled Mail message informs the recipient that a
previously sent notification is canceled. It has the following message
attributes, with values that are drawn from the message definition
associated with the canceled notification activity:

START_DATE The date the original message was sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line of the original message.

BODY The text of the original message.

COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.

NOTIFICATION Required notification code used to identify the
information in the notification.

The boilerplate text for the plain text message body is as follows:

You earlier received the notification shown below. That
notification is now canceled, and no longer requires your

response. You may simply delete it along with this message.

The boilerplate text for the HTML—formatted message body is as
follows:

<html><Head></Head><body>You earlier received the
notification shown below. That notification is now
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canceled, and no longer requires your response.

You may

simply delete it along with this message.

<hr>
&BODY
</body></html>

Workflow Invalid Mail Message

The Workflow Invalid Mail message gets sent to a user when a user
responds incorrectly to a notification. The message describes how to
respond to the notification correctly. The message attributes are as

follows:
START_DATE
TO

SUBJECT
BODY
COMMENT
PRIORITY
DUE_DATE

NOTIFICATION

RESPONSE

MAIL_ERROR _
MESSAGE

MAIL_ERROR_
STACK

CLICK_HERE _
RESPONSE

The date the original message was sent.

The role the notification is sent to; the performer.
The subject line of the original message.

The text of the original message.

Comments added by the sender or the forwarder.
The priority of the notification message.

The date by which a response is required, specified
by the notification activity.

Required notification code used to identify the
information in the notification.

The user response section as defined by the
Respond message attributes in the original message
definition.

An error message that the mail program generates
if an error occurs upon processing the response.

An error stack of arguments that the mail program
generates if an error occurs upon processing the
response. You can provide this information to your
support representative if the problem cannot be
resolved with a corrected response.

The content of the HTML tag that a recipient
would click on to access the Notification Details
page to respond to a notification. This attribute is
not currently used.

The boilerplate text for the plain text message body is as follows:



Oracle Workflow Notification
&COMMENT

WARNING: Your previous response to this message was
invalid (see error message below). Please resubmit your
response.

Error Message: &MAIL_ERROR_MESSAGE
Error Stack: &MAIL_ERROR_STACK

Response Instructions for &NOTIFICATION

To submit your response, reply to this message, including
this original with your reply. This note contains a special
'NID’ string that is required to process the response. The
first lines of your reply must be your responses to the
notification questions. You should enter one line for each
response required by the notification; any additional lines
will be ignored. You may leave a line blank to accept the
default value for that specific response. You must supply a
value or a blank line for each question asked. Instructions
below detail exactly what should be placed on each line of
your reply.

&RESPONSE

Notification Details:
&BODY

Due Date: &DUE_DATE

The boilerplate text for the HTML—formatted message body is as
follows:

<html><Head></Head><body>WARNING: Your previous response to
this message was invalid (see error message below). Please
resubmit your response.

<P>Error Message: &MATIL_ERROR_MESSAGE

<BR>Error Stack: &MAIL_ERROR_STACK

<HR><P><B><FONT SIZE=+1>&COMMENT</FONT> </B>

<P>&BODY

<P><B>Please click on one of the following choices to
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automatically generate an E-mail response. Before sending
the E-mail response to close this notification, ensure all
response prompts include a desired response value within
quotes.</B>

<P>&MAILTO

</BODY> </HTML>

Workflow Closed Mail Message

The Workflow Closed Mail message informs the recipient that a
previously sent notification is now closed. It has the following message
attributes, with values that are drawn from the message definition
associated with the closed notification activity:

START_DATE The date the original message was sent.

TO The role the notification is sent to; the performer.
SUBJECT The subject line of the original message.

BODY The text of the original message.

COMMENT Comments added by the sender or the forwarder.
PRIORITY The priority of the notification message.
DUE_DATE The date by which a response is required, specified

in the notification activity.

NOTIFICATION Required notification code used to identify the
information in the notification.

The boilerplate text for the plain text message body is as follows:

You earlier received the notification shown below. That
notification is now closed, and no longer requires your

response. You may simply delete it along with this message.

The boilerplate text for the HTML—formatted message body is as
follows:

<html><Head></Head><body>You earlier received the
notification shown below. That notification is now closed,
and no longer requires your response. You may simply delete
it along with this message.

<hr>



&BODY
</body></html>

Workflow Summary Mail Message

The Notification system uses the Workflow Summary Mail message as
a template to send a summary of workflow notifications to users and
roles that have their notification preference set to 'SUMMARY" in the
Oracle Workflow directory service. The Workflow Summary Mail
message summarizes all currently open notifications for a given
user/role. It has the following message attributes, with values that are
drawn from the message definition associated with the open
notification activity:

SUMMARY Summary report.

USER_NAME The user/role the notification summary is sent to;
the performer.

SYSDATE The current date.
The boilerplate text for the plain text message body is as follows:

Summary of Notifications for ’&USER_NAME’
(Please use the Notifications web page to see details or
respond. )

&SUMMARY

The boilerplate text for the HTML—formatted message body is as
follows:

<HTML><HEAD></HEAD><BODY>

<P><FONT size=+1>Summary of Notifications for
'&USER_NAME '’ </FONT>

<BR><1>Please use the Notifications web page to see details
or respond.</i>

<HR>

&SUMMARY

</BODY>
</HTML>

Workflow Warning Mail Message

The Notification system uses the Workflow Warning Mail message as a
template to send a message to a user if it receives unsolicited mail from
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that user. It has the following message attributes, with values that are
drawn from the unsolicited mail:

UBODY The text of the unsolicited mail message body.

USUBJECT The text of the unsolicited mail subject line.

UFROM The address of the user that sent the unsolicited
mail.

The boilerplate text for the plain text message body is as follows:

Messages sent to this account are processed automatically by
the Oracle Workflow Notification Mailer. The message you
sent did not appear to be in response to a notification. If
you are responding to a notification, please use the
response template that was included with your notification.
Take care to include the ‘NID’ line of the template in your
reply. If you are not responding to a notification, please
do not send mail to this account.

From: &UFROM

Subject: &USUBJECT

&UBODY

The boilerplate text for the HTML—formatted message body is as
follows:

<html><head></head><body>

<b>Messages sent to this account are processed automatically
by the Oracle Workflow Notification Mailer. The message you
sent did not appear to be in response to a notification. If
you are responding to a notification, please use the
auto-generated reply created when responding to the original
message. This contains the 'NID’ line which is necessary for
identification. If you are not responding to a
notification, please do not send mail to this account.</b>
<hr>

<P>From: &UFROM

<BR>Subject: &USUBJECT

<P>&UBODY
</body></html>



Step12  Customizing the Logo on Oracle Workflow’s Web Pages

To use Oracle Workflow’s web pages and the Workflow Monitor at
your site, you must have Oracle HTTP Server installed. Refer to your
web server documentation for additional information.

Once your web server is installed and set up, you can customize the
company logo that appears on Oracle Workflow’s web pages.

Use a web browser that supports JavaScript to connect to the
Notification Web page or a web browser that supports Java
Development Kit (JDK), Version 1.1.8 or higher and Abstract
Windowing Toolkit (AWT) to connect to the Workflow Monitor.

» To Customize Oracle Workflow’s Web Pages

You can customize the company logo that appears in the upper right
corner of Oracle Workflow’s web pages.

1. Copy or rename your company logo file (in .gif format) to
FNDLOGOS.gif if you are using Oracle Workflow embedded in
Oracle Applications or WFLOGO.gif if you are using the
standalone version of Oracle Workflow.

2. Move the file to the physical directory that your web server’s
/OA_MEDIA/ virtual directory points to.

Note: If you are using Oracle Workflow embedded in Oracle
Applications, the mapping of /OA_MEDIA/ is completed as
part of the Oracle Applications installation and setup steps.

Note: If you are using the standalone version of Oracle
Workflow, the mapping of /OA_MEDIA/ is completed after you
install the Oracle Workflow server and you set up the
Workflow Monitor.

Context: You need to perform this step only once.
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Adding Custom Icons to Oracle Workflow

Oracle Workflow Builder looks for icons in the Icon subdirectory of the
Oracle Workflow area on your PC. The Icon subdirectory is defined in
the registry of Oracle Workflow Builder. The Oracle Workflow area is
typically the Wf subdirectory within your ORACLE_HOME directory
structure.

Workflow provides a variety of icons that you can use with your
activities and processes. You can add any icon files to this area as long
as they are Windows icon files with the .ico suffix.

If you want the custom icons that you include in your Oracle Workflow
Builder process definition to appear in the Workflow Monitor when
you view the process, you must do the following;:

o Convert the custom icon files (.ico) to gif format (.gif).

o Copy the .gif files to the physical directory that your web
server’s /OA_MEDIA/ virtual directory points to, so that the
Workflow Monitor can access them:

Note: If you are using Oracle Workflow embedded in Oracle
Applications, the mapping of /OA_MEDIA/ is completed as
part of the Oracle Applications installation and setup steps.

Note: If you are using the standalone version of Oracle
Workflow, the mapping of /OA_MEDIA/ is completed after you
install the Oracle Workflow server and you set up the
Workflow Monitor.

Context: You need to perform this step only once.



Step 14

Setting Up the Java Function Activity Agent

To execute external Java function activities, you must set up the Java
Function Activity Agent. This functionality is currently only available
for the standalone version of Oracle Workflow. The Java Function
Activity Agent dequeues the messages related to external Java
activities from the ‘Outbound” queue for external function processing,
calls the appropriate Java functions, and places the results on the
"Inbound” queue for external function processing.

Note: These ‘Outbound’ and 'Inbound” queues are separate
from the queues used for the Business Event System. See:
Workflow Queue APIs: page 8 — 162.

After a Java function completes, you must run a background engine to
process the ‘Inbound” queue and complete the function activity. See:
Setting Up Background Engines: page 2 — 46.

Some standard Workflow activities are external Java function activities
and require the Java Function Activity Agent. You can also define your
own external Java function activities. See: Standard Activities: page

6 —2, To Create a Function Activity: page 4 — 50, and Standard API for
Java Procedures Called by Function Activities: page 7 — 8.

To run the Java Function Activity Agent, you must have Java Runtime
Environment (JRE) Version 1.1.8, or a higher 1.1.x version, installed.

Note: The Java Runtime Environment is available for
download from http: //www.javasoft.com.

Context: You need to perform this step only once.

Starting the Java Function Activity Agent

If you are using the standalone version of Oracle Workflow, you can
run scripts provided by Oracle Workflow to start the Java Function
Activity agent. You can also start the agent manually.

When you start the Java Function Activity Agent, you must specify the
database connection details. You can also optionally specify the
character set and the JDBC driver type that you want to use.

You use different commands to start the agent depending on whether
you are running it from a script or manually, which platform you are
running it on, and which options you want to specify.
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Starting the Java Function Activity Agent From a Script

If you are using the standalone version of Oracle Workflow, you can
run scripts called wfjvlsnr.csh or wfjvlsnr.bat to start the Java Function
Activity Agent on UNIX or on Windows NT, respectively. These scripts
are located on your server in the Oracle Workflow admin subdirectory.

If you define your own external Java function activities, you must edit
the scripts to include the path to the JAR files containing your custom
Java classes. The custom class files should reside on the same platform
where the Java Function Activity Agent is run. The Java Function
Activity Agent does not need to reside on the same tier as the database,
however.

You can use commands with different syntax to run the scripts,
depending on your platform and the options you want to specify.

Running the wfjvlsnr.csh Script on UNIX

For example, you can use the following command to run the
wfjvlsnr.csh script on UNIX, if you want to use the default JDBC OCIS8
driver:

wfjvlsnr.csh <user_ name>/<password>@<connect_string>
[<character_set>]

Replace the parameters in the command as follows:

¢ <user_name>—The user name of your Oracle Workflow database
account.

® <password>—The password for your Oracle Workflow database
account.

e <connect_string>—The connect string for the database. Since
this command uses the default JDBC OCIS8 driver, the connect
string should be the database name as specified in its
TNSNAMES entry.

® <character_set>—The character set to use for the database
session. If you do not specify a character set, Oracle Workflow
uses UTF8 by default.

You can also use the following command to run the wfjvlsnr.csh script
on UNIX, if you want to specify the JDBC driver type to use:

wfjvlsnr.csh "<user_name> <password> <connect_string>
[<JDBC_driver>]" [<character set>]

Replace the parameters in the command as follows:



® <user_name>—The user name of your Oracle Workflow database
account.

® <password>—The password for your Oracle Workflow database
account.

e <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For a JDBC THIN driver, you can use two different types of
connect string. For the first type, the connect string should
include the host name, port number, and database system
identifier (SID) in the following format:
<host_name>:<port_number>:<database_SID>

For the second type, the connect string should include an
Oracle Net name—value pair with the host name, protocol,
port number, and SID in the following format:
(description=(address=(host=<host_name>) (protocol=
<protocol>) (port=<port_number>)) (connect_data=(sid=
<database SID>)))

e <JDBC_driver>—The JDBC driver type you want to use to
connect to the database. The JDBC driver type can be either oci8
or thin. If you do not specify a character set, Oracle Workflow
uses the JDBC OCIS8 driver by default.

Note: The connection details, including the user name,
password, connect string, and JDBC driver type, must be
enclosed in double quotes to separate them from the character
set parameter.

® <character_set>—The character set to use for the database
session. If you do not specify a character set, Oracle Workflow
uses UTF8 by default.

Running the wfjvlsnr.bat Script on Windows NT

On Windows NT, you can use the following command to run the
wfijvlsnr.bat script, if you want to use the default JDBC OCIS driver:

wfjvlsnr.bat <user_name>/<password>@<connect_string>
[<character_ set>]

Replace the parameters in the command as follows:
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¢ <user_name>—The user name of your Oracle Workflow database
account.

® <password>—The password for your Oracle Workflow database
account.

e <connect_string>—The connect string for the database. Since
this command uses the default JDBC OCIS8 driver, the connect
string should be the database name as specified in its
TNSNAMES entry.

® <character_set>—The character set to use for the database
session. If you do not specify a character set, Oracle Workflow
uses UTF8 by default.

You can also use the following command to run the wfjvlsnr.bat script
on Windows NT, if you want to specify the JDBC driver type to use:

wfjvlsnr.bat ”"<user_name> <password> <connect_string>
[<JDBC_driver>]1" [<character_set>]

Replace the parameters in the command as follows:

¢ <user_name>—The user name of your Oracle Workflow database
account.

¢ <password>—The password for your Oracle Workflow database
account.

¢ <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For a JDBC THIN driver, you can use two different types of
connect string. For the first type, the connect string should
include the host name, port number, and database system
identifier (SID) in the following format:
<host_name>:<port_number>:<database SID>

For the second type, the connect string should include an
Oracle Net name-value pair with the host name, protocol,
port number, and SID in the following format:
(description=(address= (host=<host_name>) (protocol=
<protocol>) (port=<port_number>)) (connect_data= (sid=
<database_SID>)))



<JDBC_driver>—The JDBC driver type you want to use to
connect to the database. The JDBC driver type can be either ocis
or thin. If you do not specify a character set, Oracle Workflow
uses the JDBC OCIS driver by default.

Note: The connection details, including the user name,
password, connect string, and JDBC driver type, must be
enclosed in double quotes to separate them from the character
set parameter.

<character_set>—The character set to use for the database
session. If you do not specify a character set, Oracle Workflow
uses UTES by default.

Starting the Java Function Activity Agent Manually

To start the Java Function Activity Agent manually, run JRE against
oracle.apps. fnd.wf.WFFALsnr, specifying your CLASSPATH, the user
name and password of your Oracle Workflow database account, and

the database connect string. You can also optionally specify the
character set and the JDBC driver type that you want to use.

The CLASSPATH must point to the Java Runtime Environment, the
directory containing the Workflow JAR files, the Oracle XML parser,
the Oracle JDBC implementation, and the following Workflow JAR

files:
[ )
[ )

wfjava.jar—The Java Function Activity Agent.
wfapi . jar—Workflow Java APIs.

The Share JAR file—Ultilities referenced by the Workflow Java
APIs. In the standalone version of Oracle Workflow with
Oracle9i, this file is named share-<version>. jar, such as
share-1_1_9.3jar, or whichever version is current. In the
version of Oracle Workflow embedded in Oracle Applications,
this file is named fndbalishare.jar.

The Ewt JAR file—Ultilities referenced by the Workflow Java
APIs. In the standalone version of Oracle Workflow with
Oracle9i, this file is named ewt-<version>. jar, such as
ewt—-3_3_18.jar, or whichever version is current. In the version
of Oracle Workflow embedded in Oracle Applications, this file is
named fndewt . jar.

The Swing JAR file—Optional additional utilities. In the
standalone version of Oracle Workflow with Oracle9;, this file is
named swingall-<version>.Jjar, such as swingall-1_1_1.jar,
or whichever version is current. In the version of Oracle
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Workflow embedded in Oracle Applications, this file is named
fndswing. jar.

Note: In the standalone version of Oracle Workflow with
Oracle9i, the Workflow JAR files are located in the
<ORACLE_HOME>/31ib directory. In the version of Oracle
Workflow embedded in Oracle Applications, the Workflow JAR
files are located in the
<ORACLE_HOME>/wf/java/oracle/apps/fnd/wf/jar/
directory.

If you define your own external Java function activities, you must also
include the JAR files containing your custom Java classes in the
CLASSPATH. The custom class files should reside on the same
platform where the Java Function Activity Agent is run. The Java
Function Activity Agent does not need to reside on the same tier as the
database, however.

You can use commands with different syntax to start the Java Function
Activity Agent manually, depending on your platform and the options
you want to specify.

Starting the Java Function Activity Agent on UNIX

For example, you can use the following command to start the Java
Function Activity Agent on UNIX, if you want to use the default JDBC
OCIB8 driver:

jre —-classpath

"S<JREPATH>/rt.jar:S$<Workflow JAR file_directory>:

S<Workflow JAR_file_directory>/wfjava.jar:$<ORACLE_HOME>/wf/
xml/java/lib/xmlparserv2.jar:S$S<Workflow JAR_file directory>/
wfapi.jar: $<ORACLE_HOME>/jdbc/lib/classeslll.zip:

S<Workflow JAR_file directory>/<Share JAR file>:

S<Workflow JAR_file directory>/<Ewt_JAR file>:

S<Workflow JAR_file directory>/<Swing JAR_file>:"
[-DCHARSET=<character_set>] oracle.apps.fnd.wf.WFFALsnr
<user_name>/<password>@<connect_string>

In this command, you can optionally use the -DCHARSET option to
specify the character set that you want to use. If you do not specify a
character set, Oracle Workflow uses UTES by default.

Replace the parameters in the command as follows:

® <character_set>—The character set to use for the database
session.

¢ <user_name>—The user name of your Oracle Workflow database
account.
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® <password>—The password for your Oracle Workflow database
account.

e <connect_string>—The connect string for the database. Since
this command uses the default JDBC OCIS8 driver, the connect
string should be the database name as specified in its
TNSNAMES entry.

You can also use the following command to start the Java Function
Activity Agent on UNIX, if you want to specify the JDBC driver type to
use:

jre -classpath

"S$S<JREPATH>/rt.jar:$<Workflow JAR file_directory>:

S<Workflow JAR file directory>/wfjava.jar:$<ORACLE_HOME>/wf/

xml/java/lib/xmlparserv2.jar: $<Workflow JAR file_directory>/

wfapi.jar:$<ORACLE_HOME>/jdbc/lib/classeslll.zip:

S<Workflow JAR_file directory>/<Share_JAR_file>:

S<Workflow JAR file directory>/<Ewt_JAR file>:

S<Workflow JAR file directory>/<Swing JAR _file>:"
[-DCHARSET=<character_set>] oracle.apps.fnd.wf.WFFALsnr
<user_name> <password> <connect_string> [<JDBC_driver>]

In this command, you can optionally use the -DCHARSET option to
specify the character set that you want to use. If you do not specify a
character set, Oracle Workflow uses UTE8 by default.

Replace the parameters in the command as follows:

e <character_set>—The character set to use for the database
session.

® <user_name>—The user name of your Oracle Workflow database
account.

® <password>—The password for your Oracle Workflow database
account.

® <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For aJDBC THIN driver, you can use two different types of
connect string. For the first type, the connect string should
include the host name, port number, and database system
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identifier (SID) in the following format:
<host_name>:<port_number>:<database_SID>

For the second type, the connect string should include an
Oracle Net name-value pair with the host name, protocol,
port number, and SID in the following format:
(description=(address=(host=<host_name>) (protocol=
<protocol>) (port=<port_number>)) (connect_data=(sid=
<database_SID>)))

e <JDBC_driver>—The JDBC driver type you want to use to
connect to the database. The JDBC driver type can be either ocis
or thin. If you do not specify a character set, Oracle Workflow
uses the JDBC OCIS8 driver by default.

Starting the Java Function Activity Agent on Windows NT

On Windows NT, you can use the following command to start the Java
Function Activity Agent, if you want to use the default JDBC OCI8
driver:

jre -classpath

", <JREPATH>\rt.jar;<Workflow JAR_file directory>;

<Workflow JAR file directory>\wfjava.jar; <ORACLE_HOME>\wf\
xml\java\lib\xmlparserv2.jar;<Workflow JAR file directory>\
wfapi.jar; <ORACLE_HOME>\jdbc\lib\classeslll.zip;

<Workflow JAR_file_directory>\<Share JAR_file>;

<Workflow JAR _file_directory>\<Ewt_JAR_file>;

<Workflow JAR file directory>\<Swing JAR_file>;"

-nojit [-DCHARSET=<character_set>]

oracle.apps. fnd.wf.WFFALsnr
<user_name>/<password>@<connect_string>

In this command, you can optionally use the -DCHARSET option to
specify the character set that you want to use. If you do not specify a
character set, Oracle Workflow uses UTES by default.

Replace the parameters in the command as follows:

e <character_set>—The character set to use for the database
session.

® <user_name>—The user name of your Oracle Workflow database
account.

¢ <password>—The password for your Oracle Workflow database
account.

¢ <connect_string>—The connect string for the database. Since
this command uses the default JDBC OCIS8 driver, the connect



string should be the database name as specified in its
TNSNAMES entry.

You can also use the following command to start the Java Function
Activity Agent on Windows NT, if you want to specify the JDBC driver
type to use:

jre —-classpath

" ;<JREPATH>\rt.jar;<Workflow JAR file directory>;

<Workflow JAR file_directory>\wfjava.jar;<ORACLE_HOME>\wf\
xml\java\lib\xmlparserv2.jar;<Workflow JAR_ file directory>\
wfapi.jar; <ORACLE_HOME>\jdbc\lib\classeslll.zip;

<Workflow JAR_file_ directory>\<Share_ JAR file>;

<Workflow JAR file directory>\<Ewt_JAR file>;

<Workflow JAR _file_directory>\<Swing_ JAR file>;"

-nojit [-DCHARSET=<character_set>]

oracle.apps. fnd.wf.WFFALSnr <user_name> <password>
<connect_string> [<JDBC_driver>]

In this command, you can optionally use the -DCHARSET option to
specify the character set that you want to use. If you do not specify a
character set, Oracle Workflow uses UTFS8 by default.

Replace the parameters in the command as follows:

® <character _set>—The character set to use for the database
session.

® <user_name>—The user name of your Oracle Workflow database
account.

® <password>—The password for your Oracle Workflow database
account.

® <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For a JDBC THIN driver, you can use two different types of
connect string. For the first type, the connect string should
include the host name, port number, and database system
identifier (SID) in the following format:
<host_name>:<port_number>:<database_SID>

For the second type, the connect string should include an
Oracle Net name—value pair with the host name, protocol,
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port number, and SID in the following format:
(description=(address= (host=<host_name>) (protocol=
<protocol>) (port=<port_number>)) (connect_data=(sid=
<database_SID>)))

e <JDBC_driver>—The JDBC driver type you want to use to
connect to the database. The JDBC driver type can be either ocis
or thin. If you do not specify a character set, Oracle Workflow
uses the JDBC OCIS8 driver by default.

Stopping the Java Function Activity Agent

Normally, the Java Function Activity Agent runs as a perpetual job.
However, you can stop the agent by running a script called
wijvstop.sql, located in the admin/sql subdirectory on your Oracle
Workflow server. This script places a stop message on the "Outbound’
queue. See: wijvstop.sql: page 16 — 11.

Note: If you are running more than one Java Function Activity
Agent simultaneously, you must run the wfjvstop.sql script
once for each Java Function Activity Agent.



Step 15

Setting Up the Business Event System

The Business Event System is an application service delivered with
Oracle Workflow that uses Oracle Advanced Queuing (AQ) to
communicate business events between systems. You need to perform
this step only if you want to use event processing. See: Overview of the
Oracle Workflow Business Event System: page 8 — 235 and Managing
Business Events: page 13 - 2.

To set up the Business Event System, perform the following steps:

1. If you want to communicate business events between the local
system and external systems, create database links to those external
systems.

2. If you want to use custom queues for propagating events, set up
your queues.

3. Schedule a listener to monitor the standard WF_ERROR queue to
enable error handling for the Business Event System. See: Setting
Up Queues: page 2 — 100 and Scheduling Listeners for Local
Inbound Agents: page 13 — 55.

You can either create database links and set up queues manually, or use
Oracle DBA Studio in the Oracle Enterprise Manager to perform these
steps. Oracle DBA Studio allows workflow administrators to quickly
and easily create and administer database links, queue tables, queues,
and queue propagation without requiring knowledge of the SQL DDL
commands. See: DBA Management Pack, Oracle Enterprise Manager
Administrator’s Guide.

Context: You need to perform this step only once.

Creating Database Links

To propagate event messages between systems, you must create
database links from your local system to the remote systems. You
should fully qualify the database link name with the domain name.

You can use the following syntax to create a database link:

CREATE DATABASE LINK <database 1ink name> CONNECT TO
<user> IDENTIFIED BY <password>
USING '<connect string>';

For example:

CREATE DATABASE LINK wf817.us.oracle.com CONNECT TO
wfuser IDENTIFIED BY welcome
USING 'wf817";
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If you have multiple installations of Oracle Workflow on both the local
database and the remote database, and you want to use the same
username and password to access both systems, you can omit the
<user> IDENTIFIED BY <password> clause. In this case, the database
link uses the username and password of the user who is connected to
the database.

CREATE DATABASE LINK <database 1ink name> CONNECT TO
USING ’'<connect string>';

If you want to create a public database link available to all users,
specify the parameter PUBLIC.

CREATE PUBLIC DATABASE LINK <database link name> CONNECT TO
<user> IDENTIFIED BY <password>
USING '<connect string>';

To verify the names of your database links, use the following syntax:

SELECT db_link FROM all_db_links

You can also use the Check Setup web page to verify that your database
links are set up. See: Checking the Business Event System Setup: page
13 -52.

CREATE DATABASE LINK, Oracle SQL Reference

Setting Up Queues

The Business Event System uses Oracle Advanced Queuing (AQ) to
communicate event messages between systems. You must associate a
queue with each agent you define in the Event Manager.

When you install Oracle Workflow, four standard queues are created
automatically for the four standard Workflow agents. These queues all
use the standard WF_EVENT_T structure as their payload type. See:
Standard Agents: page 13 — 25 and Event Message Structure: page

8 —242.

The following table lists the standard queues.



Queue Table Queue Name Description

WEF_IN WEF_IN Default inbound queue

WE_OUT WE_OUT Default outbound queue

WF_DEFERRED WEF_DEFERRED Default.queue for deferred subscription
processing

WEF_ERROR WEF_ERROR Default queue for error handling

Table 2 -2 (Page1o0f1)

The default retention time set for consumed messages on the standard
Workflow queues is seven days. You can change the retention time if
necessary using the PL/SQL procedure DBMS_AQADM.Alter_Queue.
You must not change any other part of the setup of these queues.

However, you must schedule listeners for WF_DEFERRED and
WEF_ERROR to enable deferred subscription processing and error
handling for the Business Event System, respectively. Also, if you want
to use WE_IN and WF_OUT for event message propagation, schedule a
listener for WF_IN and propagations for WF_OUT as well. See:
Scheduling Listeners for Local Inbound Agents: page 13 - 55 and
Scheduling Propagations for Local Outbound Agents: page 13 — 55.

You can also set up your own queues for event message propagation.
To set up a queue, you must create the queue table, create the queue,
and start the queue.

¢ To create a queue table, use the PL/SQL procedure
DBMS_AQADM .Create_Queue_Table. Use the following syntax:

DBMS_AQADM.Create_Queue_Table (
queue_table => ’'<queue table name>',
queue_payload_type => ’‘<qgueue payload type>',
sort_list => ’'PRIORITY,ENQ TIME’,
multiple_consumers => TRUE
compatible => ’8.1’");

For queues that you want use the standard Workflow format,
specify the queue payload type as wr_EVENT_T. These queues can
use the standard queue handler provided with Oracle Workflow,
WE_EVENT_QH. If you define a queue with a different payload
type, you must create a queue handler to translate between the
standard Workflow format and the format required by the
queue. See: Standard APIs for a Queue Handler: page 7 — 23.
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You can also use the storage_clause parameter to specify the
tablespace where you want to create the queue table. You may
want to specify a tablespace if you expect a queue to be very
large.

To create a queue, use the PL/SQL procedure
DBMS_AQADM.Create_Queue. Use the following syntax:

DBMS_AQADM.Create_Queue (
queue_name => '<queue name>',

queue_table => ’'<queue table name>') ;

Note: If you want other database users to enqueue messages
onto or dequeue messages from your queue, you must grant
those users the appropriate privileges using the PL/SQL
procedure DBMS_AQADM.Grant_Queue_Privilege.

To start a queue, use the PL/SQL procedure
DBMS_AQADM.Start_Queue. Use the following syntax:

DBMS_AQADM.Start_Queue (
gueue_name => '<queue name>') ;

Oracle Workflow provides a sample script called wfevquec.sql which
you can modify to set up your queues, as well as a sample script called
wfevqued.sql which you can modify to drop queues. These scripts are
located on your server in the Oracle Workflow sql subdirectory for the
standalone version of Oracle Workflow, or in the sgl subdirectory under
$FND_TOP for the version of Oracle Workflow embedded in Oracle
Applications.

You can use the Check Setup web page to verify that your queues are
set up properly. See: Checking the Business Event System Setup: page
13 -52.

Note: SQL*Plus version 8.1.6 does not allow you to select the
USER_DATA column from queue tables. You must have
SQL*Plus version 8.1.7 or higher, which allows you to select
USER_DATA, if you want to be able to select the event message
payload from your Workflow queues.

Administrative Interface, Oracle Application Developer’s Guide —
Advanced Queuing

DBMS_AQADM, Oracle Supplied PL/SQL Packages Reference
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Step 16

Setting Up the WF_EVENT_OMB_QH Queue Handler

You need to perform this step only if you are using the Business Event
System with Oracle8i and you want to use Oracle Message Broker
(OMB) to propagate event messages between systems. The
WF_EVENT_OMB_QH queue handler translates between the standard
Workflow event message structure, WF_EVENT_T, and the structure
required by OMB queues, OMBAQ_TEXT_MSG.

After you set up WF_EVENT_OMB_QH, you can assign this queue
handler to Business Event System agents that use propagation
protocols you have implemented through OMB. See: Agents: page
13 -22.

Note: You do not need to perform this step if you are using
Oracle9i. In Oracle9i, you can use the Messaging Gateway and
Internet Access features to propagate event messages, in place
of Oracle Message Broker.

Context: You need to perform this step only once.

To Set Up WF_EVENT_OMB_QH

1. Use OMB to create the AQ queues that you want to use for event
message propagation. The queues should be single-consumer
queues created in your Oracle Workflow schema. You should create
at least one inbound and one outbound queue. For example, create
queues called WF_OMB_IN and WF_OMB_OUT.

2. Run the script wfquhndos.pls to create the PL/SQL spec for the
WE_EVENT_OMB_QH package. This script is located in the wf/sq!
subdirectory in your Oracle Home.

3. Run the script wfquhndob.pls to create the PL/SQL body for the
WF_EVENT_OMB_QH package. This script is located in the wf/sql
subdirectory in your Oracle Home.

Standard APIs for a Queue Handler: page 7 — 23
Event Message Structure: page 8 — 242

Mapping Between WE_EVENT_T and OMBAQ_TEXT_MSG: page
8 — 257
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Overview of Oracle Workflow Access Protection

Access protection is a feature that prevents workflow seed data created
by a ‘seed data provider’ from being modified by a 'seed data
consumer’. Here, a ‘seed data provider’ is any organization that
creates ‘seed data’ for other organizations ('seed data consumers’) to
use in defining and customizing a workflow process. In Oracle
Workflow, seed data refers to either of the following;:

o Workflow object definitions that can and should be customized
to meet a certain consumer’s needs.

¢ Workflow object definitions protected against customization
because they represent standards that may also be upgraded in
the future by the provider.

For example, the Oracle Workflow development team is a provider of
seed data called the Standard item type. The Standard item type
contains standard activities that can be dropped into any custom
workflow process. The development team at your organization’s
headquarters may create a custom workflow process definition that
references activities from the Standard item type. This makes the
headquarters team a consumer of the Standard item type seed data.

Now suppose the headquarters team wants to deploy the custom
workflow definition that it created to teams at other regional offices.
The headquarters team, as seed data providers, may want to do the
following:

¢ Identify certain workflow objects in its custom workflow
definition as corporate standards that the regional teams should
adhere to and not modify.

¢ Designate certain objects in its deployed process as customizable
for the regional offices to alter to their offices” needs.

The headquarters team can satisfy both requirement using the access
protection feature in Oracle Workflow. Access protection lets seed data
providers protect certain data as ‘read—only’, while allowing other data
to be customized. Also during a seed data upgrade, access protection
lets the seed data provider overwrite any existing protected seed data
with new versions of that seed data, while preserving any
customizations made to customizable seed data.

Oracle Workflow assigns a protection and customization level to every
workflow object definition stored in the database and requires every
user of Oracle Workflow to operate at a certain access level. The
combination of protection, customization, and access levels make up
the access protection feature and determines whether a user can
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modify a given workflow object. The level in all three cases, is a
numeric value ranging from 0 to 1000 that indicates the relationship
between different organizations as providers and consumers of seed
data.

The following range of levels are presumed by Oracle Workflow:

0-9 Oracle Workflow

10-19 Oracle Application Object Library

20-99 Oracle Applications development

100-999 Customer organization. You can determine how

you want this range to be interpreted. For
example, 100 can represent headquarters, while 101
can represent a regional office, and so on.

1000 Public

Access Level

Each user of Oracle Workflow operates the system at a certain access
level according to the range of levels listed above. A "user of Oracle
Workflow” in this case, represents someone who is operating Oracle
Workflow Builder, or the Workflow Definitions Loader program, which
loads workflow process definitions from a file into a database. Asa
seed data provider, you should always operate Oracle Workflow
Builder at the same consistent access level because the level you work
at affects the protection level of the seed data you create.

You can view your access level as follows:

¢ In Oracle Workflow Builder, select About Workflow from the
Help menu.

e If you are going to run the Workflow Definitions Loader
program to download workflow process definitions from the
database to a file, check the value for the environment variable
WE_ACCESS_LEVEL on your workflow server. See: Using the
Workflow Definitions Loader: page 2 — 110.

Note: The Workflow Definitions Loader program references
the access level stored in the environment variable called
WE_ACCESS_LEVEL, which you must define when you install
Oracle Workflow on your server. If you do not define this
environment variable, the Workflow Definitions Loader simply
assumes a default access level of 100.

Note: When you install the version of Oracle Workflow
embedded in Oracle Applications, you need to define this
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variable in an environment file. The default environment file is
APPLSYS.env. If you do not define this environment variable,
the Workflow Definitions Loader simply assumes a default
access level of 100. Refer to your Oracle Applications
installation manual for more information about environment
files.

Protection Level

Whenever you create a workflow object in Oracle Workflow Builder,
you have the option of protecting the object at a certain level. An
object’s protection level controls whether other users can modify the
object based on their access levels.

To change the protection level of an object, display the Access tab of the
object’s property page. The protection level that you set for an object is
dependent on your current access level. You can control access to an
object in one of four ways:

e Allow access to everyone—By default, all users are allowed
access to an object if both “Preserve Customizations’ and "Lock
at this Access Level” are unchecked in the Access tab, that is the
protection level is equal to 1000.

¢ Limit access to users with access levels equal to your own or
higher—If you check 'Preserve Customizations’ in the Options
region of the Access tab, you designate the object as being
customizable by anyone with an access level equal to or higher
than your current access level. You should only mark objects as
customizable if you are sure that you will not be providing
upgraded versions of this object in the future that would
overwrite other user’s customizations to it.

¢ Limit access to users with access levels equal to your own or
lower—If you check "Lock at this Access Level’, you protect the
object and ensure that the object may only be modified by users
with an access level equal to or lower than your current access
level. Users operating at a higher access level will see a small
lock on the workflow object’s icon, indicating that the object can
be used but not modified. Protect any objects that you want to
define as standard components that will not change unless you
provide a global upgrade. For this reason, it is important that
you always operate at the same consistent access level.

¢ Limit access to users with access levels equal to your own—If
you check both “Lock at this Level” and 'Preserve
Customizations’ you ensure that the object cannot be modified



by anyone other than users operating at your current access
level.

The following table shows which access levels can access an object
under different settings of the ‘Preserve Customizations” and "Lock at
this Access Level” options.

Preserve Lock at this Access q g
Customizations Level Access Level applied to Object
Cleared Cleared Object may be updated by any access level.
Object may only be updated by users with
Checked Cleared access levels equal to or higher than your
current access level.
Object may only be updated by users with
Cleared Checked access levels equal to or lower than your
current access level.
Checked Checked Object cannot be updated by any access
level except for your current access level.

Table 2-3 (Page1of1)

ISy

Attention: If you have installed the beta version of Microsoft’s
Internet Explorer on your PC, which automatically installs an
early version of a file called comctl32.dll, you may not see the
lock icons appear on the locked objects in Oracle Workflow
Builder. To correct this problem, install the production version
of Microsoft’s Internet Explorer to replace comcti32.dll with the
latest copy.

The protection and access levels in Oracle Workflow are present to
remind you that certain workflow objects should not be modified or
should only be modified by someone accessing the tool at an
authorized access level. It is not intended as a means of securing or
source controlling your workflow objects.

ISy

Attention: Most workflow objects provided by Oracle
Workflow have a protection level of 0, which means the objects
can only be modified by the Oracle Workflow team, operating
at an access level of 0. If you attempt to alter your access level
to 0 and modify the data anyway, your customizations will not
be supported, especially if Oracle Workflow provides an
upgrade to the seed data that may overwrite the modifications
you make to the originally protected data.
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Customization Level

Every workflow object, in addition to having a protection level, also
records a customization level equal to your access level when you
modify the object and save it to a database or file. For example, if a
workflow object is customizable (protection level is 1000), and you
customize it at an access level of 100, you now mark the object as
having a customization level of 100. The customization level indicates
that the object can only be further modified by someone operating at an
access level equal to or higher than the customization level. So in this
example, you can only customize the object further if your access level
is 100 or higher. If you are operating at an access level lower than an
object’s customization level, you will see a small lock on that workflow
object’s icon, indicating that the object can be used but not modified.

This ensures that a customizable object that has been customized never
gets overwritten during a seed data upgrade because the upgrade
always occurs with the Workflow Definitions Loader operating at an
access level below the customized object’s customization level.

Setting Up a Default Access Level
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When you install Oracle Workflow Builder on a Microsoft Windows 95,
Windows 98, Windows 2000, or Windows NT PC, Oracle Universal
Installer assigns a default access level that is global to the PC and the
operating system you are installing on. After installing Oracle
Workflow Builder, you can have individual users on the PC change
their access level to a new setting which overrides the default access
level set for the PC. If a user does not define an access level, Oracle
Workflow Builder assumes the value of the default access level for the
PC. The access levels are stored in the Microsoft Windows registry.

If you are deploying Oracle Workflow Builder and workflow seed data
to users in other parts of your organization, and you wish to
discourage those users from modifying the seed data that you provide,
you can have them operate Oracle Workflow Builder at an access level
that is higher than the data’s protection level. For example if you, as a
seed data provider, are operating at an access level of 100 and the seed
data you create is protected at a level of 100, then you should require
the access level for your users or seed data consumers to be 101 or
higher.

You can set a user’s access level in Oracle Workflow Builder by having
them choose About Oracle Workflow Builder... from the Help menu. In
the About Oracle Workflow Builder window, change the Access Level



field to a number higher than your seed data protection level, then
choose OK.

You can also set the access level directly in the Microsoft Windows
registry by using a registry editor such as regedit to edit the decimal
value under
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\Workflow\Level.

For the Workflow Definitions Loader program, you set the default
access level that the program operates at for downloading process
definitions to a file, by defining an environment variable called
WF_ACCESS_LEVEL and setting its value using the appropriate
operating system command.

Caution: Although you can modify your access level, Oracle
Workflow does not support any customizations to seed data
originally protected at a level 99 or lower. We STRONGLY
RECOMMEND that you not change your access level to an
unauthorized level for modifying protected data.
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Rather than use the File Save or File Open menu options in Oracle
Workflow Builder, you can also run a program called Workflow
Definitions Loader to save or load process definitions from a database
or flat file.

When you upgrade your database, use the Workflow Definitions
Loader to preserve and back up your process definitions to a flat file.
When the database upgrade is complete, use the Loader program again
to upload the definitions back into your database. You can also use the
Loader program to upgrade your database with a newer version of a
process definition or to transfer process definitions to other databases.

When you upload or upgrade a process definition, the Workflow
Definitions Loader automatically validates the process definition to
ensure that it conforms to specific process design rules. It performs the
same validation as the Oracle Workflow Builder Verify feature. See: To
Validate a Process Definition: page 5 —21.

Iy

Attention: When you upload or upgrade a workflow
definition onto an existing definition in a database, it is possible
that an object in the upload/upgrade definition has a Display
Name that is already in use by a different object in the target
database. If this occurs, the Workflow Definition Loader
automatically resolves the display name conflict by adding a
'@’ character to the beginning of conflicting display names in
the target database. The upload/upgrade definition is then
applied as is and a warning message is generated.

Note: You can use the Workflow Definitions Loader Release
2.6.1 to upload and download process definitions from all
versions of the Oracle Workflow Server embedded in Oracle
Applications Release 11i, as well as Release 2.6.1, base Release
2.6, and Release 2.5 of the standalone version of the Oracle
Workflow Server. However, when you use the Workflow
Definitions Loader to upload process definitions to an earlier
Oracle Workflow Server version, those processes cannot
include any new features introduced in later releases. For more
details about which features you must not use with earlier
versions, see: Using Oracle Workflow Builder with Different
Server Versions: page 3 — 21.



» To run the Workflow Definitions Loader for the standalone version
of Oracle Workflow

1.

The Workflow Definitions Loader program is located on your
server in the bin subdirectory of the Oracle Home directory
structure.

Run the program from your operating system prompt as follows
(replacing <username/password@database>with the username,
password and Oracle Net connect string or alias to your database):

e To apply a seed data upgrade to a database from an input file,
type:

wfload <username/password@database> <input_file>

By using the default upgrade behavior, the Workflow Definitions
Loader assumes the access level of the file’s creator (seed data
provider) and overwrites any objects protected at a level equal to
or above the upgrade file’s access level. During an upgrade, the
Loader program preserves any customizations made to
customizable seed data in the database. <input file>
represents the name and full path of the upgrade file you are
loading.

¢ To upload process definitions from an input file to a database,
type:

wfload -u <username/password@database> <input_file>

The upload mode is useful to someone who is developing a
workflow process. It allows the developer to save definitions to
the database without concern that accidental customizations to
existing objects might prevent the upload of some process
definition elements. The Workflow Definitions Loader uses the
access level specified in the input file. <input_file>represents
the name and full path of the input file you want to upload from.

¢ To force an upload of the process definitions from an input file to
a database regardless of an object’s protection level, type:

wfload -f <username/password@database> <input_file>

<input_file>represents the name and full path of the input file
you want to upload from. When using the force option, you
should be certain that the process definition in the file is correct
as it overwrites the entire process stored in the database. The
force option is useful for fixing data integrity problems in a
database with a known, reliable file backup. The force option is
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also useful for loading .wft files from Oracle Workflow Release
1.0 or 1.0.1, which reflect an older data model.

Note: When using the force option to load a .wft file from
Oracle Workflow Release 1.0 or 1.0.1 into a database, you must
also complete a manual step once the .wft file is loaded. You
must associate the lookup types that you load with an item
type. To do this, in the Navigator window of Oracle Workflow
Builder, drag the lookup types from the independent Lookup
Types branch to a Lookup Types branch associated with an

item type.

¢ To download the process definition of one or more item types

from a database to an output file, type:

wfload [-d <date>] <username/password@database>
<output_file> <item_ typel> <item_type2> ...<item typeN>

<output_file>represents the name and full path of the output
file you want to write to, and <item_typeN> represents the
internal name of each item type you want to download. You can
also replace <item typeN> with "*’ to represent all item types
(make sure you enclose the asterisk in single quotes). If you
specify the —d option with a date (omitting the square brackets),
you can download the process definition that was effective at
that date. The date must be supplied in the following format:
YYYY/MM/DD HH24:MI:SS.

Your output file should have the extension .wft. When you
download a process definition, the Loader program sets the
output file’s access level to be the value stored in the
WF_ACCESS_LEVEL environment variable.

» To run the Workflow Definitions Loader for the version of Oracle
Workflow embedded in Oracle Applications

Oracle Workflow Guide

1.

Navigate to the Submit Requests form in Oracle Applications to
submit the Workflow Definitions Loader concurrent program.
When you install and set up Oracle Applications and Oracle
Workflow, your system administrator needs to add this concurrent
program to a request security group for the responsibility that you
want to run this program from. See: Overview of Concurrent
Programs and Requests, Oracle Applications System Administrator’s
Guide.

Submit the Workflow Definitions Loader concurrent program as a
request. See: Submitting a Request, Oracle Applications User’s Guide.



3. In the Parameters window, enter values for the following

parameters:

Mode

File

Item Type

Specify “Download” to download a process
definition from the database to a flat file.

Specify “Upgrade” to apply a seed data upgrade to
a database from an input file. The Workflow
Definitions Loader assumes the access level of the
file’s creator (seed data provider) and overwrites
any objects protected at a level equal to or above
the upgrade file’s access level. The Loader
program preserves any customizations made to
customizable seed data in the database.

Specify “Upload” to load a process definition from
a flat file into the database. The upload mode is
useful to someone who is developing a workflow
process. It allows the developer to save definitions
to the database without concern that accidental
customizations to existing objects might prevent
the upload of some process definition elements.
The Workflow Definitions Loader uses the access
level defined by the input file to upload the process
definitions from the file and therefore will
overwrite objects in the database that are protected
at a level equal to or higher than that file’s access
level.

Specify “Force” to force an upload of the process
definitions from an input file to a database
regardless of an object’s protection level You
should be certain that the process definition in the
file is correct as it overwrites the entire process
stored in the database. The Force mode is useful
for fixing data integrity problems in a database
with a known, reliable file backup.

Specify the full path and name of the file that you
want to download a process definition to, or
upgrade or upload a process definition from.

If you set Mode to “Download”, use the List button
to choose the item type for the process definition
you want to download.

Note: When you submit the Workflow Definitions Loader
from the Submit Requests form to download process
definitions to a file, you can only specify to download one item
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type at a time. If you wish to download multiple or all item
types simultaneously, you should submit the Workflow
Definitions Loader concurrent program from the command
line. See Step 6 below for details.

Choose OK to close the Parameters window.

When you finish modifying the print and run options for this
request, choose Submit to submit the request.

Rather than use the Submit Requests form, you can also run the
Workflow Definitions Loader concurrent program from the
command line by entering the following commands:

To upgrade— WFLOAD apps/pwd 0 Y UPGRADE file.wft
Toupload—  WFLOAD apps/pwd 0 Y UPLOAD file.wft
To force— WFLOAD apps/pwd 0Y FORCE file.wft

To download— WFLOAD apps/pwd 0 Y DOWNLOAD file.wft
ITEMTYPE1 [ITEMTYPE?2 ..ITEMTYPEN]

Replace apps/pwd with username and password to the APPS

schema, replace file.wft with the file specification of a workflow

process definition file, and replace ITEMTYPE1, ITEMTYPE2,
... ITEMTYPEN with the one or more item type(s) you want to
download. You can also download all item types
simultaneously by replacing ITEMTYPE1 with "* (make sure
you enclose the asterisk in single quotes).

A file specification is specified as:
@<application_short_name>: [<dir>/.../]file.ext
or

<native path>



Using the Workflow XML Loader

The Workflow XML Loader lets you upload and download XML
definitions for Business Event System objects between a database and a
flat file. When you download Business Event System object definitions
from a database, Oracle Workflow saves the definitions as an XML file.
When you upload object definitions to a database, Oracle Workflow
loads the definitions from the source XML file into the Business Event
System tables in the database, creating new definitions or updating
existing definitions as necessary.

The XML definitions for Business Event System objects are structured
according to the following document type definitions (DTDs):

Events—WF_EVENTS DTD: page 8 — 301

Event group members—WF_EVENT_GROUPS DTD: page
8 - 304

Systems—WF_SYSTEMS DTD: page 8 — 307
Agents—WF_AGENTS DTD: page 8 — 310

Event subscriptions—WF_EVENT_SUBSCRIPTIONS DTD: page
8-313

You can download Business Event System object definitions in either
normal download mode or exact download mode.

Normal download mode lets you save a generic copy of object
definitions from one system that you can use to create similar
definitions in other systems. In this mode, the Workflow XML
Loader replaces certain system—specific data within the object
definitions with tokens. Choose normal download mode, for
example, when you want to save Business Event System object
definitions from a development system as seed data that can be
uploaded to a production system.

Exact download mode lets you save object definitions exactly as
they are specified in the database. In this mode, the Workflow
XML Loader does not convert any data to tokens; instead, all
values, including system-specific values, are copied to the XML
file. Choose exact download mode, for example, when you want
to save Business Event System object definitions from one
production system so that you can replicate them to another
production system that communicates with the first.

In normal download mode, the Workflow XML Loader uses the
following tokens to replace system—specific data within Business Event
System object definitions. The tokens are prefixed by #.
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o #NEW—Replaces the global unique identifier for an agent
within an agent definition, or for an event subscription within a
subscription definition.

o #LOCAL—Replaces the global unique identifier for the local
system wherever it appears within an agent or subscription
definition.

o #OWNER—Replaces the name of the schema that owns a queue
when the schema appears as part of the queue name and agent
address within an agent definition.

o #SID—Replaces the database system identifier (SID) when it
appears as part of the agent address within an agent definition.

o #WF_IN—Replaces the global unique identifier for the WF_IN
agent on the local system when it appears as the Source Agent,
Out Agent, or To Agent within an event subscription definition.

o #WF_OUT—Replaces the global unique identifier for the
WE_OUT agent on the local system when it appears as the
Source Agent, Out Agent, or To Agent within an event
subscription definition.

o #WF_ERROR—Replaces the global unique identifier for the
WEF_ERROR agent on the local system when it appears as the
Source Agent, Out Agent, or To Agent within an event
subscription definition.

By converting these system—specific values to tokens, the loader
produces template definitions that you can use to create similar objects
in other systems. When you upload object definitions that contain
tokens to a database, Oracle Workflow replaces the tokens with the
appropriate values for that system.

Managing Business Events: page 13 — 2

To Download Business Event System XML Definitions from a
Database

To download Business Event System object definitions from a database
to a flat XML file, you can either run the Workflow XML Loader
manually, or, if you are using the standalone version of Oracle
Workflow, you can use a script to run the loader.



To run the Workflow XML Loader manually, run JRE against
oracle.apps. fnd.wf.WFXLoad. You must specify your CLASSPATH
pointing to the Java Runtime Environment, the directory containing the
Workflow JAR files, the Oracle JDBC implementation, and the
following Workflow JAR files:

¢ wfjava.jar—Workflow Java utilities
e wfapijar—Workflow Java APIs

Note: If you are using the standalone version of Oracle
Workflow with Oracle9i, the Workflow JAR files are located in
the <ORACLE_HOME>/31ib directory. If you are using the version
of Oracle Workflow embedded in Oracle Applications, the
Workflow JAR files are located in the
<ORACLE_HOME>/wf/java/oracle/apps/fnd/wf/jar/
directory.

For example, on UNIX, use the following command to run the
Workflow XML Loader:

jre -classpath

"S<JREPATH>/rt.jar:S$S<Workflow JAR file_directory>:
S<Workflow JAR_file directory>/wfjava.jar:

S<Workflow JAR file directory>/wfapi.jar:
$<ORACLE_HOME>/jdbc/lib/classeslll.zip:”
oracle.apps.fnd.wf.WFXLoad -d[e] <user> <password>
<connect_string> <protocol> <lang> <output_file> <object>
<key>

On Windows NT, use the following command:

jre —-classpath

", <JREPATH>\rt.jar;<Workflow JAR_file directory>;

<Workflow JAR _file_ directory>\wfjava.jar;

<Workflow JAR file directory>\wfapi.jar;
<ORACLE_HOME>\jdbc\lib\classeslll.zip;"”
oracle.apps.fnd.wf.WFXLoad -d[e] <user> <password>
<connect_string> <protocol> <lang> <output_file> <object>
<key>

If you are using the standalone version of Oracle Workflow, you can
use sample scripts called wfxload for UNIX or wfxload.bat for
Windows NT to run the Workflow XML Loader. These scripts are
located on your server in the Oracle Workflow admin subdirectory. For
example, on UNIX, use the following command:

wfxload -d[e] <user> <password> <connect_string> <protocol>
<lang> <output_file> <object> <key>
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On Windows NT, use the following command:

wfxload.bat -d[e] <user> <password>
<connect_string> <protocol> <lang> <output_file> <object>
<key>

When running the Workflow XML Loader, use either the -d option or
the -de option to specify the download mode that you want.

¢ -d —Normal download mode. The loader converts
system—specific data within the object definitions to tokens
prefixed with #, where appropriate.

¢ -de —Exact download mode. The loader copies the object
definitions exactly and does not convert any data to tokens.

Additionally, replace the variables in the download command with
your parameters as follows:

¢ <user>—The user name of your database account.
¢ <password>—The password for your database account.

® <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For a JDBC THIN driver, you can use two different types of
connect string. For the first type, the connect string should
include the host name, port number, and database system
identifier (SID) in the following format:
<host_name>:<port_number>:<database_SID>

For the second type, the connect string should include an
Oracle Net name-value pair with the host name, protocol,
port number, and SID in the following format:
(description=(address= (host=<host_name>) (protocol=
<protocol>) (port=<port_number>)) (connect_data=(sid=
<database_SID>)))

e <protocol>—The JDBC driver type you want to use to connect
to the database. The JDBC driver type can be either oci8 or thin.

¢ <lang>—The abbreviation for the language of the XML file. This
parameter is case insensitive. Use the standard language
abbreviations for the Oracle database server, such as US for
American or JA for Japanese. For a list of the standard language
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abbreviations, see: Locale Data, Oracle National Language Support
Guide.

e <output_file>—The name and full path of the output file to
which you want to save the definitions.

e <object>—The type of object definitions you want to download.

— EVENT—Event, event group member, and event
subscription definitions

— SYSTEMS—System definitions
— AGENTS—Agent definitions

— ALL—AIl Business Event System object definitions,
including events, event group members, systems, agents,
and event subscriptions

Note: The Workflow XML Loader only downloads system,
agent, and event subscription definitions that belong to the
local system.

* <key>—An optional key to restrict the definitions that are
downloaded. If you specify a key, the loader retrieves definitions
only for those objects whose internal names include that key. The
key value is case sensitive and cannot contain any spaces. To
retrieve all object definitions of the specified type, you can omit
this parameter.

Note: If you specify ALL for the object type, the Workflow
XML Loader ignores the key and downloads all Business Event
System object definitions from the system.

= Attention: To use the Workflow XML Loader in download
mode, you must have a version 8.1.7 or higher database. The
download utility is not supported for earlier versions of
Oracle8i. To replicate Business Event System objects from one
system to another for earlier database versions, you should
follow the steps to synchronize systems using predefined
subscriptions provided with the Business Event System. See:
Synchronizing Systems: page 13 — 68.

You can, however, use the Workflow XML Loader in upload
mode with versions of Oracle8i earlier than 8.1.7.
» To Upload Business Event System XML Definitions to a Database

To upload Business Event System object definitions from an XML file to
a database, you can either run the Workflow XML Loader manually, or,
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if you are using the standalone version of Oracle Workflow, you can
use a script to run the loader.

To run the Workflow XML Loader manually, run JRE against
oracle.apps.fnd.wf.WFXLoad. You must specify your CLASSPATH
pointing to the Java Runtime Environment, the directory containing the
Workflow JAR files, the Oracle JDBC implementation, and the
following Workflow JAR files:

o wifjava.jar—Workflow Java utilities
o wfapijar—Workflow Java APIs

Note: If you are using the standalone version of Oracle
Workflow with Oracle9i, the Workflow JAR files are located in
the <ORACLE_HOME>/31ib directory. If you are using the version
of Oracle Workflow embedded in Oracle Applications, the
Workflow JAR files are located in the
<ORACLE_HOME>/wf/java/oracle/apps/fnd/wf/jar/
directory.

For example, on UNIX, use the following command to run the
Workflow XML Loader:

jre —-classpath

"S<JREPATH>/rt.jar:$<Workflow JAR _file directory>:
S<Workflow JAR_file directory>/wfjava.jar:
S<Workflow JAR_file directory>/wfapi.jar:
$S<ORACLE_HOME>/jdbc/lib/classeslll.zip:”
oracle.apps. fnd.wf.WFXLoad -u <user> <password>
<connect_string> <protocol> <lang> <source_file>

On Windows NT, use the following command:

jre -classpath

" ;<JREPATH>\rt.jar;<Workflow JAR file_directory>;
<Workflow JAR file_directory>\wfjava.jar;

<Workflow JAR_file directory>\wfapi.jar;
<ORACLE_HOME>\jdbc\lib\classeslll.zip;"”
oracle.apps. fnd.wf.WFXLoad -u <user> <password>

<connect_string> <protocol> <lang> <source_file>

If you are using the standalone version of Oracle Workflow, you can
use sample scripts called wfxload for UNIX or wfxload.bat for
Windows NT to run the Workflow XML Loader. These scripts are
located on your server in the Oracle Workflow admin subdirectory. For
example, on UNIX, use the following command:

wfxload -u <user> <password> <connect_string> <protocol>
<lang> <source_file>



On Windows NT, use the following command:

wfxload.bat -u <user> <password> <connect_string> <protocol>
<lang> <source_file>

When running the Workflow XML Loader, use the —u option to specify
that you want to run the loader in upload mode. Additionally, replace
the variables with your parameters as follows:

e <user>—The user name of your database account.
e <password>—The password for your database account.

® <connect_string>—The connect string for the database. The
format of the connect string depends on the JDBC driver type.

— For a JDBC OCIS8 driver, the connect string should be the
database name as specified in its TNSNAMES entry, in the
following format:
<database_name>

— For a JDBC THIN driver, the connect string should include
the host name, port number, and database system identifier
(SID) in the following format:
<host_name>:<port_number>:<database_SID>

e <protocol>—The JDBC driver type you want to use to connect
to the database. The JDBC driver type can be either oci8 or thin.

¢ <lang>—The abbreviation for the language of the XML file. This
parameter is case insensitive. Use the standard language
abbreviations for the Oracle database server, such as US for
American or JA for Japanese. For a list of the standard language
abbreviations, see: Locale Data, Oracle National Language Support
Guide.

® <source_rile>—The name and full path of the source file from
which you want to upload definitions.
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CHAPTER

Detining a Workflow
Process

T his chapter tells you how to use Oracle Workflow Builder to
define a workflow process definition.
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Overview of Oracle Workflow Builder

Oracle Workflow Builder is a graphical tool for creating, viewing, and
modifying workflow process definitions. It contains a Navigator
window that you use to define the activities and components of your
business process. You then assemble the activities in a process window
to create a process diagram. See: Creating Process Definitions in Oracle
Workflow Builder: page 3 -7.

Note: A workflow process definition can also be stored as a
flat file, which can be opened and edited in a text editor so that
the process definition can be spoken by a screen reader for
greater user accessibility.

Ed O1acle WorkHow Builder 2.6

Ed Havigator i =] 9 Document Review

Document M anagemsnt
@ Attributes

L
-[@, Standard
i Directon Service

By
pprove > Iersy -

Document Approved End [Approve]

Review Document

Reject - -
» >

Document Rejected End [Reject]

Note: If you maximize the Navigator window or any process
window in Oracle Workflow Builder, you will not be able to
access the menu from your keyboard using the Alt key.
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The Navigator Tree Structure

The Navigator window displays a navigator tree hierarchy for each
data store that you open or load into Oracle Workflow Builder. A data
store (primary branch) is a database connection or flat file that holds
your workflow process definition. Within each data store there is at
least one item type heading (secondary branch) that represents the
grouping of a particular set of processes and its component objects.
The following six tertiary branches appear beneath each item type
branch:

Attributes—lists the attributes for the current item type. Item
type attributes describe features of an item type. For example, if
an item type is a purchase order requisition, then an item type
attribute can be the requisition amount or the requisition ID.
See: Item Type Attributes: page 4 — 2.

Processes—lists the process activities or workflow process
definitions for the current item type. See: Process Window: page
5 -2 and Activities: page 4 — 42.

Notifications—lists the notification activities associated with the
current item type. A notification activity sends a message to a
user or role. The message may prompt for a response or may
simply provide information. See: Activities: page 4 — 42.

Functions—lists the function activities associated with the
current item type. A function activity represents a PL/SQL
stored procedure that the Workflow Engine executes
automatically. A function activity can also have activity
attributes associated with it. See: Activities: page 4 — 42.

Events—Iists the event activities associated with the current item
type. An event activity represents a business event that the
process receives, raises, or sends. See: Activities: page 4 —42.

Messages—Ilists the messages that a notification activity
associated with the current item type can send to a user or role.
A message can have message attributes associated with it. See:
Messages: page 4 —23.

Lookup Types—Ilists the lookup types associated with the
current item type. A lookup type has one or more values called
lookup codes associated with it. A lookup type is a list of values
that can be referenced by a message, or by a notification,
function, or process as its possible result type. See: Lookup
Types: page 4-19.
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Note: Each data store also contains a Directory Service branch.
The Directory Service branch lists all the directory service roles
that you load from your Oracle Workflow database. See: Roles:
page 5 —24.

If the data store is a database connection and the database contains
other item types that you have not loaded into Oracle Workflow
Builder, a branch called Hidden Item Types appears. When you
double—click on Hidden Item Types, you get a Show Item Types
window that lets you load other item types into Oracle Workflow
Builder.

Viewing the Navigator Tree

The navigator tree is organized much like the hierarchy of a file system,
where you can expand branches that begin with a plus sign (+) to
further sub-branches until you find your component of interest.
Sub-branches appear indented below the branches from which they are
expanded. Branches that are expanded are preceded by a minus sign
(-). You can expand no further when a branch displays neither a plus
nor minus sign. You can use either your mouse or the arrow keys on
your keyboard to expand or collapse the navigator tree.

The Navigator window also contains a toolbar that you can use to
perform actions within the Navigator window. See: Navigator Toolbar:
page A-7.
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Choose Find... from the Edit menu to display a Search window that
lets you specify search criteria to find an object in the navigator
tree.

Enter the text to search for in the Search Text field. The search is
case insensitive and looks for the text pattern that you specify in
the field that you specify.

Specify to search for this text in the object’s Display Name or
Internal Name.

Specify the object type to restrict this search to or check All Objects
to search for the text within the property pages of all objects.

Choose Search.

You can choose Find Again from the Edit menu to repeat the search
using the search criteria previously defined in the Search window.



Creating Process Definitions in Oracle Workflow Builder

Before using Oracle Workflow Builder, you should plan what your
process needs to accomplish. In particular, determine what activities
need to occur, the order of the activities, what results dictate the
different branches of the process, who needs to be informed and what
they need to know. Oracle Workflow provides several demonstration
workflow examples. See: Sample Workflow Processes: page 15 - 2.

There are several ways you can go about creating a workflow process
definition:

e Top-Down Design—If you prefer to approach your design from
a high level, you can first sketching out the process diagram with
activities, then go back later to create the supporting objects for
each activity. See: To Create a Process Definition from
Top-Down: page 3 - 10.

e Bottom-Up Design—If you prefer to take a more programmatic
approach to your design, you can first define each of the
supporting objects of your process before attempting to create a
higher level process diagram. See: To Create a Process Definition
From Bottom-Up: page 3 - 8.

Quick Start Wizard

The Quick Start Wizard helps you build a process definition from
scratch using a process definition template. The Quick Start Wizard
creates a new item type for your process, prompting you for the
minimum required information. It then creates an outline process
diagram from which you can flesh out with more activities. Once the
Quick Start Wizard sets up the template, you can use either the
top—down or bottom-up approach to complete the design. See: To Use
the Quick Start Wizard: page 3 - 18.

Versioning and Dates of Effectivity

Oracle Workflow Builder assigns a version number to each new activity
that you create. It also updates the version number whenever you
make changes to an existing activity. It saves the new version of the
activity to the database without overwriting older versions of the
activity. In Oracle Workflow, activities also have dates of effectivity so
that at any point in time, only one version of the activity is ”in effect”.
If a process is running, Oracle Workflow uses the version of the activity
that was in effect when the process was initiated. It does not switch
versions of the activity mid-way through the process. Note that a
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process itself is an activity, so a process definition always remains
constant until the process instance completes.

Oracle Workflow Builder also supports the concept of saving and
loading process definitions according to an effective date. For example,
you can load a definition into Oracle Workflow Builder that was
effective at an earlier point in time. You can also save a definition to
the database to be effective at some future time.

Note that Oracle Workflow Builder does not maintain version
information for objects that are considered constant, such as item types,
item type attributes, messages and lookup types. For these objects,
their latest definition always apply, so you should always consider
whether a change to any of these objects is backwards compatible. If
the modification affects existing processes, you should create a new
object rather than edit the existing object.

Modifying Objects in Oracle Workflow Builder: page 4 — 68

Using the Edit Button in a Property Page

To create an object in Oracle Workflow Builder, you enter information
in the object’s property page. Some of the information you provide can
be selected from a list of values. If a poplist field yields values that are
themselves defined from some other property pages in Oracle
Workflow Builder, an Edit button appears to the right of that poplist.
When you select a value from a poplist, you can choose the adjacent
Edit button to display and edit the source property page(s) of the value.
When you are done with the source property page(s) and choose OK or
Cancel, you return to the original property page you were working on.

For example, if you create a notification activity, you must specify a
Result Type for the activity. The Result Type poplist field lets you select
the value <None> or some predefined lookup type. If you select a
lookup type, you can then choose the adjacent Edit button to display
the property page for that lookup type. When you finish viewing or
editing the property page for that lookup type, you can choose OK or
Cancel to return to the notification activity property page.

To Create a Process Definition From Bottom Up

1. To start Oracle Workflow Builder, double—click on the Oracle
Workflow Builder icon located in the Application Development
folder within the Oracle — <SID NAME> program group. If you are



using Windows 95 or NT 4.0 or higher, you can also select the
Oracle Workflow Builder icon from the appropriate program folder
of the Start menu.

2. Choose New from the File menu to create a workspace for your
new process definition.

to first create the framework for your new process definition.
Once the Quick Start Wizard creates your new item type and
new process activity, you can skip to step 4 below to begin
defining the supporting objects for the new item type and
process activity. See: To Use the Quick Start Wizard: page
3-18.

@ Suggestion: Alternatively, you can use the Quick Start Wizard

3. Create a new item type. The item type classifies the work item to
be managed by the process. See: To Create an Item Type: page
4-7.

4. You can define item type attributes to fully describe your item type
and have the activities in your process refer to these attributes for
information. See: To Define an Item Type or Activity Attribute:
page 4 -8.

5. Create new lookup types. See: To Create Lookup Types: page
4-20.

Before defining an activity, you should define the lookup type that
represents your activity’s Result Type. A Result Type is a list of
possible results that an activity can have upon completion. After
defining a lookup type and an activity, you can drag the lookup
onto an activity in the navigator tree to assign that lookup as the
activity’s result type. Lookup types can also be referenced by item
type attributes, activity attributes, messages, or message attributes.

6. Create new messages. See: To Create a Message: page 4 — 29.

If you wish to create a notification activity for your process, you
should first create the message that you want the notification
activity to send. You can drag a new message onto a notification
activity in the navigator tree to assign the message to that activity.

You can also create message attributes for the message. You can
incorporate message attributes of type ‘Send’ into a message that
are token substituted at runtime to provide dynamic content. You
can also define message attributes of type ‘Respond” to prompt the
notification recipient for a response. See: To Define a Message
Attribute: page 4 — 34.
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10.

Create a new process activity, notification activity, function
activity, or event activity. You may also use predefined standard
activities associated with the Standard item type. See: Activities:
page 4 — 42 and Standard Activities: 6 — 2.

You need to define at least one process activity that represents your
high level process diagram. The process diagram establishes the
relationship of all the activities in your process.

Diagram the process.

Display the Process window for your process activity to diagram
the activities and transitions that define your workflow process.
You can drag activities from the navigator tree into the Process
window. See: Diagramming a Process: page 5 - 5.

Save your work by choosing Save or Save As from the File menu.
See: To Save Your Work: page 3 - 15.

In a database accessible by your Oracle Workflow server, create the
PL/SQL stored procedures called by your PL/SQL function
activities. You can do this through SQL*PLUS or the Oracle
Procedure Builder. See: Workflow APIs: page 8 — 3 and Standard
API for PL/SQL Procedures Called by Function Activities: page
7-3.

To Modify a Process Definition: page 3 — 11

Deleting Objects in Oracle Workflow Builder: page 4 — 67

Modifying Objects in Oracle Workflow Builder: page 4 — 68

Item Type Definition Web Page: page 3 — 24

To Create a Process Definition from Top Down

1.

To start Oracle Workflow Builder, double—click on the Oracle
Workflow Builder icon located in the Application Development
folder within the Oracle — <SID NAME> program group. If you are
using Windows 95 or NT 4.0 or higher, you can also select the
Oracle Workflow Builder icon from the appropriate program folder
of the Start menu.

Use the Quick Start Wizard to create the framework for your new
process definition. Specify the requested information for the new
item type and new process activity. See: To Use the Quick Start
Wizard: page 3 - 18.
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A Process window appears, that shows a Start and an End activity

node. Create your process diagram by defining new activity nodes
to place between the Start and End nodes. See: To Define Nodes in
a Process: page 5 - 8.

You may also use predefined standard activities associated with the
Standard item type. See: Standard Activities: 6 — 2.

Model your process by drawing transitions between your activities.
See: Diagramming a Process: page 5 - 5.

Save your work by choosing Save or Save As from the File menu.
See: To Save Your Work: page 3 - 15.

= Attention: When you save your work, Oracle Workflow

automatically validates the process definition for any invalid or
missing information and displays what it finds in a Workflow
Error verification window. The Workflow Error window is
non-modal, so you can keep it up on your screen while you go
back to your process to correct the problems that are identified.
You can also save your work as is, and fix the problems later.
Use the Copy button to copy the information to the clipboard if
you want to paste it into another document for later reference.
If you save your work without correcting the problems, the
Workflow Error window will appear when you open this
process definition later.

To Modify a Process Definition: page 3 - 11

Deleting Objects in Oracle Workflow Builder: page 4 — 67

Modifying Objects in Oracle Workflow Builder: page 4 — 68

Item Type Definition Web Page: page 3 — 24

» To Modify a Process Definition

1.

To start Oracle Workflow Builder, double—click on the Oracle
Workflow Builder icon located in the Application Development
folder within the Oracle — <SID NAME> program group. If you are
using Windows 95 or NT 4.0 or higher, you can also select the
Oracle Workflow Builder icon from the appropriate program folder
of the Start menu.

Choose Open from the File menu to open a connection to the
database or file that contains the process definition you want to
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modify. See: To Access Process Definitions in an Existing Data
Store: page 3 - 13.

3. Select and expand the existing item type associated with the
process definition you want to modify.

4. You can modify an item type, item type attribute, lookup, message,
message attribute, process activity, notification activity, function
activity, or activity attribute. See: To Create an Item Type: page
4 -7, To Define an Item Type or Activity Attribute: page 4 - 8, To
Create Lookup Types: page 4 — 20, To Create a Message: page
4 - 29, To Define a Message Attribute: page 4 — 34, or Activities:
page 4 —42.

5. You can also modify the process diagram by displaying the Process
window for your process activity. See: Diagramming a Process:
page 5 5.

6. Save your work by choosing Save or Save As from the File menu.
See: To Save Your Work: page 3 - 15.

Deleting Objects in Oracle Workflow Builder: page 4 — 67
Modifying Objects in Oracle Workflow Builder: page 4 — 68
Item Type Definition Web Page: page 3 — 24

Opening and Saving Item Types
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All processes are associated with an item type. An item type can
include one or more processes. You can save an item type to a database
or to a flat file. When you save your work to a database, you actually
save everything in the current data store that has been modified. When
you save your work to a flat file, you actually save everything in the
current data store to the file. You can also load an item type into Oracle
Workflow Builder from a database or flat file. Opening an item type
automatically retrieves all the attributes, messages, lookups,
notifications, functions and processes associated with that item type.

= Attention: Always save a copy of your workflow process
definition as a flat file and check that file into a source control
system to maintain a working version of your process
definition. Avoid using the process definition stored in your



database as your source controlled version, as others with
access to the database can update the definition.

Note: To connect from Oracle Workflow Builder to a database,
the language of your Oracle Workflow Builder installation
must match one of the available languages of the Oracle
Workflow Server installation in the database.

» To Access Process Definitions in an Existing Data Store

1. To start Oracle Workflow Builder, double—click on the Oracle
Workflow Builder icon located in the Application Development
folder within the Oracle — <SID NAME> program group. If you are
using Windows 95 or NT 4.0 or higher, you can also select the
Oracle Workflow Builder icon from the appropriate program folder
from the Start menu. In Oracle Workflow Builder, select Open...
from the File menu.

Open |
i* File
Filename ||
Browsze |
" Databaze
Llger I
Pazzward I
LCannect I
Effective I
k. Cancel

2. Select database or file to connect to the source containing the item
type to which your process definition is associated.

3. Toopen a File: Provide the complete file path and choose OK, or
use Browse to locate and open the file (extension .wft).
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Note: You can also drag and drop a .wft file from the
Microsoft Windows 95/98/2000/NT 4.0 Explorer or Microsoft
Windows NT File Manager into the navigator tree to open that
file in Oracle Workflow Builder.

Note: When you use Browse to find and open a file, the
current directory that you open the file from becomes the new
default directory from which you open files in the future. This
default directory persists until you use Browse again to locate
another file.

4. To open a Database connection: Enter the username and password
for the database. Enter the name of the database alias or connect
string and choose OK.

Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications, use the APPS schema to
connect to the database.

5. If you wish to retrieve a process definition that was effective at a
particular point in time, you can specify a date and time in the
Effective field and have Oracle Workflow Builder retrieve that data
from the database. The format that you should use to specify the
date and time depends on the date and time preferences defined in
the Regional Settings of your Windows Control Panel.

Show Item Types E3 |

Wizible Hidden
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6. If multiple item types exist in the data store, the Show Item Types
window appears. Select from the Hidden list, the item type(s) you
want to view, and choose << to move it into the Visible list. Choose
OK to load these item types into the navigator tree.

7. If at any time you want to view and modify item types that are
hidden in the current data store, you can double—click on the
Hidden Item Types branch in the navigator tree to display the
Show Item Types window and select the item types you want to
show. You can also choose Show /Hide Item Types from the File
menu to display the Show Item Types window.

Note: You can copy item types from one store to another in
any order even if the item types reference each other.
However, you may get validation errors due to foreign key
references. Pay attention to these errors as they may indicate
that you need to also copy other item types into the new store
to resolve the foreign key references. The final process
definition in the new store will be valid as long as all
referenced item types are copied to the new destination store.

8.  When you finish working, choose Save from the File menu to
preserve your changes and make them effective immediately. See:
To Save Your Work: page 3 — 15.

See Also

To Start Oracle Workflow Builder from the MS-DOS Prompt: page
3-17

» To Save Your Work

1. Choose Save from the File menu to save your work and make the
changes immediately effective.

When you use the Save command, you save all modified objects in
the currently selected data store (even those that are hidden) back
to that data store. If you want to save only specific item types, then
you must create a new data store, and copy the specific item types
you want to save into the new store and save the new store.

= Attention: Oracle Workflow Builder can save your work to
the database using one of two modes. In the ”About Oracle
Workflow Builder” dialog box from the Help menu, there is a
check box called ”Allow modifications of customized objects”.
If you check this check box, Oracle Workflow Builder saves
your edits in ‘upload’ mode, overwriting any protected objects
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that you have access to modify, as well as any previously
customized objects. If you uncheck this check box, Oracle
Workflow Builder runs in ‘upgrade’ mode and will only save
edits to protected objects that you have access to change and
will not overwrite objects that have been previously
customized. These two modes match the upgrade and upload
behavior of the Workflow Definitions Loader program. As the
default, the check box is unchecked. See: To Set the Access
Level for an Object: page 4 — 18 and Using the Workflow
Definitions Loader: page 2 - 110.

Save As |

% File

Filename ||

Browse |

" Database

Lzer I

Pazzwaord I

LConnect I

Effective I

| k. I Cancel

2. If you want to save your work to a different data store (database or
flat file), or if you want to save it to a database with an effective
date other than the current system date, then choose Save As...
from the File menu. Use the Save As window to specify the file or
database you want to save your process definition to, and the date
when you want your process definition to take effect in the
database. You can leave the Effective field blank to save and make
the changes effective immediately. See: Version/Effective Date:
page 8 —11.

Note: If you save your work to a database with a future
effective date, and then in the same Oracle Workflow Builder
session, continue to modify your process and later choose Save
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from the File menu, you automatically save the process
definition to the same database using the previously specified
effective date.

3. Note that when you save your work, Oracle Workflow
automatically validates the process definition for any invalid or
missing information and displays what it finds in a Workflow Error
verification window. You can either correct the information before
saving your work, or go ahead and save your work as is, and fix
the problems later. Use the Copy button to copy the information
from the Workflow Error window to the clipboard for later
reference. If you save your work without correcting the problems,
the Workflow Error window will reappear when you reopen your
process definition.

4. Choose Close Store from the File menu to close your connection to
the current database or file data store.

5. Choose Exit from the File menu to exit Oracle Workflow Builder.

= Attention: The Close Store and Exit options from the File
menu are enabled only when the Navigator window is the
current window.

» To Start Oracle Workflow Builder from the MS-DOS Prompt:

Rather than starting Oracle Workflow Builder by double—clicking on its
Windows icon, you can also type in a command at the MS-DOS
prompt and specify the file or database to connect to.

1. Inan MS-DOS prompt window, type the following command to
start Oracle Workflow Builder with a specific workflow data file,
where <filename.wft> represents the full path and name of the
data file:

wfbldr <filename.wft>

2. To start Oracle Workflow Builder with a specific database
connection, type the following command at the MS-DOS prompt,
where <username/password@connect> represents the database
account information to connect to:

wfbldr -c¢ <username/password@connect>

Note: If you run Oracle Workflow Builder in Microsoft
Windows 95 or Windows NT 4.0 or higher, you can also
double—click on a workflow data file (.wft) from the Windows
Explorer to automatically open that file and start Oracle
Workflow Builder.
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Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications, use the APPS schema to
connect to the database.

3. To start Oracle Workflow Builder and open a specified item type in
a data store, append the following to the appropriate command
shown in Step 1 or 2, where <item type> represents the internal
name of the item type you want to open:

-E <item_ type>
For example:
wfbldr wfdemo.wft -E wfdemo

4. o start Oracle Workflow Builder and open a specified process
diagram in a data store, append the following to the appropriate
command shown in Step 1 or 2, where <item type:process>
represents the internal names of the item type and process you
want to open:

-E <item type:process>
For example:

wfbldr wfdemo.wft -E WFDEMO:NOTIFYAPPROVER

Using the Workflow Definitions Loader: page 2 — 110
Creating a Shortcut to a Workflow Process: page 5 — 22

Quick Start Wizard Overview
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The Quick Start Wizard lets you begin designing a workflow process
immediately. It first loads a file called wftemplate.wft that is an outline
of all the mandatory objects you need to build a workflow process and
then displays a Process window for you to diagram your process.
Once you initiate the Quick Start Wizard, you can take the bottom—up
or top—down approach to complete your workflow process definition.

To Use the Quick Start Wizard
1. Select Quick Start Wizard from the File menu.



Workflow Quick Stant Wizard |
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2. The Workflow Quick Start Wizard window prompts you for the
following mandatory information:

e New Item Type

— Internal Name—Specify an all uppercase internal name with
a maximum of eight characters. All Oracle Workflow APIs,
SQL scripts, and PL/SQL procedures refer to the internal
name when identifying an item type.

= Attention: To update the internal name of an item type once it
is defined, you must use a special SQL script called wfchitt.sql.
See: Wfchitt.sql: page 16 — 8.

7.

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

— Display Name—Enter a translatable Display Name for the
item type.

— Persistence Type—Specify Temporary or Permanent
persistence for the status audit trail of the item type.

— Days—If Persistence Type is Temporary, specify the number
of days from the time an item type instance completes
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before its status audit trail can be purged. See: Persistence
Type: page 4 - 4.

New Process
— Internal Name—Specify an all uppercase internal name.

Attention: To update the internal name of an activity once it is
defined, you must use a special SQL script called wfchact.sql.
See: Wfchact.sql: page 16 - 7.

VR4

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

— Display Name—Enter a translatable Display Name for the
process activity. The Display Name also appears in the title
bar of your Process window.

3. The Quick Start Wizard does the following;:

Creates a new data store called “Untitled—n" in the Navigator
window.

Uses the information you entered in the Workflow Quick Start
Wizard window to create a new item type and process activity in
the data store.

Loads the Standard item type into the new data store so that you
can include standard activities in the process you create.

Opens the Process window for the new process activity you
defined. The Process window displays a Start and an End
activity.

4. You can now customize your process definition in one of two ways:

Take a bottom—up design approach by first creating activities and
all their supporting objects before trying to draw a workflow
diagram. See: To Create a Process Definition From Bottom-Up:
page 3 - 8.

Take a top—-down design approach by creating activities that
contain minimum information so you can draw the workflow
diagram first. You can go back later to fill in the details of each
activity and its supporting objects. See: To Create a Process
Definition from Top—Down: page 3 - 10.



Using Oracle Workflow Builder with Different Server Versions

The Oracle Workflow Builder Release 2.6.2 is compatible with all
versions of the Oracle Workflow Server embedded in Oracle
Applications Release 117, as well as with Release 2.6.2, Release 2.6.1,
base Release 2.6, and Release 2.5 of the standalone version of the Oracle
Workflow Server.

* You can create, view, and modify workflow process definitions
that include new features introduced in Release 2.6, such as
Business Event System components and external Java function
activities. The Oracle Workflow Builder can upload and
download these process definitions to a database with Oracle
Workflow Server Release 2.6 installed.

¢ Alternatively, if you do not want to take advantage of the
Release 2.6 features, you can create, view, and modify workflow
processes that include only Release 2.5 features. The Oracle
Workflow Builder can upload and download these process
definitions to a database with Oracle Workflow Server Release
2.5 installed.

= Attention: The Oracle Workflow Builder is the only Release
2.6.2 client component that is compatible with earlier versions
of the Oracle Workflow Server. The Oracle Workflow Mailer
Release 2.6.2 is not compatible with any earlier versions of the
server; it is only certified with the Oracle Workflow Server
Release 2.6.2.

Using the Release 2.6.2 Oracle Workflow Builder with a Release 2.6
Embedded Server or a Release 2.6.2 or Release 2.6.1 Standalone

Server

If you are using the Oracle Workflow Builder with Oracle Workflow
Server Release 2.6 embedded in Oracle Applications, or with the
standalone version of the Oracle Workflow Server Release 2.6.2 or
Release 2.6.1, you can use all currently available features in your
workflow processes. You can save these process definitions to the
database and open process definitions from the database to view or
modify them.

You can also open existing process definitions that were created with
the Release 2.5 Oracle Workflow Builder or with the base Release 2.6
Oracle Workflow Builder and save these process definitions to a
database with Oracle Workflow Server Release 2.6 embedded in Oracle
Applications, or with standalone Oracle Workflow Server Release 2.6.2
or Release 2.6.1.
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Using the Release 2.6.2 Oracle Workflow Builder with a Release 2.6
Standalone Server

If you are using the Oracle Workflow Builder with the base standalone
version of Oracle Workflow Server Release 2.6, you can include most of
the currently available features in your workflow processes. However,
you must not use the Event Parameter lookup code which is now
available in the Event Property lookup type, because this feature was
added in the version of Release 2.6 embedded in Oracle Applications.
Do not use the Event Parameter lookup code in any custom activities,
and do not select the Event Parameter property in any of the following
standard Workflow activities:

¢ Get Event Property
¢ Set Event Property
e Compare Event Property

You can open existing process definitions that were created with the
base Release 2.6 Oracle Workflow Builder, view or modify these
process definitions using only the base Release 2.6 components, and
save the definitions to a database with base standalone Oracle
Workflow Server Release 2.6.

You can also create new workflow processes using only base Release
2.6 components. However, the version of the Standard item type used
by the Oracle Workflow Builder Release 2.6.2 contains some later
Release 2.6 components. If you want to save a new process definition to
a database with base standalone Oracle Workflow Server Release 2.6,
perform the following steps:

1. Create a new workflow process definition.
2. Force delete the Standard item type from your data store.

3. Force save the process definition to the database with base
standalone Oracle Workflow Server Release 2.6.

4. Reopen the process definition from the database. The process
definition now includes the base Release 2.6 version of the
Standard item type.

5. Continue defining your workflow process using only base Release
2.6 components.



Using the Release 2.6.2 Oracle Workflow Builder with a Release 2.5
Standalone or Embedded Server

If you are using the Oracle Workflow Builder with either the standalone
or the embedded version of Oracle Workflow Server Release 2.5, you
must include only Release 2.5 features in your workflow processes. You
must not use any of the following new features introduced in Release
2.6:

e Event activities
e Item attributes of type Event
e External Java function activities

You can open existing process definitions that were created with the
Release 2.5 Oracle Workflow Builder, view or modify these process
definitions using only Release 2.5 components, and save the definitions
to a database with Oracle Workflow Server Release 2.5.

You can also create new workflow processes using only Release 2.5
components. However, the version of the Standard item type used by
the Oracle Workflow Builder Release 2.6.2 contains some Release 2.6
components. If you want to save a new process definition to a database
with Oracle Workflow Server Release 2.5, perform the following steps:

1. Create your workflow process definition.
2. Force delete the Standard item type from your data store.

3. Force save the process definition to the database with Oracle
Workflow Server Release 2.5.

4. Reopen the process definition from the database. The process
definition now includes the Release 2.5 version of the Standard
item type.
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The Web-based Item Type Definition page provides you with
distributed access to workflow definitions stored in your Oracle
Workflow database. The page provides a detailed view of the
attributes, processes, notifications, functions, events, messages, and
lookup types that are associated with a given item type, allowing you
to present or do a design review of your workflow process.

To display an item type definition, you use the Find Item Type web
page to first query for an item type. You can query for an item type
based on an effective date and time.

The Item Type Definition page then appears. The information is
displayed in two frames, modeled like the Oracle Workflow Builder, so
that you can review the contents easily and effectively. The left frame
lists all the objects in your item type definition in an expandable
navigator tree. The right frame displays the details of the object you
select in the navigator tree. You can also select either frame at any time
and use your web browser to print all the information in that frame.

To Query an Item Type

1. Enter the following URL in your web browser:
<webagent>/wf_item_definition.find_item_ type

Replace <webagent> with the base URL of the web agent
configured for Oracle Workflow in your Web server. See: Setting
Global User Preferences: page 2 - 14.

= Attention: This URL accesses a secured page, so if you have
not yet logged on as valid user in the current web session, you
will be prompted to do so before the page appears.

Note: You can also access the Find Item Type web page from
the Oracle Workflow home page. See: Accessing the Oracle
Workflow Home Page: page 9 — 2.
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2. Use the Item Type poplist field to select an item type.

3. Specify the effective date and time of the item type definition you
want to display using the format specified in the Date Format field
of your User Preferences web page. See: Setting User Preferences:
page 9 - 6.

4. Choose Find to display the item type in the Item Type Definition
web page.

Defining a Workflow Process ~ 3-25




3-26

Oracle Workflow Guide

em Type Definition - Metscape
Ele Edit “iew Go Communicator Help

< v

A 4 e W o &

&

Document Fesponse - Approve
Message Attributes
Eesponse Document

Custormzation Level O

Protection Level

Back Fopward  FReload Home Search  Metscape Print. Securty Stop
( ﬁ Item Type Definition % u ? ORACLE
TDiseme® Wmrrmmet = Attribute Mame Send Document =
Attributes Internal Mame SEND_DOC
Send Decument Description Document sent for review J
M Attribute Type Document
W Defal Valus
Eesponse Document Customization Level 0
Processes Protection Level 1000
Document Eeview
Notifications Attribute Mame Document Ovmer
Sl Tnternal Mame DOC_OWNER_ROLE
Document Rejected )
[ e— Description Owmer of the document sent for review
Functions Attribute Type Role
Messages Default Value BLEWIS

1000

Document Crwner
Document Rewiewer
Comments
Send Document
Drocument Eesponse - Rejectec
Message Attributes
Document Crwner
Send Document
Comments

Attribute MName
Internal Name
Description
Attribute Type
Drefault Vatue

Custemization Level 0

Protection Level

Document Reviewer
DOC_REVIEW _ROLE
Document reviewer role
Role

1000

: Darumers Reviewrer _ILI
a4 L3

[ == | Document: Done

To Review an Item Type Definition

1. The Item Type Definition web page displays two frames. The

frame on the left lists the components of an item type definition in
hierarchical format similar to the navigator tree in Oracle Workflow
Builder. The frame on the right lists the details of each component.

2. Click on any component link in the left hand frame to display the
details of that component in the right hand frame.



CHAPTER

Detining Workflow
Process Components

T his chapter tells you how to use Oracle Workflow Builder to
define the components necessary to compose a workflow process
diagram.
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Depending on the workflow process you wish to create, you need to
define all or some of the following types of components to make up the
process:

e Item Types

¢ Lookup Types
e Messages

e Activities

o Attributes

e Roles

An item type is a classification of the components that make up a
workflow process. You must associate any component that you create
for a process, such as a function activity or a message, with a particular
item type. Often it makes sense to define an item type so that it
describes the item being managed by your workflow process. For
example, purchase order requisition can be an item type while a
purchase order requisition identified by a particular ID number is an
item of that item type. See: To Create an Item Type: page 4 - 7.

Item Type Attributes

An item type attribute is a property associated with a given item type.
It acts as a global variable that can be referenced or updated by any
activity within a process. An item type attribute often provides
information about an item that is necessary for the workflow process to
complete. For example, the "Workflow Demonstration” item type has
an item type attribute called “Requisition Amount.” An activity in our
example Requisition Approval process requires the value of this item
type attribute to determine if a selected approver has the authority to
approve a requisition of that amount.

Applications as well as function activities can reference and set item
type attributes using the Oracle Workflow Engine APIs. You can define
and maintain as many item type attributes as necessary for an item
type. You should define as an item type attribute, any information that
will be required by an activity in your process, or any information that
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will need to be sent in a notification message. See: To Define a Message
Attribute: page 4 — 34.

Item Attributes: page C -3

Attribute Types

There are ten attribute types, as shown below. The type determines
what values are acceptable and how the attribute is used.

Text—The attribute value is a string of text.

Number—The attribute value is a number with the optional
format mask you specify.

Date—The attribute value is a date with the optional format
mask you specify.

Lookup—The attribute value is one of the lookup code values in
a specified lookup type.

Form—The attribute value is an Oracle Applications internal
form function name and its optional form function parameters.
This attribute type is not relevant for the standalone version of
Oracle Workflow.

If you include a form-type attribute in a notification message as
a message attribute, the notification, when viewed from the
Notification Details web page, displays an attached form icon
that lets users drill down to the referenced form. See: Overview
of Menus and Function Security, Oracle Applications Developer’s
Guide.

URL—The attribute value is a Universal Resource Locator (URL)
to a network location. If you reference a URL attribute in a
notification message as a message attribute, the notification,
when viewed from the Notification Details web page or as an
HTML-formatted e-mail, displays an anchor to the URL
specified by the URL attribute. The user can complete an
activity or see additional information related to the activity by
accessing that URL.

Document—The attribute value is an attached document. You

can specify the following types of documents in the default value
field:
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— PL/SQL document—a document representing data from the
database as a character string, generated from a PL/SQL
procedure.

— PL/SQL CLOB document—a document representing data
from the database as a character large object (CLOB),
generated from a PL/SQL procedure.

— DM document—a document managed by an external
document management system. (This functionality will be
supported in a future release.)

See: To Define a Document Attribute: page 4 — 14.

o Role—The attribute value is the internal name of a role. If a
message attribute of type role is included in a notification
message, the attribute automatically resolves to the role’s display
name, eliminating the need for you to maintain separate
attributes for the role’s internal and display names. Also when
you view the notification from a web browser, the role display
name is a hypertext link to the e-mail address for that role. To
set a default value for the attribute, you must initially load roles
from the database. See: Roles: page 5 —24.

o Attribute—The attribute value is the internal name of another
existing item type attribute that you want to maintain references
to in a process.

¢ Event—The attribute value is a Business Event System event
message in the standard WF_EVENT_T structure. See: Event
Message Structure: page 8 —242.

Note: If you store an event message in an item attribute of
type event, you can access the event data within that event
message by creating an item attribute of type URL and setting
the value of the URL attribute to reference the event data. See:
SetltemAttribute: page 8 —48.

Persistence Type

When you define an item type, you must also specify its persistence
type. The persistence type controls how long a status audit trail is
maintained for each instance of the item type. If you set Persistence to
Permanent, the runtime status information is maintained indefinitely
until you specifically purge the information by calling the procedure
WF_PURGE.TotalPerm( ).

If you set an item type’s Persistence to Temporary, you must also
specify the number of days of persistence ('n’). The status audit trail



for each instance of a Temporary item type is maintained for at least 'n’
days of persistence after its completion date. After the 'n” days of

persistence, you can then use any of the WF_PURGE APIs to purge the
item type’s runtime status information. See: WF_PURGE: page 8 — 111.

If you set an item type’s Persistence to Synchronous, Oracle Workflow
expects instances of that item type to be run as forced synchronous
processes with an item key of #SYNCH. Forced synchronous processes
complete in a single SQL session from start to finish and never insert
into or update any database tables. Since no runtime status information
is maintained, you do not normally need to perform any purging for a
process with the Synchronous persistence type. However, if you run
the process with a unique item key in asynchronous mode for testing or
debugging purposes, Oracle Workflow does maintain runtime status
information for that process instance. You can purge this information
by changing the item type’s Persistence to Temporary and running any
of the WF_PURGE APIs. Then change the item type’s Persistence back
to Synchronous. See: Synchronous, Asynchronous, and Forced
Synchronous Processes: page 8 — 14, WF_PURGE: page 8 — 111, and
Purging for Performance: page C - 8.

Note: If you are using the version of Oracle Workflow
embedded in Oracle Applications, you may also use the Purge
Obsolete Workflow Runtime Data concurrent program to purge
obsolete item type runtime status information. The executable
name for this concurrent program is “Oracle Workflow Purge
Obsolete Data” and its short name is EFNDWFPR. See: Purge
Obsolete Workflow Runtime Data: page 8 — 119.

Item Type Selector Function

If your item type has or will have more than one runnable process
activity associated with it, define a PL/SQL function that determines
which process activity to run in a particular situation. For example,
you may have two different requisition approval process activities
associated with the same item type. The process that Oracle Workflow
executes may vary depending on how and where the requisition
originates. Your selector function would determine which process
would be appropriate in any given situation.

You can also extend the Selector function to be a general callback
function so that item type context information can be reset as needed if
the SQL session is interrupted during the execution of a process. This
is particularly important in the Oracle Applications scenario when you
view a notification from the Notification Details web page and attempt
to launch another form that is associated with the notification. Oracle
Workflow calls the selector/callback function for your item type in
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"TEST_CTX’ mode to test the Oracle Applications context before
turning the form launch over to the Oracle Application Object Library
function security system. In "TEST_CTX’ mode, the selector/callback
function can perform whatever logic necessary to determine whether it
is appropriate to launch the form. See: Standard API for an Item Type
Selector or Callback Function: page 7 - 13.

External Document Integration

Documents have an enormous impact in the operations of an
organization. With the explosion of digital media and the worldwide
web, electronic documents of a wide variety of formats, including
non-printed media, are forcing organizations to address the
management of these documents. The value of information in these
documents can be maintained only if the documents can be managed
and shared.

In a workflow process, you can attach documents generated by a
PL/SQL procedure, which we call PL/SQL or PL/SQL CLOB
documents. In a future release, you will also be able to attach
documents stored in a document management system, which we call
DM documents. You attach a document to a workflow process by
referencing the document in a predefined item attribute or message
attribute of type Document. See: Attribute Types: page 4 - 3, To
Define an Item Type or Activity Attribute: page 4 — 8 and To Define a
Message Attribute: page 4 — 34.

For PL/SQL documents and PL/SQL CLOB documents, the item or
message attribute’s value would be the name of the PL/SQL package
and procedure used to generate the document. The PL/SQL procedure
must follow an Oracle Workflow standard interface. The document
generated by the PL/SQL procedure is simply displayed within the text
of a notification. See: Standard APIs for “PL/SQL” and “PL/SQL
CLOB” Documents: page 7 —17.



» To Create an Item Type

Mavigator Control Properties E

4 Roles | .t’-‘n.ccessl

Internal Mame I

Dizplay Mame I
Diescription ;I

Persigtence ITemporary ﬂ

Mumber of Dayz IU

Selector I

QK I Cancel | ol | Help |

1. If you do not already have a data store open, select New from the
File menu to create a new data store to define this new item type.
Then define a new item type in the navigator tree by choosing New
Item Type from the Edit menu. An Item Type property page
appears.

2. Every item type has an all-uppercase internal name, which is a
maximum of eight characters long. All Oracle Workflow APIs, SQL
scripts, and PL/SQL procedures refer to the internal name when
identifying an item type.

Attention: To update the internal name for an item type once

ISy it is defined, you must use a special SQL script called
wichitt.sql. You should only use this script to correct errors in
an item type’s internal name during design time. Do not use
this script to rename item types that are involved in running
instances of processes. See: Wfchitt.sql: page 16 - 8.

7.

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

3. Enter a translatable Display Name that is longer and more
descriptive. You can also supply a description for the item type.

4. Specify a persistence type of Temporary or Permanent. If you set
the persistence type to Temporary, then specify the number of days
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from the time the item instance completes before its status audit
trail can be purged. See: Persistence Type: page 4 — 4.

5. If your item type has or will have more than one workflow process
associated with it, you may specify a selector function using the
syntax <package_name> . <procedure_name>. The selector
function is a PL/SQL stored procedure that automatically identifies
the specific process definition the Workflow Engine should execute
when a workflow is initiated for this item type. You can also
extend the selector function to be a general callback function that
resets context information each time the Workflow Engine
establishes a new database session to execute activities. See:
Standard API for an Item Type Selector or Callback Function: page
7-13.

6. Choose Apply to save your changes.

7. Select the Roles tab page to specify the roles that have access to this
item type. (This functionality will be supported in a future release.)

8. Select the Access tab page to set the access and customization
levels for this item type. See: Allowing Access to an Object: page
4-17.

9. Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

10. A secondary branch appears in the navigator tree that represents
the item type you just created. You can review or edit the
properties of this item type at any time by double—clicking on the
item type in the navigator tree or by selecting the item type and
choosing Properties from the Edit menu.

11. Define as many item type attributes as necessary to use as global
variables in your process. You use these item type attributes to
pass values to and from your function, notification, and event
activities. See: To Define an Item Type or Activity Attribute: page
4-8.

See Also
Using the Edit Button in a Property Page: page 3 — 8

» To Define an Item Type or Activity Attribute

1. To create an item type attribute, select an item type in the navigator
tree, then choose New Attribute from the Edit menu.
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Mavwigator Control Properties

Access I

Itern Type IDDcument Management

Internal Narne I

Dizplay Mame I

Dezcription I

Tupe IText j

Length |

Drefault

Type |Canstant =]

WValue I

a. I Cancel | Soply | Help |

To create an activity attribute, select an activity in the navigator
tree and choose New Attribute from the Edit menu.

Mavigator Control Properties [ x|

Function IDn-:e Orily

Intemnal Mame I

Dizplay Mame I

Description I

Tupe ITe:-tt j

Length |

Drefauilt

Type |Constant =l

Yalue I

(] 4 I Cancel | Appl Help

An Attribute property page appears in both cases.

2. Provide an Internal Name in all uppercase with no leading/trailing
spaces. All Oracle Workflow APIs, SQL scripts, and PL/SQL
procedures refer to the internal name when identifying an attribute.
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Attention: To update the internal name for an attribute once it
is defined, you must use special SQL scripts called wfchita.sql
and wfchacta.sql. You should only use these scripts to correct
errors in an attribute’s internal name during design time. Do
not use these scripts to rename attributes that are involved in
running instances of processes. See: Wfchita.sql: page 16 -7
and Wfchacta.sql: page 16 - 7.

R

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

Enter a Display Name. This is the name that appears in the
navigator tree.

Enter an optional description.

Select the data type of the attribute. Form, URL, and document
data types are not relevant if you are defining an activity attribute.

Depending on the data type of your attribute, provide the
following default value information:

Text—Specify the maximum length of the text attribute and an
optional default text string.

Number—Optionally provide a format mask for your number
and a default value.

Date—Optionally supply a format mask for the date and a
default value.

Lookup—Choose a predefined Lookup Type from which to
draw values. Choose a lookup code from that lookup type for
the default value.

URL—Specify an optional Universal Resource Locator (URL) to
a network location in the Default Value field and specify the
frame target for the URL. See: To Define a URL Attribute: page
4-12.

Note: The Frame Target field is applicable only for message
attributes of type URL. It is not used for item type attributes or
activity attributes.

Form—This attribute is relevant only for the version of Oracle
Workflow embedded in Oracle Applications.

Specify an optional developer form function name and optional
argument strings (form function parameters) in the Default Value
field. See: Overview of Menus and Function Security, Oracle
Applications Developer’s Guide and To Define a Form Attribute:
page 4-13.



¢ Document—Enter an optional string that identifies the
document in the default value field. See: To Define a Document
Attribute: page 4 — 14.

Note: The Frame Target field is applicable only for message
attributes of type DM Document, to be supported in a future
release. Itis not used for item type attributes or activity
attributes.

e Role—Specify a role name. See: Roles: page 5 — 24.

e Attribute—Specify the name of an item type attribute that you
want to maintain references to in a process by choosing from the
list of existing item type attributes.

e Event—If you are defining an item type attribute, you cannot
specify any default value for an event attribute. If you are
defining an activity attribute, you can only specify an event item
type attribute as the default value.

7. For item type attributes, the optional default value is a constant
that you enter or select from a list of values. The constant,
however, may be a text string that allows for token substitution at
runtime.

For activity attributes, the optional default value may be a constant
or an item type attribute. If you want the default to acquire its
entire value from an item type attribute, choose Item Attribute in
the Default Value region, then use the adjacent poplist field to
choose the item type attribute. The item type attribute you select
must be associated with the same item type that the activity itself is
associated with. The item type attribute you select must also be of
the same data type as the activity attribute.

Note: An activity attribute type of "Text” is compatible with
any item attribute type, but all other activity attribute types
must match the item attribute type exactly.

Note: For attributes of type Lookup, the default value must be
a lookup code belonging to that lookup type.

8. Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

9. If you are defining an item type attribute, select the Access tab page
to set the access levels allowed to modify this attribute. Activity
attributes assume the access/protection level of their parent
activity. See: Allowing Access to an Object: page 4 —17.

10. Choose Apply to save your changes.
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11. Any item type attribute you create appears beneath the Attributes

branch in the navigator tree. Any function activity attribute you
define appears beneath the activity you defined it for in the
navigator tree. You can review or edit the properties of an attribute
at any time by double—clicking on the attribute in the navigator tree
or by selecting the attribute and choosing Properties from the Edit
menu.

= Attention: The order that you list these attributes in the

navigator tree correlate to the order in which they appear in
any list of values that draw upon these attributes. You can use
the drag and drop feature of the navigator tree to reorder a set
of attributes, or select an attribute and choose Move Attribute
Up or Move Attribute Down from the Edit menu.

Using the Edit Button in a Property Page: page 3 — 8

p To Define a URL Attribute

Oracle Workflow Guide

1.

Specify a Universal Resource Locator (URL) to a network location
in the Default Value field of the Attribute property page. The URL
can be a constant or a value returned from another item attribute.

You can include argument strings in your URL that are text strings.
Additionally, if you are defining a message attribute of type URL,
you can include argument strings that are token substituted with
other message attributes. The message attributes used for token
substitution can have constant values or can reference the values
returned from item type attributes. See: To Define a Message
Attribute: page 4 — 34 and To Token Substitute an Attribute: page
4-41.

To token substitute other message attributes in an argument string,
specify the message attributes as follows:

-&message_attr-

For example, the following string represents a URL with two
arguments called argl and arg2 that are token substituted with the
runtime value of message attributes msgattri and msgattr2,
respectively:

http://www.oracle.com?argl=-&msgattrl-&arg2=-&msgattr2-

Note: If you are defining a message attribute of type URL, you
can also include a special token in your argument string called



—&#NID- which Oracle Workflow substitutes with the
notification ID of the runtime notification.

If your URL attribute contains an argument string, you must
adhere to the following restrictions:

¢ You cannot token substitute that argument string with another
item attribute of type Document.

* You can token substitute that argument string with another Form
attribute or URL attribute. However, the argument string for the
other attribute is not further token substituted.

If you need to pass a date and time as an argument to a URL, you
should use TO_CHAR to format the string as
YYYY/MM/DD+HH24:MI:SS. Similarly, you need to do the
correlating format translation in the function that the URL calls,
using TO_DATE. This formatting is required because in multibyte
databases, the month portion of the DD-MON-YYYY format could
potentially translate to a value that is not acceptable across a URL.

Choose OK when you are done.

» To Define a Form Attribute

1.

Specify a developer form function name and any optional
argument string (form function parameters) in the Default Value
field of the form Attribute property page.

The default value must be entered using the following format:

function_name:argl=valuel arg2=value2 ...argN=valueN

” o

The value of argN can be a text string, enclosed in quotes (” ”) or
can be token substituted with another item type attribute in any of
the following ways, where &item_attr represents the internal
name of the item type attribute:

® argN="&item attr”
® argN="Value &item attr”
See: To Token Substitute an Attribute: page 4 — 41.

Note: If you are defining a message attribute of type Form,
you can also include a special token in your argument string
called &#NID which Oracle Workflow substitutes with the
notification ID of the runtime notification.

If your form attribute contains an argument string, you must
adhere to the following restrictions:
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¢ You cannot token substitute the value of argN with another item
attribute of type Document.

¢ You can token substitute the value of that argument string with
another Form attribute or URL attribute, however, the argument
string for the other attribute is not further token substituted.

4. Choose OK when you are done.

» To Define a Document Attribute

Oracle Workflow Guide

1.

Enter a string that identifies the document in the default value field
of the Attribute property page.

You can identify the following types of document for a document
attribute:

e A PL/SQL document
e A PL/SQL CLOB document

¢ An external document stored in a Document Management
repository (This functionality will be supported in a future
release.)

A PL/SQL document represents data from the database as a
character string, generated from a PL/SQL procedure. Specify the
default value of a PL/SQL document as

plsqgl: <procedure>/<document_identifier>.

Replace <procedure> with the PL/SQL package and procedure
name, separated by a period. Replace <document_identifier>
with the PL/SQL argument string that you want to pass directly to
the procedure. The argument string should identify the document.

Note: The PL/SQL procedure must follow a standard API
format. See: Standard APIs for “"PL/SQL” and "PL/SQL
CLOB” Documents: page 7 - 17.

For example, the following string represents the PL/SQL
document, po_req:2034, generated by the procedure
po_wf.show_req.

plsgl:po_wf.show_reqg/po_req:2034

Note: The maximum length of the data that a PL/SQL
document can contain is 32 kilobytes. If you expect your
document to exceed 32 Kb, you should use a PL/SQL CLOB
document to hold the data instead.



A PL/SQL CLOB document represents data from the database as a
character large object (CLOB), generated from a PL/SQL
procedure. Specify the default value of a PL/SQL CLOB document
as

plsqglclob: <procedure>/<document_identifier>.

Replace <procedure> with the PL/SQL package and procedure
name, separated by a period. Replace <document_identifier>
with the PL/SQL argument string that you want to pass directly to
the procedure. The argument string should identify the document.

Note: The PL/SQL procedure must follow a standard API
format. See: Standard APIs for “"PL/SQL” and "PL/SQL
CLOB” Documents: page 7 —17.

For example, the following string represents the PL/SQL CLOB
document, po_req:2036, generated by the procedure
po_wf.show_req_clob.

plsglclob:po_wf.show_req clob/po_reqg:2036

PL/SQL CLOB documents do not support further substitution of
message attribute tokens. The contents of the CLOB are printed in
the message body as they are generated by the PL/SQL procedure.

¢ Do not use tokens within the CLOB.

e Ensure that the PL/SQL procedure performs any formatting you
require.

If you wish to generate the document identifier for a PL/SQL or
PL/SQL CLOB document dynamically, you can token substitute
the document identifier with other item type attributes. See: To
Token Substitute an Attribute: page 4 - 41.

For example:

plsgl:po_wf.show_reqg/&item attrl:&item attr2

Note: If you are defining a message attribute of type
Document, you can also include a special token in your
argument string called &#NID which Oracle Workflow
substitutes with the notification ID of the runtime notification.

To specify a document managed by an external document
management system, enter the following in the default value field:

DM: <node_ID>:<document_ID>: [version]

Replace <node_1D> with the node ID of the document management
system, as listed in the Document Management Nodes web page.
Replace <document_1D>with the ID assigned to the document by
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the document management system. You may also optionally
specify the version number of the document, if multiple versions of
the document exist. (This functionality will be supported in a
future release.) See: Defining Document Management Repositories:
page 2 —43.

6. Choose OK when you are done.

» To Copy an Item Type
1. Select the item type to copy in the navigator tree.

2. Drag the item type, holding down your select mouse button, to the
data store or workspace you want to copy it to.

You can also use the Copy and Paste commands in the Edit menu.

3. If you copy this item type back to the same data store, you get
prompted to enter a new internal and display name for the item
type in the Item Type property page. This is because every item
type must have a unique internal and display name. When you are
done, choose OK.

Note that when you copy an item type, you also copy all the
components associated with the item type. Since most components
must also have unique internal and display names, you may get
prompted to update those components’ internal and display names
in their property pages as well.

4. If you copy an item type to a data store where a previous version of
the same item type already exists, you update the existing version
of the item type in that target data store with the changes in the
version of the item type you are copying.

Attention: The order in which you drag two or more item

ISy types to a new store is important. For example, suppose an
item type references objects in the Standard item type. If you
plan to copy that item type and the Standard item type to a
new data store, you should first drag the Standard item type to
the new data store before dragging the other item type over,
otherwise the other item type will have unresolved references
to the Standard item type.

» To Copy an Attribute

1. Select the attribute to copy in the navigator tree.

2. Drag the attribute, holding down your select mouse button, to the
component branch you want to copy it to.
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3. If you copy an attribute to a component associated with the same
item type, the property page for the attribute appears.

Enter a new unique internal name and display name for the
attribute.

When you are done, choose OK.

Note: You can also use the Copy and Paste options in the Edit
menu.

See Also

Using the Edit Button in a Property Page: page 3 -8

Allowing Access to an Object

Mavigator Control Properties B=

Atibute Acoess |

Fange of Editable Access Levels (indicated in green)

: 1000
—Lewvels
LCustomization |1 0o
Aocess 100

Frotection |1 oo

el

Cusztomized objects can be modified.

Ok I Cancel | Apply | Help |

In the Access tab page, the 'Range of Editable Access Levels’ indicator
bar provides a relative indication of the range of access levels that can
edit the object. The shaded area represents the access levels that can
edit the object, while the vertical bar represents your current access
level. See: Overview of Oracle Workflow Access Protection: page
2-104.

The indicator bar can be shaded solid green, or shaded with any
combination of solid green and crosshatch grey. If the ”Allow

Defining Workflow Process Components 4 -17



4-18

modifications of customized objects” check box in the ”About Oracle
Workflow Builder” dialog box of the Help menu is:

o Checked—The range of editable access levels can appear as a
combination of solid green and crosshatch grey areas. The levels
depicted by grey crosshatches represent levels that usually
cannot modify customized objects, but can now do so because
Oracle Workflow Builder is operating in "upload” mode. Upload
mode means that Oracle Workflow Builder can save your edits,
overwriting any protected objects that you have access to modify
as well as any previously customized objects.

¢ Unchecked—The range of editable access levels appears as a
solid green area. This indicates that when you save your work,
Oracle Workflow Builder is operating in ‘upgrade’ mode, only
saving edits to protected objects that you have access to change
and leaving objects that have been previously customized
untouched.

These two modes match the upgrade and upload behavior of the
Workflow Definitions Loader program. See: To Set the Access
Level for an Object: page 4 — 18 and Using the Workflow
Definitions Loader: page 2 - 110.

» To Set the Access Level for an Object

Oracle Workflow Guide

1.
2.

Select the Access tab of the property page.

In the Options region, use the 'Preserve Customizations” and "Lock
at this Access Level” check boxes to define the access levels that can
modify this object. The options that you check in this region
directly affect the values that appear in the Levels region.

The following table illustrates how the customization and
protection levels of an object are affected when you check different
combinations of these options. This table assumes that the user
setting the options has an access level of 100.



Lookup Types

Selected Checkbox

Resulting Levels

Levels Allowed to Modify the
Object

NONE—Object can
be updated at any
time, by anyone.

Customization =0,
Access =100,

Protection = 1000

Object may be updated by any ac-
cess level (0-1000).

Preserve
Customizations—
Disallow customized
objects from being
overwritten during a
workflow definition
upgrade.

Customization = 100,
Access =100,
Protection = 1000

Object may only be updated by ac-
cess levels from 100-1000. If the

” Allow modifications of custom-
ized objects” checkbox is checked,
customized objects can also be up-
dated by access levels 0-99, as rep-
resented by grey crosshatches in the
indicator bar.

Lock at this Access
Level—Protect the
object at the current
access level and do
not allow the object
to be customized.

Customization =0,
Access =100,

Protection = 100

Object may only be updated by ac-
cess levels from 0-100.

BOTH—Object can
only be updated by
the access level at
which the object is
protected.

Customization = 100,
Access =100,
Protection = 100

Object cannot be updated by any
access level other than 100. If the

” Allow modifications of custom-
ized objects” checkbox is checked,
customized objects can also be up-
dated by access levels 0-99, as rep-
resented by grey crosshatches in the
indicator bar.

Table4-1 (Page1of 1)

3. Choose the Apply button to save your changes.

Note: An object appears with a small red lock over its icon in
the navigator tree to indicate that it is a read—only if you are
operating at an access level that does not have permission to
edit an object, that is, your access level is in a white area of the
'Range of Editable Access Levels” indicator bar.

A lookup type is a static list of values. These lists can be referenced by
activities and by item type, message or activity attributes. For
example, an activity can reference a lookup type for its possible result
values, while a message attribute can reference a lookup type as a
means of providing a list of possible responses to the performer of a

notification.
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When you define a lookup type, you associate it with an particular item
type. However, lookup types are not item type specific; when you
create an activity or an attribute, you can reference any lookup type in
your current data store, regardless of the item type that the lookup type
is associated with. See: To Create Lookup Types: page 4 — 20.

» To Create Lookup Types

Mavigator Control Properties x|

il Access I

Internal Mame |

Dizplay Mame I

Dezcription

Ok, I Cancel | Sppl | Help |

1. Select an item type from the navigator tree and choose New
Lookup Type from the Edit menu. A Lookup Type property page
appears.

2. Lookup types have an all-uppercase Internal Name with no
leading/trailing spaces and a translatable Display Name. All
Oracle Workflow APIs, SQL scripts, and PL/SQL procedures refer
to the internal name when identifying a lookup type.

= Attention: To update the internal name for a lookup type once
it is defined, you must use a special SQL script called
wichlut.sql. You should only use this script to correct errors in
a lookup type’s internal name during design time. Do not use
this script to rename lookup types that are involved in running
instances of processes. See: Wfchlut.sql: page 16 - 8.

R

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

You can supply an optional description for this lookup type.
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3. Select the Access tab page to set the access levels allowed to modify
this lookup type. See: Allowing Access to an Object: page 4 —17.

4. Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

5. The lookup type you just defined now appears beneath the Lookup
Types branch in the navigator tree. You can review or edit the
properties of this lookup type at any time by double—clicking on the
lookup type in the navigator tree or by selecting the lookup type
and choosing Properties from the Edit menu.

6. Now define the lookup codes for your lookup type. See: To Create
Lookup Codes for a Lookup Type: page 4 —21.

» To Create Lookup Codes for a Lookup Type

Mavigator Control Properties

Lookup Type IStatus

Internal Hame I

Dizplay Mame I

Description

Ok I Cancel | ey |1 | Help

1. Select a lookup type from the navigator tree and choose New
Lookup Code from the Edit menu. A Lookup Code property page
appears.

2. Enter an Internal Name with no leading/trailing spaces and a
Display Name for the lookup code. You can also enter an optional
description. All Oracle Workflow APIs, SQL scripts, and PL/SQL
procedures refer to the internal name when identifying a lookup
code.
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= Attention: To update the internal name for a lookup code

once it is defined, you must use a special SQL script called
wichluc.sql. You should only use this script to correct errors in
a lookup code’s internal name during design time. Do not use
this script to rename lookup codes that are involved in running
instances of processes. See: Wfchluc.sql: page 16 - 8.

VR

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

The lookup code you just defined now appears beneath the lookup
type you created it for in the navigator tree. You can review or edit
the properties of this lookup code at any time by double—clicking
on the lookup code in the navigator tree or by selecting the lookup
code and choosing Properties from the Edit menu.

Repeat step 1 if you wish to create additional lookup codes for a
specific lookup type.

» To Copy a Lookup Type

Oracle Workflow Guide

1.
2.

Select the lookup type to copy in the navigator tree.

Use the Copy and Paste options in the Edit menu to copy and paste
the lookup type to the item type you want. You can also drag and
drop the lookup type to the item type you want.

¢ If you copy a lookup type back to the same item type, or if you
copy a lookup type to an item type in a different data store when
the lookup type already exists in any item type in that data store,
then the property page appears for you to enter a unique internal
and display name for the new lookup type. When you are done,
choose OK.

e If you copy a lookup type to an item type in a different data
store, and that lookup type does not yet exist in any item type in
that data store, then the new lookup type is copied with the same
internal and display name as the original. You do not have to
enter new names.

Note: Copying a lookup type also copies any lookup codes
assigned to it.

Note: You cannot use the Copy and Paste options to copy a
lookup type to another item type in the same data store.
However, you can drag and drop a lookup type to another item



type in the same data store; by doing so, you actually move the
lookup type to the new item type.

» To Copy a Lookup Code

1. Select the lookup code to copy in the navigator tree.

2. Hold down your mouse select button as you drag the lookup code
to the lookup type you want to copy it to.

3. If you drag the lookup code to the same lookup type or to a lookup
type where this code already exists, then when you release your
mouse button, a properties page appears for you to enter a unique
internal and display name the new lookup code. When you are
done, choose OK.

Note: You can also use the Copy and Paste options in the Edit
menu.

Messages

The Messages branch of the navigator tree lists all available workflow
messages for the current item type.

A message is what a notification activity sends to a role in a workflow
process. A message can prompt a user for a reply or an action to take
that determines what the next activity in the process should be. The
recipient of a workflow message is called the performer.

Each message is associated with a particular item type. This allows the
message to reference the item type’s attributes for token replacement at
runtime when the message is delivered.

When you define a message, you can specify that the message prompts
a recipient for a special response value that the Workflow Engine then
uses to determine how to branch to the next eligible activity in the
process. You can create a message with context-sensitive content by
including message attribute tokens in the message subject and body
that reference item type attributes. A message function lets you include
a formatted table of message attributes or a notification history table in
the message body. You can also attach message attributes that
represent entire documents or URLs to a notification message. In
addition, you can create message attributes that generate a response
section that is unique to the message.

You can drag a message onto the Notifications branch to create a new
notification activity that sends that message. You can also drag a
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message directly onto an existing notification activity to update the
message that the activity sends.

Message Result

When you create a message for a notification activity, you should make
note of whether the notification activity has a Result Type specified. If
it does, then the message you create needs to prompt the notification
recipient for a special response that is interpreted as the result of the
notification activity. The Workflow Engine uses that result to
determine how it should branch to the next eligible activity in the
process.

To create a message that prompts for this special response, complete
the Result tab in the message’s property page. The information you
enter creates a special '‘Respond” message attribute for the message that
has an internal name of RESULT. The RESULT message attribute has a
data type of Lookup and must be set to the same lookup type as the
notification activity’s Result Type. This ensures that the performer of
the notification can choose from a list of possible response values that
matches the list of possible results that the notification activity is
expecting. See: Send and Respond Message Attributes: page 4 — 24.

Send and Respond Message Attributes

Once you create a message, you can define as many message attributes
as necessary for that message. Message attributes are listed beneath a
message in the navigator tree.

The source (Send or Respond) of a message attribute determines how
the message attribute is used. When you define a message attribute
with a source of ‘Send’, you can embed the message attribute in the
subject and/or body of the message for token substitution. In addition,
you can attach the message attribute to the message when the
notification is sent.

Each message attribute has a specific data type. The value of a "Send’
message attribute can be a constant or can be a value returned by an
item type attribute of that same data type. To embed a message
attribute in a message’s subject or body for token substitution, specify
the internal name of the message attribute using the format
&MESGATTR within the subject or body text.

Note: You should not embed a message attribute of type
Document in a message’s subject, since Document message
attributes cannot be be token substituted in the subject. For a
DM Document message attribute (to be supported in a future



release), the attribute’s display name will be substituted in the
subject. All other Document message attributes embedded in
the subject will be ignored.

You can, however, embed Document message attributes within
the body of a message for token substitution.

A message attribute defined with a source of 'Respond’ constitutes the
response section of a message. A 'Respond’ message attribute provides
instructions that prompts a recipient for a response. When you define a
"Respond’ message attribute, you must specify the data type of the
attribute. You can also provide an optional default value for the
response. The default value can be a constant or a value returned from
an item type attribute of the same data type.

Message Attributes: page C -5

#HIDE_REASSIGN Attribute

You can use a special message attribute or notification attribute with
the internal name #HIDE_REASSIGN to hide the Reassign button in
the Notification Detail web page. When users view a notification from
their Worklist web page, the response frame in the Notification Detail
page includes the Reassign button by default. If you want to prevent
users from reassigning a notification, you can add the
#HIDE_REASSIGN attribute to control whether the Reassign button is
displayed or hidden.

The #HIDE_REASSIGN attribute must be of type text. To hide the
Reassign button, set the value of this attribute to Y. To display the
Reassign button, set the value to N.

e If you always want to hide the Reassign button for notifications
using a particular message, specify the value Y as a constant.

e If you only want to hide the Reassign button in certain cases,
specify an item type attribute as the value. Then include logic in
your workflow process that dynamically determines at runtime
whether the button should be hidden or displayed and sets the
item type attribute to Y or N, respectively.

See Also

To Reassign a Notification to Another User: page 10 — 23
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#FROM_ROLE Attribute

You can use a special message attribute with the internal name
#FROM_ROLE to specify the role that is the source of a notification.
For example, if you have a notification that informs an approver that a
requisition was submitted, you can set the requisition preparer as the
From Role for the message.

The From Role for each notification is displayed in the Worklist web
page to give users additional information for reviewing and
responding to the notifications. Additionally, the Find Notifications
page lets you search for notifications based on the From Role.

To specify the From Role for a message, create a message attribute with
the following properties:

¢ Internal Name—#FROM_ROLE
¢ Display Name—From Role

¢ Description—From Role

e Type—Role

¢ Source—Send

¢ Default Type—Item Attribute

¢ Default Value—The item attribute that holds the value you want
to set as the From Role for the message

To View Notifications from the Worklist: page 10 — 17
To Find Notifications: page 10 — 15

WE_NOTIFICATION() Message Function

In addition to message attribute tokens, you can also use a special
message function called WF_NOTIFICATION() to add
context-sensitive content to a message body. Depending on the
parameters you provide, the WF_NOTIFICATION() function can
produce either a table of message attributes or a notification history
table. The tables are created in a standard Oracle Workflow format.



3 Detail notification for SPIERSON - Netscape

Ay

(4 Notscation Deits B | TP 2 | ORACLE

From CDOUGLAS
To SPIERSCN Sent D8-AUG-2001 13:00:40

Subject Requisition Message

Require Approval:
Requestor BLEWIS
Amount $540.00
Description Cormputer Equipment

History:
Sequence Who Action Date Note
3 SPIERSON 08-AUG-2001
2 CDOUGLAS Approve 08-AUG-2001 Agreed
1 HWALKER Approve 08-AJG-2001 This will help BLEWIS to be more productive, please approve
0 BLEWIS Submit 08-AUG-2001

Eeturn to Worlhst

e ﬂ

Approved?  Approwe | Reject | Reassign.. |

Message Attribute Table

To include a table of message attributes in a message body;, call
WE_NOTIFICATION() with the ATTRS option followed by the internal
names of the message attributes, separated by commas. Use the
following format:

WF_NOTIFICATION (ATTRS,<attributel>,<attribute2>,<attribute3>,...)

Note: You must not include any spaces or carriage returns in
the call to WE_NOTIFICATION(). You only need to use a
comma to delimit the parameters in the list.

The message attribute table contains a row for each message attribute
listed in the WF_NOTIFICATION() call, showing the display name and
the value for each attribute.

Notification History Table

To include a notification history table in a message body, call
WF_NOTIFICATIONY() with the HISTORY option in the following
format:

WF_NOTIFICATION (HISTORY)

The notification history table contains a row for each previous
execution of the notification activity in the process, as well as a row for
the initial submission of the process. For example, for a requisition
approval notification that is sent to several approvers in turn, the
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notification history table would contain a row for each approver to
whom the notification was sent, as well as a row for the process owner.

The notification history table includes the following columns:

¢ Sequence—The order in which the executions of the notification

activity took place, beginning at zero (0) for the initial
submission of the process by the process owner.

Who—The notification recipient or process owner.

Action—The action with which the recipient responded to the
notification.

Date—The notification date.

Note—An additional note from the recipient. To allow a recipient
to add a note for the notification history table, you must create a
special 'Respond’ message attribute with the internal name
WEF_NOTE.

Define the message attribute with the following properties:

Internal Name—WEF_NOTE

Display Name—Note

Description—Note

Type—Text
— Source—Respond

When the WF_NOTE attribute is defined with a source of
"Respond’, it appears as part of the notification response section,
and the recipient can enter a note there when responding to the
notification. The WF_NOTIFICATION() function retrieves the
note text stored in the WF_NOTE attribute and displays it in the
notification history table.

If the recipient did not enter a note, or if the WF_NOTE message
attribute was not defined for the notification, then the Note
column in the notification history table is left blank.

Note: The process owner cannot add a note for the notification
history table when submitting the process. Only a notification
recipient can add a note when responding to the notification.



» To Create a Message

Mawigator Control Properties

Body I Roles I .-’-\cc:essl Hesult'

Internal Mame I

Digplay Mame I
Deszcription ;I
=
Brierity |Narmal =]

(0] I Cancel | Appl | Help |

1. Select the item type that you want to create a message for in the
navigator tree, and choose New Message from the Edit menu. A
Message property page appears.

2. Provide an internal name for the message that is all uppercase with
no leading/trailing spaces, and provide a display name. You may
also enter an optional description. All Oracle Workflow APIs, SQL
scripts, and PL/SQL procedures refer to the internal name when
identifying a message.

= Attention: To update the internal name for a message once it
is defined, you must use a special SQL script called
wfchmsg.sql. You should only use this script to correct errors
in a message’s internal name during design time. Do not use
this script to rename messages that are involved in running
instances of processes. See: Wfchmsg.sql: page 16 — 9.

7.

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

3. Choose High, Normal, or Low for the default priority of the
message. The priority level simply informs the recipient of the
urgency of the message. It does not affect the processing or
delivery of the message.

Note: When you assign this message to a notification activity
and you incorporate the notification activity into a process
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diagram as a node, you can override this default message
priority with a new priority that is constant or dynamically
determined at runtime. See: To Define Nodes in a Process:
page 5 -6.

Note: In earlier versions of Oracle Workflow, the message
priority was represented as a numeric value between 1 (high)
and 99 (low). Oracle Workflow now automatically converts the
priority values of all message definitions defined in earlier
versions as follows: 1-33 = High, 34-66=Normal, and
67-99=Low.

4. Choose Apply to save your changes.

Mavigator Control Properties x|

Foles I .t’-‘«ccessl Hesultl

Subiject |

Tent Body | HTML Badp |

] =

Ok, | Cancel | Sppl | Help |

5. Select the Body tab to display the Body property page of the
message.

6. The subject gets its default value from the display name that you
entered in the Message tab. You can choose to keep the default
subject or enter a new subject for the message. The subject can
include message attributes that get token replaced with runtime
values when the message is delivered. To include a message
attribute in the subject, use an ampersand (&) followed by the
message attribute’s internal name. See: Send and Respond
Message Attributes: page 4 — 24 and To Define a Message Attribute:
page 4 - 34.

~~_ Suggestion: For clarity, you can assign a message attribute the
@ same name as the item type attribute it references.
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7. Enter a plain text message body in the Text Body field. You can
select the ellipsis button (...) to expand the view of the Subject and
Text Body fields in another window.

Oracle Workflow uses the content you enter in the Text Body field
to generate a plain text version of the notification message. The
plain text message can be viewed from the from an e-mail reader
that displays plain text messages.

= Attention: Make sure you enter a plain text message body in
the Text Body field. If Text Body is null, you get an empty
notification when you view your message from a plain text
e-mail reader.

8. You may enter an optional HTML—formatted message body in the
HTML Body field by selecting the HTML Body tab and typing in
the content, or by selecting Import to import the content from a
.HTM or HTML file. You can also select the ellipsis button (...) to
expand the view of the Subject and HTML Body fields in another
window.

= Attention: When you enter or import the HTML message
body, you do not need to include the <Body>...</Body> HTML
tags. If you do include these tags, Oracle Workflow simply
extracts the content between these tags to use as the HTML
message body. As a result, Oracle Workflow ignores any
HTML tags or content prior to the <Body> tag.

= Attention: Oracle Workflow Builder does not verify the
HTML formatting of the message body.

Oracle Workflow uses the content you enter in the HTML Body
field to generate an HTML—formatted version of the notification
message. You can view an HTML-formatted notification message
from the Notification Details web page, or from an e-mail reader
that displays HTML—formatted messages or HTML-formatted
message attachments.

Note: If HTML Body is null, Oracle Workflow uses the
message body entered in Text Body to generate the notification
message. It inserts the plain text between the <pre>...</pre>
HTML tags.

= Attention: Oracle Workflow does not fully support references
to icon and image files in the HTML message body. Although
your web server may be able to resolve the location of these
files for proper display in the Notification Details web page,
the Notification Mailer and third party e-mail applications are
not able to identify the location of these files when users view
the HTML version of their notifications in e-mail.
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You can embed message attributes in the text or HTML body.
Oracle Workflow token replaces the message attributes with
runtime values when it delivers the notification. To embed a
message attribute, enter an ”"&” followed by the message attribute’s
internal name.

= Attention: The text in a message body must be less than 4000

10.
11.

12.

13.

bytes. If you include message attributes in the text for token
substitution, then the final message body can increase up to
32000 bytes.

Note: You can also include a special token in the message
subject or body called &#NID. Oracle Workflow substitutes
this token with the notification ID of the runtime notification.

Additionally, you can use the message function
WF_NOTIFICATION() to include a formatted table of message
attributes or a notification history table in the text or HTML
message body.

Choose Apply to save your changes.

Select the Roles tab page to specify the roles that have access to this
message. (This functionality will be supported in a future release.)

Select the Access tab page to set the access levels allowed to modify
this message. See: Allowing Access to an Object: page 4 —17.

If you want the notification message to prompt the performer for a
response value and you want Oracle Workflow to interpret that
response value as the result of the notification activity, select the
Result tab page and complete the information requested. Oracle
Workflow uses the information you specify in the Result tab page
to create a special 'Respond’ message attribute called RESULT. See:
Message Result: page 4 — 24



Mavigator Control Properties B=

Messagel Body I Rales I Access

Digplay Mame I

Description I

Lookup Type I j Edit |

— Default
Tope | -]
Yalue | =l Edit |

Clear |

] I Cancel | Sl | Help |

14.

15.

16.

17.

Specify a display name and description for RESULT. Select a
lookup type from the poplist field. The lookup type you select
should be identical to the lookup type specified for the notification
activity’s result type. Select a lookup code in the Default Value
region. The lookup code you select appears as the default value of
the RESULT message attribute.

Note: To create any other type of message attribute, see: To
Define a Message Attribute: page 4 — 34.

Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

The message you just defined now appears beneath the Message
branch in the navigator tree. You can review or edit the properties
of this message at any time by double—clicking on the message in
the navigator tree or by selecting the message and choosing
Properties from the Edit menu.

If a message has a Result defined, then its message icon in the
Navigator tree has a red question mark overlay to help you
distinguish it from messages that do not have a Result defined.

You must now define all the message attributes that you have
included in the subject and body of this message.

To create a message attribute that references an item type attribute,
select the referenced item type attribute in the navigator tree, and
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hold down your mouse select button as you drag the item type
attribute to your message.

Edit the property page that appears, making sure the message
attribute has the proper Source. The Default Value region is
automatically set to Item Attribute and references the originating
item attribute.

You can also create message attributes that are not based on
existing item type attributes. See: To Define a Message Attribute:
page 4 - 34.

» To Define a Message Attribute

Mavigator Control Properties

Meszzage IDDcument Responge - Approved

Internal Mame I

Digplay Mame I

Dezcription I

Type ITth 'I
Source m

Length I
Drefault
Tepe IEonstant 'I
Walue |

o]

Cancel | S| | Help |

I
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To create a message attribute that does not reference an existing
item type attribute, select a message in the navigator tree and
choose New Attribute from the Edit menu.

An Attribute property page appears.

Provide an Internal Name in all uppercase with no leading/trailing
spaces. All Oracle Workflow APIs, SQL scripts, and PL/SQL
procedures refer to the internal name when identifying an attribute.

Attention: To update the internal name for a message
attribute once it is defined, you must use a special SQL script
called wfchmsga.sql. You should only use this script to correct
errors in a message attribute’s internal name during design
time. Do not use this script to rename message attributes that



are involved in running instances of processes. See:
Wifchmsga.sql: page 16 - 9.

7”0

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

Specify ‘Send” or "Respond’ in the Source field to indicate whether
this attribute should send information to the notification recipient
or prompt a notification message recipient for a response,
respectively.

Enter a Display Name. This is the name that appears in the
navigator tree. If this is a "Respond’ message attribute, then this
display name is also used as the response prompt.

= Attention: For ‘Send’ message attributes, the Display Name of

the attribute appears in plain text e-mail notifications only if
the attribute is of type URL to describe what the URL drills
down to.

Enter an optional description. If this is a '/Respond” message
attribute, use this field to elaborate on response instructions.

Select the data type of the attribute.

Depending on the Type of your attribute, provide the following
default information:

o Text—Specify the maximum length of the text attribute.

¢ Number—Optionally provide a format mask for your number
and a default number value.

¢ Date—Optionally supply a format mask for the date and a
default date value.

¢ Lookup—Choose the name of a predefined Lookup Type from
which to draw values. Choose a lookup code for the default
value.

e URL—Specify a Universal Resource Locator (URL) to a network
location in the Default Value field. See: To Define a URL
Attribute: page 4 —12.

= Attention: 'Respond’ message attributes of type URL do not

appear properly when you view the notification from a plain
text e-mail reader. You should advise your workflow users to
view their notifications from the Notification Details web page
if you plan to create messages with 'Respond’ message
attributes of type URL.

= Attention: A single 'Respond’ message attribute of type URL

replaces the Notification Details web page response frame and
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takes the notification recipient to a custom HTML page to
complete the notification response. Your custom HTML
response document must include references to all your
'Respond’ message attributes, including the special RESULT
attribute, if one is defined, and must also include a call to the
Workflow Engine CompleteActivity( ) API to inform the
Workflow Engine when the notification response is complete.

¢ Form—This attribute is relevant only with the version of Oracle
Workflow embedded in Oracle Applications.

Specify a developer form function name and any optional
argument string (form function parameters) in the Default Value
field. See: Overview of Menus and Function Security, Oracle
Applications Developer’s Guide and To Define a Form Attribute:
page 4 -13.

> Attention: 'Send’ and 'Respond’ message attributes of type
Form appear only when your Notifications web pages are
launched from Oracle Applications. The attached form icon is
enabled if a notification message includes a ‘Send” message
attribute of type Form. The notification recipient can click on
the attached form icon to drill down to the form function
defined by the message attribute.

= Attention: If a message includes a 'Respond’ message
attribute of type Form, the attached form icon that appears in
the notification’s Response section simply drills down directly
to the designated form function. This form function must be
coded with a call to the Workflow Engine CompleteActivity( )
API to inform the Workflow Engine that the notification
response is complete. See: Workflow Engine APIs: page 8 — 19.

¢ Document—Enter a string that identifies the document in the
Default Value field. See: To Define a Document Attribute: page
4-14.

¢ Role—Specify a role name. If a message attribute of type role is
included in a notification message, the attribute automatically
resolves to the role’s display name, eliminating the need for you
to maintain separate attributes for the role’s internal and display
names. Also when you view the notification from a web
browser, the role display name is a hypertext link to the e-mail
address for that role. To set a default value for the attribute, you
must initially load roles from the database. See: Roles: page
5-24.

¢ Event—Specify an event item type attribute as the default value.
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= Attention: Do not specify a message attribute’s data type as

Attribute, as it serves no purpose in a notification message and
is also not supported by the Workflow Notification System.

= Attention: 'Respond’ message attributes of type Date,

10.

Number, Text, Document or Role prompt the notification
recipient to respond with a date, number, text value, document,
role (internal or display name), respectively.

"Respond’ message attributes of type Lookup prompt the
notification recipient to select a response from a list of values.

If your message attribute type is URL or DM Document, specify a
Frame Target. When you reference this message attribute in a
message, the URL or URL for the DM document frame opens
according to what you specify as the frame target. The frame target
can be:

¢ New Window—the URL loads in a new, unnamed browser
window.

¢ Same Frame—the URL loads in the same frame as the element
that references the URL attribute.

e Parent Frameset—the URL loads into the immediate FRAMESET
parent of the current frame. This value is equivalent to Same
Frame if the current frame has no parent.

¢ Full Window—the URL loads into the full, original window, thus
cancelling all other frames. This value is equivalent to Same
Frame if the current frame has no parent.

If your message attribute is a Send attribute and is of type
Document, you can check Attach Content to attach the content of
the attribute to the notification message. When you view your
notification from the Notification web page interface, you see a
document icon following the notification message body that
displays the contents of the attached message attribute when you
click on it. If you view your notification from e-mail, the
presentation of the attachment will vary depending on what your
e-mail notification preference setting is. See: Reviewing
Notifications via Electronic Mail: page 10 - 2.

Note: You can attach, as well as embed (by token substitution)
Document attributes in the notification message and are not
limited to one or the other.

If your message attribute is a Send attribute and is of type URL,
you can check Attach Content to append an attachment called
Notification References to the notification message. This
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11.

12.

13.

attachment includes a link to each URL attribute for the message
that has Attach Content checked. You can navigate to a URL by
choosing its link.

Note: You can attach, as well as embed (by token substitution)
URL attributes in the notification message and are not limited
to one or the other.

For message attributes, the default value may be a constant or an
item type attribute. If the default references its entire value directly
from an item type attribute, choose Item Attribute, then use the
poplist field to choose an item type attribute. The item type
attribute you select must be associated with the same item type
that the message itself is associated with. The item type attribute
you select must also be of the same data type as the message
attribute.

Note: A message attribute type of "Text’ is compatible with
any item attribute type, but all other message attribute types
must match the item attribute type exactly.

Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

Any message attribute you define appears beneath the respective
message you defined it for in the navigator tree. You can review or
edit the properties of an attribute at any time by double—clicking on
the attribute in the navigator tree or by selecting the attribute and
choosing Properties from the Edit menu. Respond message
attribute icons in the Navigator tree have a red question mark
overlay to help you distinguish them from Send message attribute
icons.

Note: Message attributes assume the access/protection level of
their parent message.

= Attention: The order that you list 'Respond’ message

attributes in the navigator tree correlate to the order in which
they appear in the response section of the notification message.
You can use the drag and drop feature of the navigator tree to
reorder a set of attributes, or select an attribute and choose
Move Attribute Up or Move Attribute Down from the Edit
menu.

Example ‘Respond” Message Attributes: page 4 — 39



Using the Edit Button in a Property Page: page 3 — 8

Reviewing Notifications via Electronic Mail: page 10 — 2

Example '‘Respond’ Message Attributes

Following are examples of how the Notification System generates the
Response section of an e-mail notification using a sample set of
"Respond’ message attributes that have no default values.

The following table lists some sample "‘Respond’ message attributes.

Internal Type Format/Lookup Display Description

Name Type Name

RESULT lookup WEFSTD_APPROVAL | Action Do you approve?

COMMENT | text 2000 Review
Comments

REQDATE | date DD-MON-YYYY Required If there is no required
Date date, leave this blank.

MAXAMT | number Maximum This is the maximum
Amount approved amount.

Table4-2 (Page1lof1)

For the templated response method, the following boilerplate text is
used to generate the Response template section of an e-mail
notification:

<Description>
<Display Name>: " "
<list of lookup codes>
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Portion of Resulting Response Template as Shown in a Templated
Response E-mail Notification

Do you approve?

Action: 7"
Approve
Reject

"o

Review Comments:

If there is no required date, leave this blank.

"o

Required Date:

This is the maximum approved amount.

"o

Maximum Amount:

For the direct response method, the following boilerplate text is used to
generate the Response section of an e-mail notification:

Enter the <Display Name> on line <Sequence>. <Description>
<Type_Hint>

<Display Name> isreplaced with the Display Name of the message
attribute. <Sequence> is replaced with the relative sequence number
of the 'Respond’ message attribute as it appears in the Navigator tree
among all 'Respond’ message attributes (that is, the presence of "Send’
message attributes is ignored when determining the sequence).
<Description> is replaced with the Description of the message
attribute. In addition, <Type Hint> is replaced with one of the
following statements, if the message attribute matches one of these data

types:

Type Type Hint
Lookup Value must be one of the following:

<list of lookup codes>
Date Value must be a date [in the form “"<format>"].
Number Value must be a number [in the form “<format>"].
Text Value must be <format> bytes or less.



Portion of Resulting Response Section as Shown in a Direct
Response E-mail Notification

Enter the Action on line 1. Do you approve? Value must be one of the following:
Approve

Reject

Enter the Review Comments on line 2. Value must be 2000 bytes or less.

Enter the Required Date on line 3. If there is no required date, leave this blank. Value
must be a date in the form "DD-MON-YYYY”.

Enter the Maximum Amount on line 4. This is the maximum approved amount. Value
must be a number.

p» To Token Substitute an Attribute

®  Oracle Workflow supports runtime token substitution of attributes.
You can embed attributes within an attribute as well as embed
attributes within a message subject and body. To embed an
attribute, specify the attribute that you want to have token
substituted as &attr_name, where attr_name is the internal name of
the attribute.

When performing token substitution, Oracle Workflow fetches the
internal name of the attribute and its value. If an attribute
requiring token substitution is nested with another attribute, Oracle
Workflow orders the nested list of attributes according to the
length of their internal attribute names and then begins substituting
the attributes with the longest internal names first.

= Attention: If you find that you need to nest message attributes
more than two layers deep to display the necessary message
body content, you should investigate creating a PL/SQL
document-type message attribute. See: External Document
Integration: page 4 - 6.

» To Copy a Message

1. Select the message to copy in the navigator tree.
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2. Hold down your mouse select button as you drag the message to
the item type branch you want to copy to.

3. When you release your mouse button, a property page appears for
the new message.

Note: You can also use the Copy and Paste options in the Edit
menu.

4. Enter a new internal name and display name.

5. Make any additional modifications to the properties of the
message.

6. When you are done, choose OK.

Note: Copying a message also copies any message attributes
assigned to it.

An activity is a unit of work that contributes toward the
accomplishment of a process. An activity can be a notification, a
function, an event, or a process. A notification activity sends a message
to a workflow user. The message may simply provide the user with
information or request the user to take some action. A function activity
calls a PL/SQL stored procedure or some external program to perform
an automated function. An event activity receives, raises, or sends a
business event. A process activity is a modelled workflow process,
which can be included as an activity in another process to represent a
sub—process.

Activities are organized beneath their respective Processes,
Notifications, Functions, or Events headings in the navigator tree. You
can create, edit, and delete activity definitions in the navigator tree, and
drag an activity from the tree into a Process window to create a new
usage of that activity in a process diagram. Each activity is depicted as
an icon in a process diagram

Oracle Workflow provides an item type called Standard that includes
generic activities you can use in any process you define. For example,
some of the activities perform standard functions such as comparing
two values. See: Standard Activities: page 6 — 2.

Oracle Workflow also provides an item type called System:Error that
includes a standard error process and activities you can use to create a
custom error process. You can assign an error process to a process



activity. If an error occurs, the error process informs Oracle Workflow
how to handle the error. See: Default Error Process: page 6 — 26.

Notification Activity

When the workflow engine reaches a notification activity, it issues a
Send( ) API call to the Notification System to send the message to an
assigned performer. You define the message that the notification sends.
The message can be an informative note or it can prompt the performer
for a response. When a performer responds to a notification activity,
the Notification System processes the response and informs the
workflow engine that the notification activity is complete so that it can
continue processing the next eligible activity. See: To Create a
Notification Activity: page 4 —48.

You specify the performer of a notification activity when you include
the notification activity as a node in the process. You can either
designate the performer to be a specific role or an item type attribute
that dynamically returns the name of a role. See: To Define Nodes:
page 5 — 8 and Roles: page 5 — 24.

When you define a notification activity, you can also optionally:

e Check Expand Roles to send an individual copy of the
notification message to each user in the role. The notification
remains in a user’s notification queue until the user responds or
closes the notification.

= Attention: You should expand roles to send out a
broadcast-type message that you want all users of that role to
see.

If you do not expand the role for a notification activity, Oracle
Workflow sends one copy of the notification message to the
assigned performer role and that notification is visible in the
notification queue of all the users in that role. If one user in that
role responds or closes that notification, the notification is
removed from the notification queue of all other users in that
role.

e Specify a post-notification function that the Workflow Engine
executes in response to an update of the notification’s state after
the notification is delivered. The Workflow Engine runs the
post—notification function in RESPOND, FORWARD,
TRANSFER, or TIMEOUT mode depending on whether the
notification recipient responds to, forwards, or transfers the
notification, or whether the notification times out, respectively.
When the Notification System completes execution of the
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post—notification function in RESPOND mode, the Workflow
Engine then runs the post—notification function again in RUN
mode.

For example, if you wish to restrict the roles that a notification
can be forwarded to, you can specify a post—notification function
that the Workflow Engine executes in FORWARD mode when
the notification recipient attempts to forward the notification.
The post-notification function would audit the role and either
allow the forward to occur or reject it with an error. See:
Post—notification Functions: page 8 — 13 and Notification Model:
page 8 —192.

To create a post-notification function, you should use the same
PL/SQL API required for function activities. See: Standard API
for PL/SQL Procedures Called by Function Activities: page 7 — 3.

By both checking Expand Roles and specifying a post-notification
function, you can create your own custom vote tallying activity. See:
Voting Activity: page 4 - 61.

Function Activity

A function activity is defined by the PL/SQL stored procedure or
external program that it calls. Function activities are typically used to
perform fully automated steps in the process. As a PL/SQL stored
procedure, a function activity accepts standard arguments and can
return a completion result.

If you pass a parameter for the stored procedure, you can expose that
parameter as an activity attribute. The activity attribute’s value can be
set when you define that activity as a node in your process. Note that
these activity attributes are available only to the current activity and
are not global like item type attributes. See: To Define Activity
Attribute Values: page 5 -17.

As an external program, a function activity is able to enqueue payload
information into an Oracle Advanced Queuing outbound queue for
some external agent to dequeue and consume. The external agent can
similarly enqueue updated attributes and a completion result into an
inbound queue that the Workflow Engine consumes and processes.

As an external Java program, a function activity is able to enqueue
payload information into an Oracle Advanced Queuing outbound
queue for the Java Function Activity Agent to dequeue and consume.
The results of the Java program are enqueued into an inbound queue
that the Workflow Engine consumes and processes. This functionality is



currently only available for the standalone version of Oracle Workflow.
See: To Create a Function Activity: page 4 - 50.

Event Activity

An event activity represents a business event from the Business Event
System within a workflow process. Include event activities in workflow
processes to model complex processing or routing logic for business
events beyond the standard event subscription options of running a
function or sending the event to a predefined agent. See: Managing
Business Events: page 13 - 2.

An event activity can either receive, raise, or send a business event.

e A Receive event activity can be marked as a Start activity for a
process, meaning it is always enabled to receive events.
Alternatively, a Receive event activity can be placed within the
process, so that it is only enabled to receive events after the
process transitions to that activity.

When the activity receives an event, the Workflow Engine stores
the event name, event key, and event message in item type
attributes, as specified in the node’s event details, and then
continues the thread of execution from the event activity. If that
activity has already received an event, then the On Revisit flag
for the activity determines whether the Workflow Engine
reexecutes the activity. See: To Define Optional Activity Details:
page 4 -59.

If the event was originally raised by a Raise event activity in
another workflow process, the item type and item key for that
process are included in the parameter list within the event
message. In this case, the Workflow Engine automatically sets
the specified process as the parent for the process that receives
the event, overriding any existing parent setting. See:
SetltemParent: page 8 —79.

e A Raise event activity retrieves information about the event and
raises the event to the Business Event System, which will then
execute subscriptions to the event. The activity retrieves the
event name, event key, and event data as specified in the node’s
event details. The event details can be dynamically determined
at runtime using item type attributes. You can also specify the
event name as a predefined constant for the event activity node.

Additionally, the activity retrieves the names and values of any
activity attributes defined for it and sets these attributes as
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parameters in the parameter list for the event message. See:
Event Message Structure: page 8 —242.

The activity also automatically sets the item type and item key
for the current workflow process in the parameter list for the
event message. If the event message is later received by another
process, the Workflow Engine uses that item type and item key
to automatically set the process that raised the event as the
parent for the process that receives the event. See: SetltemParent:
page 8 -79.

¢ A Send event activity retrieves the event name, event key, event
message, outbound agent, and inbound agent, as specified in the
node’s event details. If no correlation ID is initially specified in
the event message, the correlation ID is automatically set to the
item key of the process. Then the Send event activity sends the
event directly from the outbound agent to the inbound agent.
The event details can be dynamically determined at runtime
using item type attributes. You can also specify the event name,
outbound agent, and inbound agent as predefined constants for
the event activity node. See: To Create an Event Activity: page
4 - 54 and To Define Event Details for an Event Node: page
5-12.

Note: A Send event activity does not raise the event to the
Business Event System, so no subscription processing is
performed.

Process Activity

A process activity represents a collection of activities in a specific
relationship. When a process activity is contained in another process it
is called a subprocess. In other words, activities in a process can also
be processes themselves. There is no restriction on the depth of this
hierarchy. See: To Create a Process Activity: page 4 — 57.

Caution: Oracle Workflow does not support using a
subprocess activity multiple times within a process hierarchy.

Subprocesses: page C -5



Activity Cost

Each function activity and event activity has a cost associated with it.
The cost is a value representing the number of seconds it takes for the
Workflow Engine to execute the activity. If you do not know how long
it takes for the Workflow Engine to perform the activity, you can enter
an estimated cost and update it later as you accumulate more
information about its performance. Generally, you should assign
complex, long running activities a high cost.

The valid range for cost is 0.00 to 1,000,000.00.

= Attention: Although the cost is entered and displayed in
seconds in Oracle Workflow Builder, it is actually converted
and stored in the database as hundredths of a second.

In normal processing, the Workflow Engine completes the execution of
a single activity before continuing to a subsequent activity. In some
cases, an activity might take so long to process that background
processing would be more appropriate.

You can define your Workflow Engine to defer activities with a cost
higher than a designated threshold to a background process. The
engine then continues processing the next pending eligible activity that
may occur in another parallel branch of the process.

The default threshold for the Workflow Engine is 50 hundredths of a
second. Activities with a cost higher than this are deferred to
background engines. A background engine can be customized to
execute only certain types of activities. You can set the workflow
engine threshold through SQL*Plus. See: Setting Up Background
Workflow Engines: page 2 — 46, To Set Engine Thresholds: page 2 — 50,
and Deferring Activities: page C -7.
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Select the item type that you want to create a notification for in the
navigator tree, then choose New Notification from the Edit menu.
Define your notification activity in the Activity property page that
appears.

You can also select a message in the navigator tree and drag and
drop the message into the Notifications branch of the same item
type to create a notification activity that sends that message.

A notification activity must have an Internal Name (all uppercase
and no leading/trailing spaces) and a Display Name, which is the
translatable name that appears in your process diagram. Use the
description to provide an explanation about this activity.

= Attention: To update the internal name for an activity once it

3.

is defined, you must use a special SQL script called
wifchact.sql. You should only use this script to correct errors in
an activity’s internal name during design time. Do not use this
script to rename activities that are involved in running
instances of processes. See: Wfchact.sql: page 16 — 7.

.o

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

Indicate the result type (a predefined Lookup Type) for this activity.
Result types list the possible results returned by this activity. Your
workflow diagram may branch depending on the value returned



by your completed activity. See: To Create Lookup Types: page
4 -20.

You can choose <None> as the result type if your activity does not
return a value, or if your workflow process does not depend on the
value returned.

Select the name of the message you want this notification to send.
See: To Create a Message: page 4 —29.

If you plan to assign this notification to a role consisting of multiple
users and you want to send an individual copy of this notification
to each user in the role, then check Expand Roles. If you uncheck
Expand Roles, then only one copy of the notification is delivered to
the role as a whole. See: Notification Activity: page 4 — 43.

You can optionally specify a PL/SQL stored procedure in the
Function field. The procedure is known as a post—notification
function and lets you couple processing logic to the notification
activity. The Workflow Engine executes this post—notification
function in RESPOND, FORWARD, TRANSFER or TIMEOUT
mode depending on whether the recipient responds to, forwards,
or transfers the notification or whether the notification times out.
When the Notification System completes execution of the
post-notification function in RESPOND mode, the Workflow
Engine then runs the post—notification function again in RUN
mode. See: Standard API for PL/SQL Procedures Called by
Function Activities: page 7 — 3 and Post-Notification Functions:
page 8 —13.

If you check Expand Roles and you assign a message that has a
special Result, to this notification activity, then use the Function
field to specify the name of a custom PL/SQL stored procedure
that tallies the responses you get back from each of the recipients of
this notification. Specify the procedure using the format:
<package_name>.<procedure_name>. See: Voting Activity: page
4-61.

Choose an icon that identifies your activity. You can use any icon,
as long as the icon is stored in a .ico file, to symbolize the action of
an activity. See: Adding Custom Icons to Oracle Workflow: page
2-88.

Choose Browse to view the icon files listed in the workflow icons
subdirectory.

You can also drag and drop icon files from the Windows Explorer
or File Manager onto an activity in your navigator tree to assign
that icon to the activity.
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Choose Apply to save your changes.

Select the Details tab to display and modify optional Details of the
activity. See: To Define Optional Activity Details: page 4 — 59.

Select the Roles tab page to specify the roles that have access to this
notification activity. (This functionality will be supported in a
future release.)

Select the Access tab page to set the access levels allowed to modify
this notification. See: Allowing Access to an Object: page 4 —17.

Choose OK to save your changes and close the property pages.

The notification activity now appears beneath Notifications in the
navigator tree. You can review or edit the properties of this activity
at any time by double—clicking on the activity in the navigator tree
or by selecting the activity and choosing Properties from the Edit
menu or by pressing Enter on your keyboard.

Using the Edit Button in a Property Page: page 3 — 8
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Select the item type that you want to create a function for in the
navigator tree, then choose New Function from the Edit menu.



Define your function activity in the Activity property page that
appears.

2. A function activity must have an Internal Name (all uppercase and
no leading/trailing spaces) and a Display Name, which is the
translatable name that appears in your process diagram. Use the
description to provide an explanation about this activity.

= Attention: To update the internal name for an activity once it
is defined, you must use a special SQL script called
wichact.sql. You should only use this script to correct errors in
an activity’s internal name during design time. Do not use this
script to rename activities that are involved in running
instances of processes. See: Wfchact.sql: page 16 — 7.

.

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

3. Enter the name of the function you want this activity to execute. In
the Type field, specify whether the function is a PL/SQL function,
an External function, or an External Java function.

Fora PL/SQL function, set the function type to PL/SQL and
specify the function as <package_name>.<procedure_name>. The
function must be defined according to a standard API. See:
Standard API for PL/SQL Procedures Called by Function
Activities: page 7 - 3.

For an external function activity, set the function type to External.
The Workflow Engine enqueues an entry in the “Outbound” queue
and sets the correlation value of that entry to a value composed of
the Workflow schema name and the item type in the following
format:

<schema_name><item type>

See: Workflow Queue APIs: page 8 — 162.

You must create your own queue handler to search for this type of
record on the "Outbound” queue. The queue handler must execute
the action associated with the record and seed the result of the
action onto the “Inbound” queue. The background engine then
takes care of messages on the inbound queue and restarts your
original workflow process. See: Deferred Processing: page 8 — 9.

For an external Java function activity, set the function type to
External Java and enter the class name of your custom Java class as
the function name. This functionality is currently only available for
the standalone version of Oracle Workflow. If the custom class is
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within a package, prefix the class name with the package name in
the following format:

<customPackage>.<customClass>

The Java class must be defined according to a standard API. See:
Standard API for Java Procedures Called by Function Activities:
page 7 - 8.

The Workflow Engine enqueues an entry in the ‘Outbound” queue.
The Java Function Activity Agent dequeues messages of this type,
executes your Java program, and enqueues the results onto the
‘Inbound” queue. The background engine then takes care of
messages on the inbound queue and restarts your original
workflow process. See: Setting Up the Java Function Activity
Agent: page 2 — 89 and Deferred Processing: page 8 - 9.

Note: These ‘Outbound’ and 'Inbound’ queues are separate
from the queues used for the Business Event System. See:
Workflow Queue APIs: page 8 — 162.

Note: To execute external Java function activities, you must
include your JAR files in your CLASSPATH.

Indicate the result type (a predefined Lookup Type) for this activity.
Result types list the possible results returned by this activity. Your
workflow diagram may branch depending on the value returned
by your completed activity. See: To Create Lookup Types: page
4-20.

You can choose <None> as the result type if your activity does not
return a value, or if your workflow process does not depend on the
value returned.

Specify the cost of this function activity. See: Activity Cost: page
4-47.

Choose an icon that identifies your activity. You can use any icon,
as long as the icon is stored in a .ico file, to symbolize the action of
an activity. See: Adding Custom Icons to Oracle Workflow: page
2-88.

Choose Browse to view the icon files listed in the workflow icons
subdirectory.

You can also drag and drop icon files from the Windows Explorer
or File Manager onto an activity in your navigator tree to assign
that icon to the activity.

Choose Apply to save your changes.
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Select the Details tab to display and modify the optional details of
the activity. See: To Define Optional Activity Details: page 4 — 59.

Select the Roles tab page to specify the roles that have access to this
function activity. (This functionality will be supported in a future
release.)

Select the Access tab page to set the access levels allowed to modify
this function. See: Allowing Access to an Object: page 4 —17.

The function activity now appears beneath Functions in the
navigator tree. You can review or edit the properties of this activity
at any time by double—clicking on the activity in the navigator tree
or by selecting the activity and choosing Properties from the Edit
menu or by pressing Enter on your keyboard.

If your function requires input arguments, you can expose those
arguments in Oracle Workflow Builder as attributes of the function
activity. Function activity attributes behave as parameters whose
values you can modify for each usage of the activity in a process.
Function activity attributes are specific to a function activity and
are not global to a process. See: To Define an Item Type or Activity
Attribute: page 4 - 8.

To create a function activity attribute that references an item type
attribute, select the referenced item type attribute in the navigator
tree, and hold down your mouse select button as you drag the item
type attribute to your function activity. The Default Value region is
automatically set to Item Attribute and references the originating
item attribute.

When you include a function activity as a node in a process, you
can assign a value to the function activity attribute that is specific
to that node. See: To Define Activity Attribute Values: page 5 -17.

Using the Edit Button in a Property Page: page 3 — 8
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» To Create an Event Activity

Mavigator Control Properties
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1. Select the item type that you want to create an event for in the
navigator tree, then choose New Event from the Edit menu. Define
your event activity in the Activity property page that appears.

2. Anevent activity must have an Internal Name (all uppercase and
no leading/trailing spaces) and a Display Name, which is the
translatable name that appears in your process diagram. Use the
description to provide an explanation about this activity.

= Attention: To update the internal name for an activity once it
is defined, you must use a special SQL script called
wifchact.sql. You should only use this script to correct errors in
an activity’s internal name during design time. Do not use this
script to rename activities that are involved in running
instances of processes. See: Wfchact.sql: page 16 - 7.

R

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.

3. Choose an icon that identifies your activity. You can use any icon,
as long as the icon is stored in a .ico file, to symbolize the action of
an activity. See: Adding Custom Icons to Oracle Workflow: page
2-88.

Choose Browse to view the icon files listed in the workflow icons
subdirectory.
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You can also drag and drop icon files from the Windows Explorer
or File Manager onto an activity in your navigator tree to assign
that icon to the activity.

Select the Event Action for the activity.
e Receive—Receive an event from the Business Event System.
e Raise—Raise an event to the Business Event System.

¢ Send—Send an event directly from one Event agent to another
agent without re-raising the event to the Business Event System.

Note: Depending on the event action you select, you may need
to define item type attributes for some or all of the following
event details:

Event Name

Event Key

Event Message

Event Data

— Out Agent

To Agent

When you include the event activity as a node in a process, you
can use the item type attributes to specify where to store or
retrieve the required event detail information for that node.
The item type attributes that you use for event details must be
associated with the same item type that the event activity itself
is associated with. See: To Define an Item Type or Activity
Attribute: page 4 — 8 and To Define Event Details for an Event
Node: page 5 - 12.

If you are defining a Receive event activity, you can optionally
enter an Event Filter to specify the event that the activity can
receive.

¢ To allow only a specified event for the activity, enter the full
internal event name.

Note: You can only specify an individual event as the event
filter. The event filter cannot be an event group.

e To allow any event for the activity, leave the Event Filter field
blank.

See: To Define an Event: page 13 — 5.

Enter an optional cost for the activity. For event activities with the
event actions Raise or Send, you can use the cost to defer long
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10.
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running activities to a background engine. See: Activity Cost: page
4-47.

Choose Apply to save your changes.

Select the Details tab to display and modify the optional details of
the activity. See: To Define Optional Activity Details: page 4 — 59.

Select the Roles tab page to specify the roles that have access to this
function activity. (This functionality will be supported in a future
release.)

Select the Access tab page to set the access levels allowed to modify
this event. See: Allowing Access to an Object: page 4 —17.

The event activity now appears beneath Events in the navigator
tree. You can review or edit the properties of this activity at any
time by double—clicking on the activity in the navigator tree or by
selecting the activity and choosing Properties from the Edit menu
or by pressing Enter on your keyboard.

For a Raise event activity, if the event raised by the activity requires
additional parameters to be included in the event message, you can
define those parameters as attributes of the Raise event activity.
When the event is raised, the activity attributes are set as
parameters in the parameter list for the event message. You can
modify the values of the attributes for each usage of the activity in
a process. Event activity attributes are specific to an event activity
and are not global to a process. See: To Define an Item Type or
Activity Attribute: page 4 - 8.

To create an event activity attribute that references an item type
attribute, select the referenced item type attribute in the navigator
tree, and hold down your mouse select button as you drag the item
type attribute to your event activity. The Default Value region is
automatically set to Item Attribute and references the originating
item attribute.

When you include an event activity as a node in a process, you can
assign a value to the event activity attribute that is specific to that
node. See: To Define Activity Attribute Values: page 5 -17.

Note: A Raise event activity also automatically sets the item
type and item key for the current workflow process in the
parameter list for the event message. If the event message is
later received by another process, the Workflow Engine uses
that item type and item key to automatically set the process
that raised the event as the parent for the process that receives
the event. See: SetltemParent: page 8 —79.



To Create a Process Activity

Before you can draw a workflow process diagram, you must first create
a process activity in the navigator tree to represent the process
diagram.

Mavigator Control Properties

|Details| Raoles I .-’-‘n.cc:essl

Internal Mame I

Dizplay Mame I

Description I

leon [PROCESS.ICO =l o Browse |

Besult Type |<Nones | Edi |

¥ Rurnable

Ok I Cancel | ey |1 | Help |

1. Select the item type that you want to create a process activity for in
the navigator tree, then choose New Process from the Edit menu.
Define your process activity in the Activity property page that
appears.

If a process activity is closed and you want to redisplay it, select
the process activity in the navigator tree and press Enter or select
Properties from the mouse menu button.

2. A process activity must have an Internal Name (all uppercase and
no leading/trailing spaces) and a Display Name, which is the
translatable name that appears in your process diagram. Use the
description to provide an explanation about this activity.

= Attention: To update the internal name of an activity once it is
defined, you must use a special SQL script called wfchact.sql.
You should only use this script to correct errors in an activity’s
internal name during design time. Do not use this script to
rename activities that are involved in running instances of
processes. See: Wfchact.sql: page 16 —7.

7.

Caution: Do not include colons ”:” or leading/trailing spaces
in your internal name.
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10.

Indicate the result type (a predefined Lookup Type) for this activity.
Result types list the possible results returned by this process. See:
To Create Lookup Types: page 4 - 20.

You can choose <None> as the result type if you do not need to
record any specific result for the completion of your process.

Choose an icon that identifies your activity. You can use any icon,
as long as the icon is stored in a .ico file, to symbolize the action of
an activity. See: Adding Custom Icons to Oracle Workflow: page
2-88.

Choose Browse to view the icon files listed in the workflow icons
subdirectory.

You can also drag and drop icon files from the Windows Explorer
or File Manager onto an activity in your navigator tree to assign
that icon to the activity.

Check Runnable so that the process that this activity represents can
be initiated as a top-level process and run independently. If your
process activity represents a subprocess that should only be
executed if it is called from a higher level process, then uncheck
Runnable. See: CreateProcess: page 8 —21.

Caution: Oracle Workflow does not support reusing a
subprocess activity multiple times within a process hierarchy.
If you wish to use a subprocess more than once in a process,
you must create a distinct copy of the subprocess for each
instance needed.

Choose Apply to save your changes.

Select the Details tab to display and modify the optional details of
the activity. See: To Define Optional Activity Details: page 4 — 59.

Select the Access tab page to set the access levels allowed to modify
this process. The access you set for a process activity determines
who has access to edit its process diagram. See: Allowing Access
to an Object: page 4 —17.

Choose Apply to save your changes, OK to save your changes and
close the property page or Cancel to cancel your changes and close
the property page.

The process activity now appears beneath Processes in the
navigator tree. You can review or edit the properties of this activity
at any time by selecting the activity and choosing Properties from
the Edit menu or by pressing Enter on your keyboard.



See Also

Using the Edit Button in a Property Page: page 3 — 8

» To Define Optional Activity Details

Mavigator Control Properties BE

| Rales I .-’-‘n.cc:essl

Eror ltem Type  [WFERROR

Error Process I

Effective  [08/26/1999 11:11:33 PM
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Yersion |EI

Ok I Cancel | Apply | Help

1. Select the Details tab of the activity’s property page.

2. If you are creating a process activity, you can specify an error
process to execute in the event that an error occurs in the current
process. Enter the internal name of the item type that owns the
error process and then specify the internal name of the error
process activity to execute. Note that the error process item type
does not need to be open in your current Oracle Workflow Builder
session for you to define it here. See: Default Error Process: page
6 - 26.

3. The effective date tells you when this version of the activity is
available for the Workflow Engine to execute. If the Effective Date
field is blank, the activity is effective immediately.

You set the effective date when you save your changes using the
Save As option in the File menu. All your activity modifications
share the same effective date when you save.

4. Select a value for On Revisit to determine how the Workflow
Engine handles this activity when it is transitioned to more than
once. If this activity is the first activity that is revisited, as in a
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loop, you should set On Revisit to specify how you want the
Workflow Engine to process the loop. The first activity in a loop is
also called the pivot activity. For all other activities in a loop, the
value of On Revisit is irrelevant.

If On Revisit is set to Ignore, the Workflow Engine executes the
activity only once, and ignores the activity for all subsequent
revisits.

If On Revisit is set to Reset, the Workflow Engine resets the
completed activities in the loop by traversing through the loop in
reverse order from the pivot activity, executing each activity in
CANCEL mode. You can include special logic in each function’s
CANCEL mode to undo prior operations. The Workflow Engine
then traverses through the loop in forward order, reexecuting each
activity, starting with the pivot activity, in RUN mode.

If On Revisit is set to Loop, the Workflow Engine simply reexecutes
the pivot activity and all activities that follow in the loop, without
resetting, as if they have never been executed before. See: Looping:
page 8 - 10.

5. The version number identifies which revision of the activity you
are examining. The engine ensures that it uses the most recent
updates to an activity by using the latest effective version number
of that activity.

6. Choose Apply to save your changes.

To Copy an Activity

1. Select the activity to copy in the navigator tree.

2. Hold down your mouse select button as you drag the activity to
the item type branch you want to copy it to.

3. If you copy the activity within the same item type, a property page
will appear prompting you for a new unique internal and display
name for the copied activity.

Note: You can also use the Copy and Paste options in the Edit
menu.

4. When you are done, choose OK.

Note: Copying a function, event, or notification activity also
copies any attributes or message associated wit